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1.0 Introduction
This manual is intended for use by service technicians responsible for installing and servicing the LaserLight3 Large-Display 
Weight Indicator. LaserLight3 can operate as either a remote display or an indicator. Remote display configuration is detailed in 
Section 5.0 on page 72. Configuration and calibration of LaserLight3 can be accomplished using the Revolution® configuration 
utility or the indicator front panel keys. See Section 4.0 on page 44 and Section 6.0 on page 92 for information about 
configuration and calibration.

Manuals and additional resources are available from Rice Lake Weighing Systems at www.ricelake.com/manuals
Warranty information can be found at www.ricelake.com/warranties

1.1 Safety
Safety Definitions:

DANGER: Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. Includes 
hazards that are exposed when guards are removed.
WARNING: Indicates a potentially hazardous situation that, if not avoided, could result in serious injury or death. Includes 
hazards that are exposed when guards are removed.

  CAUTION: Indicates a potentially hazardous situation that, if not avoided, could result in minor or moderate injury.

IMPORTANT: Indicates information about procedures that, if not observed, could result in damage to equipment or 
corruption to and loss of data.

General Safety
Do not operate or work on this equipment unless this manual has been read and all instructions are understood. 
Failure to follow the instructions or heed the warnings could result in injury or death. Contact any Rice Lake 
Weighing Systems dealer for replacement manuals. 

  WARNING
Failure to heed could result in serious injury or death.

Some procedures described in this manual require work inside the indicator enclosure. These procedures are to be performed by 
qualified service personnel only.
Do not allow minors (children) or inexperienced persons to operate the LaserLight3.
Do not place fingers into slots or possible pinch points.
Do not use any load-bearing component that is worn beyond 5% of the original dimension.
Do not use this product if any of the components are cracked.
Do not make alterations or modifications to the unit.
Do not remove or obstruct view of warning label (Figure 1-1).
Before opening the unit, ensure the power cord is disconnected from the outlet.
 

Figure 1-1. Safety Label (PN 16861)

WARNING!
HIGH VOLTAGE

DISCONNECT POWER BEFORE SERVICING

https://www.ricelake.com/manuals
http://www.ricelake.com/warranties
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1.2 FCC Compliance
United States
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.
Canada
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set out in the Radio 
Interference Regulations of the Canadian Department of Communications.
Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils 
numériques de la Class A prescites dans le Règlement sur le brouillage radioélectrique edicté par le ministère des 
Communications du Canada.

1.3 Overview
The LaserLight3 operates with most digital weight indicators, host computers, and peripherals via 20 mA current loop, RS-232, 
RS-422 full and half duplex, Ethernet (wired TCP/IP), Wi-Fi or Radio connections. It displays a 5 in weight, 4 in weight with 
traffic symbols, 2-line message, or quarantine messages with color selections. The LaserLight3 includes a photo sensor that 
monitors ambient light and automatically adjusts the LaserLight3 display between day and night settings.
The LaserLight3 enclosure provides easy access to internal components, the front door swings down for setup and service. A 
keypad is installed on the front door which makes navigating and configuring options convenient.
1.3.1 Standard Features
Standard features include:

• Operates as an indicator or a remote display
• Two 64 X 32 Led Displays (128 x 32 Combined) 
• Color Selection (red, yellow, green, blue, magenta, cyan or white)
• Auto-Learn mode
• Hold displayed weight (demand input)
• IP66 enclosure
• Hinged front door
• Keypad
• Adjustable day and night brightness intensity
• Software selectable time and date (when the displayed weight is at zero)
• Non-glare contrast filtered lens
• Mirror (reverse image) feature
• RS-232, RS-422, 20 mA, and Ethernet (wired TCP/IP) communications
• Auto sensing 115/240 VAC power supply
• VESA flat-wall mount or side-mounting flange
• Gore-Tex® breather vent inhibits internal moisture buildup

https://www.ricelake.com
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1.4 Operating Modes
The LaserLight3 Large-Display Weight Indicator includes scale A/D circuitry and can operate as an indicator or a remote 
display. Operating modes are detailed in Table 1-1.

NOTE: Remote Display Mode is enabled when a RmtIn (Remote In) parameter is configured in the Comm (Communications) 
menu (Section 5.2.2 on page 74).

1.5 LaserLight3 Options
Options for the LaserLight3 include:

• Flange Pole mount kit (see PN 75856)
• VESA Pole mount kits (see PN 212745)
• Sunshade Visor kit (see PN 214693)
• Wi-Fi (factory installed, PN 209118)
• ConnexLink (see PN 212753)

Mode Description
Weigh Mode While operating as an indicator, Weigh mode is the primary mode of the LaserLight3. The LaserLight3 

displays gross or net weights as required
Remote Display Mode While operating as a remote display, Remote Display mode is the primary mode of the LaserLight3. The 

LaserLight3 displays data that is received from an external source, such as an indicator
Menu Mode Menu mode is accessible by pressing  on the front panel. Access to the Audit, Setpoint, Setup, 

Accumulator, Tare, Time, Date, MAC ID, and Version menus is available when in Menu mode
NOTE: While using as remote display, menus and features not relating to displaying information 
from a data source or using Digital I/O is are not required in most cases.

Setup Mode Many of the procedures described in this manual, require the indicator to be in Setup mode. 

Setup mode is accessible by shorting the setup jumper or pressing  on the front panel when 
the audit jumper is in the ON position or by shorting the Setup jumper. See Section 2.8.2 on page 25 for 
more information.

Table 1-1.  Operating Mode Descriptions

MENU

MENU
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2.0 Installation
This section provides an overview of LaserLight3 Series installation, AC wiring, CPU board connections, replacement parts. 

WARNING: The LaserLight3 has no on/off switch. Before opening the unit, ensure the power cord is disconnected from the 
power outlet.
Use a grounding wrist strap to protect components from electrostatic discharge (ESD) when working inside the enclosure.

2.1 Unpacking
Immediately after unpacking, visually inspect the LaserLight3 for damage. If parts were damaged in shipment, notify Rice Lake 
Weighing Systems and the shipper immediately. 
The shipping carton contains the following components:

• LaserLight3
• Mounting bracket or pole mount
• Documentation

2.2 Product Dimensions
Figure 2-1 displays exterior LaserLight3 dimensions.

Figure 2-1. LaserLight3 Dimensions Profile and Top

Item Inches Millimeters
A 8.73 222
B 10.10 257
C 10.34 262
D 5.00 127
E 23.00 584
F 6.35 162

Table 2-1.  LaseLight3 Dimensions

BA 

C

D
F

E

   

https://www.ricelake.com
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2.2.1 Mount Bracket Dimensions
Figure 2-2 displays LaserLight3 the mounting bracket dimensions.

Figure 2-2. Mounting Bracket Dimensions 

Item Inches Millimeters
A 6.00 152
B 8.00 203
C 16.00 406
D 23.00 584
E 25.00 635
F 0.39 10
G 0.76 19

Table 2-2.  LaseLight3 Dimensions

A

G

B

C
D
E

 F
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2.3 Wall Mounting
LaserLight3 can be mounted to a flat surface in two ways:

• Using 0.39 in (10 mm) - 0.76 in (19 mm) keyholes
• Using 100 x 100 or 200 x 200 VESA mounting holes

Figure 2-3. Bracket with VESA Mounting Holes Identified 

  NOTE: An optional pole mounting kit is required when installing the remote display on a pole.

Item Description Inches Millimeters
A VESA 200 Mount Standard 7.87 200
B VESA Mount Holes (M4 0.07 X 10mm) 0.19 5
C VESA 100 Mount Standard 3.94 100
D Upper Keyhole Mount 0.39 10
E Lower Keyhole Mount 0.75 19

Table 2-3.  Mounting Dimensions

CA B

E
D

https://www.ricelake.com


Installation

© Rice Lake Weighing Systems ● All Rights Reserved 15

2.4 Opening the Enclosure
Perform the following to open the enclosure.

WARNING: The LaserLight3 has no on/off switch. Before opening the unit, ensure the power cord is disconnected from the 
power outlet.

1. If necessary, remove tamper proof seal.

  NOTE: Breaking the seal terminates the Legal for Trade status of the LaserLight3 Large-Display Weigh Indicator.

2. Loosen the two captive screws located on the front of the enclosure. 

Figure 2-4. Front Door Fasteners and Wire Seal Location

3. Pull the hinged display outward to open the enclosure.

Figure 2-5. LaserLight3 Open

4. Reverse the procedure to close the enclosure.

Tamper Seal

Captive Screws
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2.5 Legal for Trade Sealing
Insert a lead wire seal through two holes on front door and through retaining bracket in enclosure. This restricts access of the 
setup jumpers, electronics, electrical contacts and Legal for Trade configuration parameters.

NOTE: The audit jumper (J24) must be set to off to require shorting the setup jumper (J25) to access configuration 
parameters. See Section 2.8.2 on page 25 for the location of the audit jumper on the CPU board.

Figure 2-6. LaserLight3 Legal for Trade Sealing

1. With door closed, route sealing wire through hole in sealing post (that protrudes through door).
2. Tighten captive screws.

https://www.ricelake.com
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2.6 Cable Connections
The LaserLight3 arrives pre-wired with connections from the CPU board to the display boards, CPU board to keypad, CPU 
board to power supply and power cord to power supply. Whether the LaserLight3 operates with scale functionality or as remote 
displays determines the required additional cabling. 
When operating with scale functionality, load cells must be wired to the CPU board (Section 2.7.3 on page 20). When operating 
as a remote display, a data source from an external device must connected via RS-232 (Section 2.7.4 on page 20), RS-485/422 
(Section 2.7.10 on page 23), 20 mA (Section 2.7.5 on page 20), Ethernet (Section 2.7.8 on page 22) or Wi-Fi (factory installed 
option).
2.6.1 Cord Grips
The LaserLight3 remote display provides three cord grips located on the underside of the enclosure; one for the supplied A/C 
power cord and two for load cell or communication cables. Cable plugs are included in the parts kit and must be installed in 
open cord grips to prevent moisture from entering the enclosure. See the following sections to install cables as required for the 
application.

IMPORTANT: Ensure stripped portion of cables are entirely inside cord grips. Properly seal cord grips to prevent moisture 
damage inside of the enclosure. Cable plugs must be installed in unused cord grips. Cord grips have a clamping range of 
0.197-0.472 in (5.0-12.0 mm). 

Figure 2-7. Cord Grip Layout

Power CableCord grips for Communication 
Cables or DIOs

Mounting Location for 
optional Wi-Fi  or 
ConnexLink Antenna
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2.6.2 Power Supply Wiring
The LaserLight3 AC power supply is mounted inside the enclosure and supplies power to the CPU board. AC wiring runs 
through a cord grip to the power supply.

Figure 2-8. Power Supply Wiring

  NOTE: The far left wire illustrated in Figure 2-8 is a ground attached to power supply mounting plate and enclosure.

Refer to Table 2-4 for power supply input wiring connections.

Refer to Table 2-4 for power supply output connections.

Power Supply
 Label Wire Color Voltage Input
AC (L) Line Brown or Black 115 or 240 VAC at 50/60 hz.
AC (N) Neutral Blue or White 0
GRD Ground Green/Yellow 0

Table 2-4.  Power Supply Input Connections

Power Supply
 Label Wire Color Voltage Output CPU Board Connector

-V0 Ground Black 0 J14 P2
-V0 - - - -
+V0 Line Red 12 VDC

(10.2 to 13.8 VDC tolerance)
J14 P1

+V0 – – – –

Table 2-5.  Power Supply Power Output Connections

https://www.ricelake.com
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2.7 CPU Board Connections
Figure 2-9 illustrates location of cable connections on the CPU board.

Figure 2-9. LaserLight3 CPU Board

2.7.1 CPU Board Power Input
J14 receives power from the AC power supply to power the CPU board. See Figure 2-10 for the pin assignments for the J14 
connector.

Figure 2-10. CPU Board Power In Connector (J14)

2.7.2 CPU Board Display Power Out
J15 and J17 supplies display LED boards with power. See Figure 2-11 for the pin assignments for the J15 and J17 connectors.

Figure 2-11. CPU Board Display Power Out Connectors (J15 and J17)

Power In (J14)

20 mA (J11) RS-232 (J3)
RS-485/RS-422 (J4)

DIO (J5)

Micro USB (J7)

Ethernet (J8)

Keypad (J16)

Optional Wi-Fi Card (J12)

Display Power Output CH 1 (J15)
Display Power Output CH 2 (J17)

USB Host (J9)
3V lithium CR2032 
Battery (PN 71408)

Load Cell Input (J1)

CPU Board Connector Pin Assignment Signal
J14 1 +  12 VDC

(10.2 to 13.8 VDC tolerance)
2 GND

CPU Board Connector Pin Assignment Signal
J15 CH1 Display Power Output 1 +  5VDC 

(4.85 to 5.05 VDC tolerance)
2 GND

J17 CH 2 Display Power Output 1 +  5VDC
(4.85 to 5.05 VDC tolerance)

2 GND
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2.7.3 Load Cell Input
To attach the cable from a load cell or junction box, connect cable to the J1 connector (Section 2.8 on page 24). See Figure 2-12 
for the pin assignments for the J1 connector.

Figure 2-12. CPU Board Load Cell Connector (J1)

NOTE: For a 4-wire installation leave pins 3 and 4 empty on the connector.
For a 6-wire installation set the SENSE parameter to 6-WIRE in the CONFIG menu.

2.7.4 RS-232 Serial Communications
The J3 connector (Section 2.8 on page 24) is intended to provide a connection point for the RS-232 serial communications. 
Two RS-232 ports are available. See Figure 2-13 for the pin assignments for the J3 connector.

Figure 2-13. CPU Board RS-232 Connector (J3)

2.7.5 RS-485/422 Serial Communications
The J4 connector (Section 2.8 on page 24) is intended to provide a connection point for the RS-485/422 serial communications. 
Both full duplex (four-wire) and half duplex (two-wire) are supported through the J4 connector. See Figure 2-14 for the pin 
assignments for the J4 connector.

Figure 2-14. CPU Board RS-485/422 Connector (J4)

Connector Pin Signal
J1 1 +SIG

2 –SIG
3 +SENSE
4 –SENSE
5 +EXC
6 –EXC

Connector Pin RS232-1 RS232-2
J3 1 GND –

2 RX1 –
3 TX1 –
4 – GND
5 – RX2
6 – TX2

Connector Pin 4-Wire (Full Duplex) 2-Wire (Half Duplex)
J4 1 GND GND

2 RX- (B) –
3 RX+ (A) –
4 TX- (Z) TX / RX-
5 TX+ (Y) TX / RX+

https://www.ricelake.com
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2.7.6 Digital I/O
The Digital I/O port, J5 connector (Section 2.8 on page 24) can be configured as an input or an output.
Digital inputs can be set to provide many functions, including most keypad functions except MENU. Digital inputs are active low 
(0 VDC) and inactive high (5 VDC). Use the Digital I/O menu to configure the digital inputs. 
Digital outputs are used to control relays which drive other equipment. Outputs are designed to sink, rather than source current. 
Each output is an open collector circuit, capable of sinking 24 mA (max) when active. Digital outputs are active when low or at 0 
VDC, with reference to the 5 VDC supply. 
Use the Digital I/O menu to set the function of the Digital I/O pins to OUTPUT and then use the Setpoints menu to configure the 
digital outputs. See Figure 2-15 for the pin assignments for the J5 connector.

NOTE: An output is wired to ground (P2) and the first available DIO pin, while an input is wired to +5VDC (P1) and first 
available DIO pin.

Figure 2-15. CPU Board DIO Connector (J5)

2.7.7 Micro USB Device Communications
The Micro USB port, J7 connector, is intended to be connected to a PC only. It appears as a Virtual COM Port and is assigned 
a “COMx” designation. Applications communicate through the port like a standard RS-232 communications port.
With the PC and LaserLight3 powered on, connect a USB cable from the PC to the micro USB connector (J7) on the LaserLight3. 
A new COM Port designation is assigned for each physical USB port the LaserLight3 is connected to on the PC.

WARNING: Use a grounding wrist strap to protect components from electrostatic discharge (ESD) when working inside the 
enclosure or on the front door.

For example, if the PC has four physical COM Ports with two are in use, they most likely are designated COM1 and COM2. 
When connecting the LaserLight3 to a USB port on the PC, it is assigned the next available port designation, or in this case, 
COM3. When plugging into the same physical USB port on the PC, the port designation is again COM3. If plugging into another 
physical USB port on the PC, it is assigned the next available designation, in this case COM4.
Use Windows® Device Manager to determine the COM Port designation which was assigned to the USB port, or open the 
application to be used with the LaserLight3, such as Revolution, to see which ports are available.
Configuration of the Micro USB port is done in the USB sub-menu under Communication in Setup mode. If Remote In is set, 
other features (such as sending EDP commands) are disabled.
The port can be configured as either a demand port for EDP commands and printing, or as a data streaming port (Remote In 
parameter). 

NOTE: This port is not a host port and is not intended to be connected to other devices such as keyboards, memory sticks 
or printers.
NOTE: If a computer application has an open communications connection through the Micro USB device port and the 
physical cable connection is interrupted, a soft reset (short J30 momentarily) must be performed on the LaserLight3 or the 
power must be cycled to the LaserLight3; the connection in the computer application must be disconnected and then 
reconnected before it continues to communicate with the LaserLight3.
For the Micro USB device port, it does not matter what the settings are for Baud, Data Bits, Parity and Stop Bits in the 
computer software. The port communicates in the same way regardless of these settings. 

Figure 2-16. Micro USB Input (J7)

Connector Pin Signal
J5 1 +5 VDC, 250 mA max

2 GND
3 DIO1
4 DIO2
5 DIO3
6 DIO4
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2.7.8 Ethernet TCP/IP 
The LaserLight3 features Ethernet TCP/IP 10Base-T/100Base-TX communication using the J8 connector (Section 2.8 on 
page 24), and can support two simultaneous connections, one as a server, the other as a client.
Through an Ethernet network, software applications can communicate with the LaserLight3 using the EDP command set 
(Section 9.0 on page 100), or data can be streamed continuously from the LaserLight3, or printed on demand.
The Ethernet port supports both DHCP and manual configuration of settings such as the IP and netmask. In addition, the TCP 
Port number, and the Default Gateway can be configured using the Ethernet sub-menu of the Ports setup menu. For more 
information on configuring the Ethernet port see Section 4.3.10.3 on page 67.
Physical connection to the LaserLight3 Ethernet port can be made directly from a PC to the LaserLight3 (AdHoc Network), or 
through a network router or switch. The port supports auto-sensing MDI/MDIX cable configuration, allowing either straight-
through or crossover cables to be used. See Figure 2-17 for the pin assignments for the J8 connector.

Figure 2-17. CPU Board Ethernet Connector (J8)

See Table 2-6 and Table 2-7 for the pin assignments when connecting a RJ45 Ethernet cable to the J8 connector. There are 
two Ethernet wire standards (T568A and T568B). If the type of cable is unknown, use the wiring option in Table 2-6. The auto-
sensing feature of the Ethernet port allows either of the wiring options to function. Trim unused wires.

 

RJ45 Cable 
Pin

Wire Color
(T568A)

Wire Diagram
(T568A)

10Base-T Signal
100Base-TX Signal

J8 Connector 
Pin

1 White/Green Transmit+ 1
2 Green Transmit- 2
3 White/Orange Receive+ 3
4 Blue Unused NA
5 White/Blue Unused NA
6 Orange Receive- 4
7 White/Brown Unused NA
8 Brown Unused NA

Table 2-6.  Ethernet Cable Pin Assignments for T568A

RJ45 Pin #
Wire Color

(T568B)
Wire Diagram

(T568B)
10Base-T Signal

100Base-TX Signal J8 Pin #
1 White/Orange Transmit+ 1
2 Orange Transmit- 2
3 White/Green Receive+ 3
4 Blue Unused NA
5 White/Blue Unused NA
6 Green Receive- 4
7 White/Brown Unused NA
8 Brown Unused NA

Table 2-7.  Ethernet Cable Pin Assignments for T568B

Connector Pin Signal
J8 1 TX+

2 TX-
3 RX+
4 RX-

https://www.ricelake.com
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2.7.9 USB Host
The J9 connector is intended to provide USB Host functionality. See Table 2-18 for the pin assignments for the J9 connector.

Figure 2-18. CPU Board USB Host Connector (J9)

2.7.10  20 mA
The J11 connector (Section 2.8 on page 24) is intended to provide a connection point for the 20 mA current loop  
communications. See Figure 2-19 for the pin assignments for the J11 connector.

Figure 2-19. CPU Board 20 mA Current Loop Connector (J11)

2.7.11  Keypad and Ambient Light Sensor
The keypad with integrated ambient light sensor connects to J16 on the CPU board. The keypad provides the functional buttons 
that interface with LaserLight3 (see Section 3.2 on page 32). 
The ambient light sensor adjusts the brightness of the display in relation to configured Bright parameters. For more information 
about ambient light sensor parameters, see Section 4.3.9 on page 62.

  NOTE: The LaserLight3 defaults to the Night setting if the sensor is faulty or absent.

2.7.12 RF Interference 
A cylindrical EMI filter is pre-installed on LED power cables (J15 and J17) and two rectangular EMI filters are pre-installed on 
the LED data cable (HUB75) to eliminate RF interference.

Figure 2-20. EMI Filters Placement for RF Interference

Connector Pin Signal
J9 1 USB PWR

2 D-
3 D+
4 Ground

Connector Pin Signal
J11 1 RX+

2 RX-
3 TX+
4 TX-

Power Cables with EMI Filter Data Cable with EMI Filters
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2.8 CPU Board Features
2.8.1 Status LEDs
There are several small LEDs located on the CPU board that indicate status for a specific connector or component. Typically, 
LEDs are located adjacent to their relevant connectors or components. Figure 2-21 illustrates the locations of LEDs on the CPU 
board.

Figure 2-21. LaserLight3 CPU Board with Status LEDs Identified

LED Description
LED 1 +5V Status Illuminates to indicate the +5V Power Supply is operating properly
LED 2 3.3V Status Illuminates to indicate the +3.3V Power Supply is operating properly
LED 4 HB (Heartbeat) Flashes when CPU board is operating properly
LED 21 ACTIVE Flashes when Wi-Fi module is enabled and ready
LED 22 PWR Illuminates when Wi-Fi module receives power
LED 23 TX RS-232 Port 1 Flashes when data is transmitted by RS-232 Port 1
LED 24 TX RS-232 Port 2 Flashes when data is transmitted by RS-232 Port 2
LED 25 RX RS-232 Port 1 Flashes when data is received by RS-232 Port 1
LED 26 RX RS-232 Port 2 Flashes when data is received by RS-232 Port 2
LED 27 RX RS-485/422 Flashes when data is received by RS-485/422
LED 28 TX RS-485/422 Flashes when data is transmitted by RS-485/422
LED 29 20 mA RX Flashes when data is received by 20 mA
LED 30 20 mA TX Flashes when data is transmitted by 20 mA
LED 31 DIO 1 Illuminates when DIO 1 (DIO P3) is active (pulled low)
LED 32 DIO 2 Illuminates when DIO 2 (DIO P4) is active (pulled low)
LED 33 DIO 3 Illuminates when DIO 3 (DIO P5) is active (pulled low)
LED 34 DIO 4 Illuminates when DIO 4 (DIO P6) is active (pulled low)

Table 2-8.  Status LED Descriptions

 20 mA LEDs (LED 29 
and 30)

RS-232 LEDs (LED 26, 
24, 23 and 25)

 3.3 V Status (LED1)
Wi-Fi Connection 
Active (LED21)

Wi-Fi Enabled / 
Ready (LED22)

DIO LEDs (LED 31, 
32, 33 and 34)

Heartbeat Diagnostic 
(LED4)

RS-485 LEDs 
(LED 27 and 28)

 +5 V Status (LED2)
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2.8.2 CPU Board Jumpers
The CPU board provides three jumpers (J24 Audit, J25 Setup and J30 Reset) located near RS-485/RS-422 (J4). 

NOTE: In certain Legal for Trade applications it is necessary to seal the LaserLight3 to restrict access to the setup jumper 
(Section 2.4 on page 15). Breaking of the seal terminates the Legal for Trade status of the LaserLight3.

Figure 2-22. CPU Board Jumpers

Jumper Description
Audit Jumper (J24) The audit jumper (J24) turns Setup mode access ON (shunt on pins 2 and 3) and OFF (shunt on pins 1 

and 2). Access to Setup mode is allowed without shorting the setup jumper when the audit jumper is in 
the ON position. Access to Setup mode requires shorting jumper J25 with a metallic object when the 
audit jumper is in the OFF position. See Figure 2-22 for the location of the audit jumper on the CPU 
board.

Setup Jumper (J25) In order to configure the LaserLight3, it must be placed in Setup mode with the setup jumper or with the 
audit jumper. The setup jumper is activated by opening the enclosure and momentarily shorting the pins 
on J25.

Reset Jumper (J30) The reset jumper (J30) enables a simulated power up reset, eliminating the need to unplug the unit to 
perform a reset. The unit then goes back to normal operation mode, see Figure 2-22 for the reset 
jumper location on the CPU board.

Table 2-9.  Jumper Descriptions

Audit Jumper (J24) 
with Shunt

Setup Jumper 
(J25)

Reset Jumper 
(J30)

CPU Board
 Jumper Function Application

J24 Audit Trail Off Install shunt on pins 1 and 2
Audit Trail On (LFT) Install shunt on pins 2 and 3

J25 Setup Short pins 1 and 2 momentarily
J30 Reset Short pins 1 and 2 momentarily
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2.8.3 CPU Board Switches

The CPU board contains several switches that are identified in Figure 2-23.

Figure 2-23. CPU Board Switches

2.9 Parts Kit
The LaserLight3 includes a parts kit (PN 215346) that provides wire connectors and cable ties.

Switches Description
SW1 (Boot Switch) SW1 is located near the Setup jumper (J25) and controls the operating state of the CPU board. SW1 

has two positions: Update (top) and RUN (bottom/default).
SW2 and SW3 SW2 and SW3 are located adjacent to the Reset Jumper (J30) and not intended for use. These 

switches are sealed with a film and should remain in their default Off positions.
SW4 SW4 switch bank is located in the bottom left corner near the Hub75 connector. These switches are 

sealed with a film and should remain in their default off positions: 1, 2, 3 and 4.
20 mA RX and TX Switches 20 mA RX and TX switches configure active or passive mode for receiving (left switch) and transmitting 

(right switch). The Switches have two positions up (active) and down (passive) and default positions are 
passive (down). The switches can be toggled at anytime without requiring a power cycle. 

Table 2-10.  Switch Descriptions

Part No. Description QTY
153878 Connector, 4 Position Screw Terminal 1
153882 Connector, 5 Position Screw Terminal 1
153883 Connector, 6 Position Screw Terminal 2
201910 Cable Tie, 8 in Nylon 6/6 4
80589 Cable Tie Mount 4

Table 2-11.  LaserLight3 Assembly Parts

SW2 and SW3 SW1 (Boot Switch)

SW4
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2.10 Replacement Parts
2.10.1 LaserLight3 Assembly Parts

Figure 2-24. LaserLight3 Assembly Parts Illustration

Item No. Part No. Description QTY
1 205781 Cabinet with Components (Section 2.10.3 on page 30) 1
2 205791 Front Door Assembly (Section 2.10.2 on page 28) 1
3 150800 Screw, M5-0.8 X 10 Pan Phillips Head 1
4 46381 Washer, Bonded Sealing #10 X .50 Od 1
5 187876 Nut, Lock M5 1
6 209194 Pin. Quick Release 2
7 15134 Washer, #8 with Internal Tooth Lock 1
8 14626 Nut, #8-32NV, Hex 6
9 165902 Serial Label 1

10 208806 Bracket, Mount 1
11 15132 Washer, #8 with Internal Tooth Lock 6
12 193230 Screw, M4X017 X 10 Phillips Pan Head 6

Table 2-12.  LaserLight3 Assembly Parts

12

1

2

11

5

10
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2.10.2 Front Door Assembly Parts

Figure 2-25. LaserLight3 Front Door Parts Illustration
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Item No. Part No. Description QTY
1 205792 Front Door Panel, Painted 1
2 205796 Lens Overlay Assembly 1
3 104301 3M VHB Tape, 5952 Black Double Sided Foam, 0.062 Thick X 0.75 Wide 60
4 215010 Display,32x64 Led Module P4 Pitch, Display Module, Outdoor Rated 2
5 206320 Heat Sink Assembly 1
6 214338 Machine Screw, M4-0.7x8 Phillips Pan Head, External Tooth Washer 16
7 212423 Display Communication Cable 1
8 215024 16 Conductor Data Cable with Ferrites 1
9 214876 Mount, Ferrites 4

10 206765 Washer Flat #2 Small 0.094 ID X 0.250 OD X 0.02 Thick 4
11 78628 Screw, Mach 2-56NC X 0.25 Phillips Pan Head SST 4
12 205606 CPU Board 1
13 71408 Battery, CR2032 3V 1
14 15370 Male-fem Standoff, 6-32NC x 0.25 Brass 2
15 214872 Mount, Ferrite Holder 1
16 14839 Machine Screw, 6-32nc X 1/4 10
17 212422 Power Cable Assembly with Ferrite 1
18 214914 Cable Clamp 1 In Nylon 1
19 44251 Screw, 6-32NF X 3/8 Phillips Pan Head, Internal Tooth Lock Washer 1
20 220470 Screw, Captive, Panel, 10-32 x 1/2, 18-8 SST 2
21 220471 Washer, Retaining, ID = .166, OD = .312, Thickness = .012, SST 2
22 223088 Washer,cup, No 82 Quarter Turn, 0.420 in OD 0.38 in ID 0.080 in Deep 0.02 in Thick

Nylon, black.
2

Table 2-13.  LaserLight3 Front Door Parts



LaserLight3 Large-Display Weight Indicator

30 Visit our website www.RiceLake.com

2.10.3 Cabinet Assembly Parts

Figure 2-26. LaserLight3 Cabinet Parts Illustration

Item No. Part No. Description QTY
1 205782 Cabinet, Painted 1
2 15628 Cord Grip, 1/2-NPT 3
3 30376 Seal Ring, 1/2-NPT Nylon 3
4 15665 Gland, Reducing 1/2-NPT 2
5 19538 Cord Grip Post, Slotted Black Seal 1/4 x 1 2
6 15630 Lock Nut, 1/2-NPT Plastic 3
7 88733 Vent, Breather Sealed Gore-Tex® Membrane 2
8 88734 Nut, Breather Vent M12 x 1 Thread 2
9 16892 Label, Ground Protective Earth 3

10 212330 Label, Serial Comm Pin Out 1
11 212318 Power Cord Assembly 1
12 206521 Power Supply, 12V 150W, 12.5A, AC Input, 100-240 VAC 1
13 16861 Warning Label, High Voltage 1
14 209464 Cable Assembly, Power 1
15 15418 Grommet, Rubber 3/16 ID X 7/16 OD 1
16 214933 Screw,Cap M3-0.5x10 Phillips Button Head 1
17 194487 Screw, Machine M3-0.5x6 Phillips Pan Head 2
18 14626 NUT, KEP #8-32NC HEX Ext. Tooth Lockwasher 5
19 15134 Washer, Lock No 8 Type A Internal Tooth 3
20 15601 Wire, Ground 6 in 2
21 215788 Seal, Bulb, 55 5/8 inches 1

Table 2-14.  LaserLight3 Cabinet Parts
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3.0 Operation
The front panel consists of two combined LED displays and a keypad.

3.1 Front Panel Display
The LaserLight3 provides status information about the weight value displayed. The LaserLight3 also has arrows and traffic lights 
that can be displayed with serial commands (Section 5.5.2 on page 88).

Figure 3-1. Front Panel Display

NOTE: The layout of annunciators and size of weight digits vary depending on which Type option is configured in the 
Display menu: Legacy provides about 3.75 inch weight digits with annunciators along the bottom while Standard provides 
about 5 inch weight digits with annunciators along the right side.

Item Description
Traffic Symbols Red stop light, red x, green go light, and green up arrow, green left arrow, green right arrow
Weight Value Displays weighment data

>0<
→0←

The center of zero annunciator indicates that the current gross weight reading is within ± 0.25 display divi-
sions of the acquired zero, or is within the center of zero band. A display division is the resolution of the 
displayed weight value, or the smallest incremental increase or decrease which can be displayed or 
printed
The standstill annunciator indicates the weight is at standstill or within the specified motion band. Some 
operations, including zero, tare and print, can only be done when the standstill annunciator is displayed

GR
NT

Displays which weight display mode is active, GR (Gross) or NT (Net)

lb
kg
oz
g
tn
T
G

The current unit displays at the right side of the numeric weight area and specifies which unit of measure is 
being used. Indicates units associated with the displayed value, represents primary and secondary units 
such as lb, kg, g, oz, tn and T. The units are changed by pressing the Units button

Table 3-1.  Front Panel Descriptions
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3.2 Keypad
The keypad, located on the bottom right corner of the unit, allows for easy setup and operation of LaserLight3. The keypad 
includes six function keys. 

Figure 3-2. LaserLight3 Keypad

3.3 General Navigation
The front panel function buttons are also used to navigate through the menu structure.

•  and  move left and right (horizontally) in a menu level

•  and  move up and down to different menu levels

•  enters a menu or parameter and selects/saves parameter settings or values

•  exits a parameter and selects/saves highlighted parameter settings or values

•  accesses Menu mode, exits Menu mode, or leaves a parameter without making changes

Key Description
Sets the current gross weight to zero, provided the amount of weight to be removed is within the specified zero range and the 
LaserLight3 is not in motion. The zero band by default to 1.9% of full scale, but can be configured for up to 100% of full scale.  
Also used as the up button to navigate menus
Switches the display mode from gross to net, or from net to gross. If a tare value has been entered or acquired, the net value is the 
gross weight minus the tare. Also used as the down button to navigate menus

Performs one of several predetermined tare functions dependent on the mode of operation selected in the TARE FN parameter. 
Also acts as an enter button for numeric or parameter entry

Switches the weight display to an alternate unit. The alternate unit is defined in the Format menu, and could be kg, g, lb, oz, tn or 
t. Also used as the left button to navigate menus or to toggle to another digit when editing a value

Sends on-demand print format out the configured port, provided the necessary conditions are met. RS232-1 is the default print 
port. Also used used as the right button to navigate menus or to toggle to another digit when editing a value

Accesses or exits Menu mode

Table 3-2.  Key Functions

MENU

MENU

MENU
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3.4 Menu Element Overview
LaserLight3 can display up to four lines, preceding and following menus/parameters and parameter configurations. A color 
scheme indicates the type element in the menu. Figure 3-3 through Figure 3-5 displays illustrations with several menus 
selected and a parameter configured.

3.4.1 Menu with Selectable Item

Figure 3-3. Selected Item Menu Example

3.4.2 Menu and Read Only Message

Figure 3-4. Read Only Message Menu Example

Number Element Description
1 Red Font Red font appears in two scenarios:

• In center column to indicate previously selected menus and parameters
• On left or right sides to indicate previously available menus, options, or parameters

2 Yellow Font Indicates selected menu or parameter. Select a menu item with  and , then press  to 
confirm selection

3 White Font Indicates parameters are available, but not currently selected
Not 

illustrated
Blinking Cyan 

Underline Indicates text is scrollable with  and  buttons

Table 3-3.  Menu Element Descriptions

Number Element Description
1 Red Font Red font appears in two scenarios:

• In center column to indicate previously selected menus and psarameters
• On left or right sides to indicate previously available menus, options, or parameters

2 White Font Indicates a read only message
NOTE: Read only messages, typically display as a result of selecting an information parameter.

Table 4.  Menu Element Descriptions

Respons
StrLft RmtOut

Serial
RS232 1
Trigger
RmtIn

Baud

1

23

1

Date AuditVersion

V1.00.00 LL3

1

2
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3.4.3 Menu with Text Editable Parameter

Figure 3-5. Editable Text Parameter Menu Example

3.5 Frequently Used Software Functions
This section provides procedures for frequently used LaserLight3 functions.

  NOTE: Parameters that are part of the Setup Menu require access to Setup mode (Section 2.8.2 on page 25).

3.5.1 Edit Time
Select Time in the top-level menu to edit the time.

Figure 3-6. Time Parameter Menu Path

1. Navigate to Audit ► ... ► Time.

2. Press . The configured time displays.
3. To edit the time value:

• Press  and  to select characters

• Press  and  to edit the underlined character

4. Press  to set the time. OK displays. 

5. Press  then  to exit the menu.
NOTE: Time is backed up by the internal coin cell battery and is not lost if the main power is interrupted. See  for time 
formatting options.

Number Element Description
1 Red Font Red font appears in two scenarios:

• In center column to indicate previously selected menus and parameters
• On left or right sides to indicate previously available menus, options, or parameters

2 White Font with 
Blinking Cyan 

Underline
Indicates a text configured parameter. Move character selection (cyan underline) with  and .

Press  and  to change characters.

Hold  to delete a character or hold  to insert a 0 character.

Press  to confirm character configuration and exit the parameter

Table 3-1.  Menu Element Descriptions

Sense
10000.0

Setup
Config
Capcity ZtrkBn

2

1

1

Audit Setpnt TareSetup Accum

TimeMac ID Test

MENU
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3.5.2 Edit Date
Select Date in the top-level menu to edit the date.

Figure 3-7. Date Parameter Menu Path

1. Navigate to Audit ► ... ► Date.

2. Press  to view the configured date.
3. To edit the date:

• Press  and  to select characters

• Press  and  to edit the underlined character

4. Press  to set the date. OK displays. 

5. Press  then  to exit the menu.

NOTE: Date is backed up by the internal battery and is not lost if the main power is interrupted. See  for date formatting 
options.

3.5.3 Displaying Time and Date
To display time and date when weight is zero in increments of five seconds, select Tm/Dt from the Remote menu.

Figure 3-8. Tm/Dt File Path

1. Navigate to Audit ► Setup ▼ Config ►... ►Remote ▼Manual ► ... ► Tm/Dt.

2. Press  to view the configuration.

3. Press  until On is selected.

4. Press  to accept the configuration. 

5. Press  to exit the menu.

Audit Setpnt TareSetup Accum

DateTimeMac ID Test

MENU

Manual MirrorHoldWTKeys

Setup SetpntAudit

Remote Comm

Addres

DspTest Tm/Dt

DfltCfg

MsgTim

MENU
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3.5.4 View Ethernet and Wi-Fi Media Access Control (MAC) IDs
Select MAC ID in the top-level menu to view the Ethernet and Wi-Fi MAC IDs. MAC addresses display in the following format: 
88:88:88:88:88:88.

Figure 3-9. MAC ID Parameter Menu Path

1. Navigate to Audit ►  ... ► Mac ID.

2. Press . Wired displays.

3. Press . Ethernet MAC ID displays.

4. Press . WiFi displays.

5. Press . WiFi MAC ID displays (if installed).

6. Press  to exit the menu.

3.5.5 View Version
Select Version in the top-level menu to view the current firmware version.

Figure 3-10. Version Parameter Menu Path

1. Navigate to Audit ►  ... ► Version.

2. Press . The software version number displays.

3. Press  to exit the menu.

Audit Setpnt TareSetup Accum Mac ID

Wired WiFiWiFi

MENU

Audit Setpnt TareSetup Accum

DateTimeMac ID Test Version

MENU

https://www.ricelake.com


Operation

© Rice Lake Weighing Systems ● All Rights Reserved 37

3.5.6 Reset Configuration
Select DfltCfg in the Setup menu to reset the LaserLight3 configuration. 

Figure 3-11. DfltCfg Parameter Menu Path

1. Navigate to Audit ► Setup ▼ Config ► ... ► DfltCfg.

2. Press . No displays.

3. Press . Yes displays.

4. Press  or  to reset the configuration setting. OK displays.

5. Press  to exit the menu.

3.5.7 Change Brightness Intensity
To change brightness, adjust the Intnsty (Intensity) parameter in the Dsplay (Display) Menu. 

Figure 3-12. Color Parameter Menu Path

1. Navigate to Audit ► Setup ▼ Config ► ... ►Program ▼PwrUpM ► ... ► Dsplay ▼Bright.

2. Press . Intnsty displays.

3. Press . The currently configured parameter displays.

4. Press  or  repeatedly until the desired brightness value is selected.

NOTE: Brightness is set from 1–6 (16.67–100% screen brightness) or as DayLVL (uses Day, Night and DayLVL parameters 
to automatically adjust brightness for day and night). For additional information about brightness, see Section 4.3.4 on 
page 50.

5. Press . Day displays.

6. Press  to exit the menu and load the new brightness setting.

Program PFormt SFormt

Setup SetpntAudit

DigioSetpnt

FormatConfig CalibrComm

DfltCfg

MENU

PwrUpM PstTareGrvDest

Setup SetpntAudit

Program PFormt

Regula

Calibr

Dsplay

Intnsty

Bright

Day Night DayLVL

MENU
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3.5.8 Change Display Color
The LaserLight3 display can illuminate as red (default), yellow, green, blue, magenta, cyan or white. Select the desired color in 
the Color parameter.

  NOTE: Changing the display color requires access to Setup mode (Section 2.8.2 on page 25).

Figure 3-13. Color Parameter Menu Path

1. Navigate to Audit ► Setup ▼ Config ► ... ►Program ▼ PwrUpM ► ... ► Dsplay ▼Bright ► ...  ► Color.

2. Press . The configured color displays.

3. Press  or  repeatedly until desired color is selected.

4. Press . Bright displays.

5. Press  to exit the menu.

3.5.9 Enter New Unit ID
If more than one LaserLight3 is in use a different Unit ID may be required. Select UID (Unit ID) in the Program menu to assign 
the an identification value.

  NOTE: Entering a new Unit ID requires access to Setup mode (Section 2.8.2 on page 25).

Figure 3-14. UID Parameter Menu Path

1. Navigate to Audit ► Setup ▼ Config ► ... ►Program ▼ PwrUpM ► ... ► UID.

2. Press . The current unit ID value displays.

3. Edit the value using arrow keys.

4. Press  to accept the new value.

5. Press  to exit the menu.

PwrUpM PstTareGrvDest

Setup SetpntAudit

Program PFormtCalibr

Regula Dsplay

Bright Type Color

MENU

PwrUpM PstTare ConsNuGrvDest

Setup SetpntAudit

Program PFormtCalibr

UID

Dsplay

Constu

Regula

MENU
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3.6 Indicator Functions
This section provides procedures for basic indicator operations.

3.6.1 Zero Scale
1. In Gross mode, remove all weight from the scale and wait for the LaserLight3 to display .

2. Press , >0< displays to indicate the LaserLight3 is zeroed.

  NOTE: The LaserLight3 must be stable and within the configured zero range for it to be zeroed.

3.6.2 Print Ticket
1. Wait for  to display.
2. Press  to send data to the configured port(s). The default print destination is RS-232 Port 1.

If  does not display and  is pressed, the print action only occurs if the LaserLight3 comes out of motion within 
three seconds. If the LaserLight3 stays in motion for over three seconds, the  press is ignored.

3.6.3 Toggle Units
Press  to toggle between primary and secondary units.

3.6.4 Toggle Gross/Net Mode
NET mode is available when a tare value has been entered or acquired (Net = Gross minus Tare). If tare has not been entered 
or acquired, the display remains in GROSS mode. GR (GROSS) or NT (NET) is indicated on the right side (in Standard Display 
Type configurations) or along the bottom (in Legacy Display Type) of the display to indicate the current mode.

Press  to toggle the display mode between GR (Gross) and NT (NET) modes.

Figure 3-15. Gross and Net Annunciators

3.6.5 Acquire Tare
1. Place a container on the scale and wait for  to display.

2. Press  to acquire the tare weight of the container. The net weight displays and the NT (Net) is indicated on the 
right side of the display.

0NT
lb

0

0 GR
lb

0

Gross Annunciator Net Annunciator
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3.6.6 Remove Stored Tare Value
1. Remove all weight from the scale and wait for  to display. The display shows a negative net value or 0 Gross 

value and >0< displays.

  NOTE: Press  to zero the scale, if >0< is not displayed.

2. Press  (or  in OIML mode). Tare is removed and the display changes to gross weight and Gross is 
indicated on the display.

3.6.7 Preset Tare (Keyed Tare)
Tare Function (Section 4.3.1 on page 46) must be set to Keyed Tare or Both for the preset tare feature to function.

1. Remove all weight from the scale and wait for  and >0< to display.

2. With the LaserLight3 displaying zero weight, use the numeric keypad to enter the tare weight value and press .
3. The display changes to net weight and NT (Net) is indicated on the display. 

  NOTE: Press  again while  displays, or enter a keyed tare of zero to remove the preset tare value.

3.6.8 Display a Stored Tare
Select DispTar (Display Tare) in the Tare menu to display a stored tare. 

Figure 3-16. DispTar Parameter Menu Path

1. Navigate to Audit ► ... ► Tare ▼ DispTar.

2. Press . The stored tare value displays.

3. Press  to exit the menu.

  NOTE: If there is not a tare in the system, the value displayed is zero.

3.6.9 Clear a Stored Tare
Select ClrTare (Clear Tare) in the Tare menu to clear a stored tare without the weight being at zero.

Figure 3-17. ClrTare Parameter Menu Path

1. Navigate to Audit ► ... ►Tare ▼ DispTar ►ClrTar.

2. Press  or  to clear the stored tare value. OK displays.

3. Press  to exit the menu.

DispTarClrTare

Audit Setpnt TareSetup Accum

MENU

DispTarClrTare

Audit Setpnt TareSetup Accum

ClrTare

MENU
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3.6.10 View Legally Relevant Version
Select LRV (Legally Relevant Version) in the Audit menu to view the legally relevant version.

Figure 3-18. LRV Parameter Menu Path

1. Navigate to Audit ▼ LRV.

2. Press . The current version number displays.

3. Press  to exit the menu.

3.6.11 View Audit Trail Calibration Counter
Select Calibr (Calibration Counter) in the Audit menu to view the audit trail calibration counter number.

Figure 3-19. Calibr Parameter Menu Path

The audit trail calibration and configuration counters can be viewed in Menu mode.
1. Navigate to Audit ▼ LRV ► Calibr.

2. Press . The audit trail calibration counter number displays.

3. Press  to exit the menu.

3.6.12 View Audit Trail Counter
Select Config (Configuration Counter) in the Audit menu to view the audit trail configuration counter number.

Figure 3-20. Config Parameter Menu Path

The audit trail calibration and configuration counters can be viewed in Menu mode.
1. Navigate to Audit ▼ LRV ► ... ►Config.

2. Press . The audit trail configuration counter number displays.

3. Press  to exit the menu.

Audit SetupVersion

LRVDumpAud

MENU

Audit SetupVersion

LRV CalibrDumpAud

MENU

Audit SetupVersion

LRV CalibrDumpAud Config

MENU
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3.6.13 Display Accumulator
Select DispAcm (Display Accumulator) in the Accum menu to display the accumulator.

Figure 3-21. DispAcm Parameter Menu Path

1. Navigate to Audit ► ... ► Accum ▼ DispAcm.

2. Press . The accumulator value displays.

3. Press  to exit the menu.

3.6.14 Print Accumulator
Select PrtAcum (Print Accumulator) in the Accum menu to print the accumulator value.

Figure 3-22. PortAcum Parameter Menu Path

1. Navigate to Audit ► ... ► Accum ▼ DispAcm ► PrtAcum.

2. Press  to print the accumulator value. OK displays.

3. Press  to exit the menu.

3.6.15 Clear Accumulator
Select ClrAcum (Clear Accumulator) in the Accum menu to clear the accumulator value.

Figure 3-23. ClrAcum Parameter Menu Path

1. Navigate to Audit ► ... ► Accum ▼ DispAcm ► ... ► ClrAcum.

2. Press  or  to clear the accumulator value. OK displays.

3. Press  to exit the menu.

Accum TareSetpnt

DispAcmClrAcum

MENU

Accum TareSetpnt

DispAcm PrtAcumClrAcum

MENU

Accum TareSetpnt

DispAcm PrtAcumClrAcum ClrAcum

Audit Setup

MENU
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3.6.16 View Configured Setpoint Values
Select Setpnt (Setpoint) in the top-level menu to view setpoint values.

Figure 3-24. Setpnt Parameter Menu Path

1. Navigate to Audit ► ... ► Setpnt.

2. Press . The lowest configured setpoint number displays (e.g. Setpnt 1).

3. Press  or  to navigate to the desired setpoint number (1-8).

  NOTE: Only configured setpoint numbers display. See Section 4.3.7 on page 57 for the complete setpoint menu.

4. Press . Value displays.

5. Press  again to view the current configured setpoint value.
NOTE: Displayed setpoints are editable by default, since Access defaults to On. Change Access settings if Setpoint value 
needs to be read only (Access = Off) or hidden (Access = Hidden).

6. Use arrow keys to edit the setpoint.
7. Press  to accept the new value.

Press  to exit the menu.

Audit SetpntSetup

MENU



LaserLight3 Large-Display Weight Indicator

44 Visit our website www.RiceLake.com

4.0 Configuration
There are two types of configuration parameters in the LaserLight3, Setup mode parameters (or Legal for Trade configuration) 
and Menu mode parameters (or non-legal configuration). Setup mode parameters are accessed by enabling the Audit Jumper or 
shorting the Setup jumper (Section 2.8.2 on page 25). Menu mode parameters are accessed by pressing the Menu button and 
do not require shorting the setup jumper. 
The following sections provide graphic representations of the LaserLight3 menu structures. Most menu diagrams are 
accompanied by a table which describes all parameters and parameter values associated with the menu. The factory default 
setting appears at the top of each column in bold type.
The Audit, Calibration, Setpoints, Accumulator, Tare, Test, Time, Date, MAC ID and Version menus can be accessed by 
pressing the Menu button. The Audit, Tare, MAC ID and Version menus are read only and accessible in the top-level menu. 

NOTE: The Menu mode Setpoints menu displays the setpoint value of configured setpoints and is accessible with the Menu 
button. Complete configuration of setpoints is available in Setup mode within the Setup menu. All weight related 
parameters must be configured prior to calibrating the unit.

IMPORTANT: In order to configure the LaserLight3, it must be placed in Setup mode by shorting the setup jumper or 
enabling the audit jumper (Section 2.8.2).

4.1 Main Menu
This section provides a flow chart and descriptions for the LaserLight3 top-level Main menu.

Figure 4-1. Main Menu

Menu Description
Audit See Section 4.2 on page 45 for menu structure and parameter descriptions of the Audit menu
Setup See Section 4.3 on page 45 for menu structure and parameter descriptions of the Setup menu; only accessible when in Setup 

mode by shorting the setup jumper or if the audit jumper is in the ON position
Setpnt (Setpoint) Displays the setpoint value of configured setpoints; Read only unless access parameter for the setpoint is set to ON; menu is 

empty if no setpoints are configured; setpoints are fully configurable in the setup menu while the indicator is in Setup mode
Accum (Accumulator) Displays, prints and clears accumulated weight value; see Section 4.4 on page 69
Tare Displays and clears stored tare value; see Section 4.5 on page 69
MAC ID Displays Ethernet and Wi-Fi (if installed) MAC ID addresses; see Section 4.6 on page 69
Test Performs various tests; see Section 4.7 on page 69
Time Displays the current set time; allows the time to be edited using the navigation keys; see Section 4.8 on page 71
Date Displays the current set date; allows the date to be edited using the navigation keys; see Section 4.9 on page 71
Version Displays the installed firmware version number (read only); see Section 4.10 on page 71

Table 4-1.  Main Menu Descriptions

Audit Setpnt TareSetup Accum

DateTimeMac ID Test Version
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4.2 Audit Menu
This section provides a flow chart and descriptions for the Audit menu.

Figure 4-2. Audit Menu

4.3 Setup Menu
This section provides a flow chart and descriptions for the Setup menu. 

Figure 4-3. Setup Menu

NOTE: The Setup Menu’s first option changes depending on when it is accessed during a single Setup Mode session. The 
first instance that Setup Menu is accessed, Config displays as the first option. Subsequent times Setup Menu is accessed, 
without exiting Setup Mode, changes Comm to the first option and Config to the second option.

Parameter Description
LRV (Legally Relevant Version) Legally relevant firmware version number (read only)
Calibr (Counter Calibration) Displays total number of calibration events (read only)
Config (Configuration Counter) Displays total number of configuration events (read only)
Dest 1 (Destination Port 1) Destination Port 1 – Audit trail port; Settings: RS232 1 (default), RS232 2, RS485, TCPC, TCPS, USB, NONE
Dest 2 (Destination Port 2) Destination Port 2 – Audit trail port; Settings: NONE (default), RS232 1, RS232 2, RS485, TCPC, TCPS, USB
DumpAud (Dump Audit) Sends the audit parameters to the configured audit destination ports (Section 4.3.5 on page 55)

Table 4-2.  Audit Menu Descriptions

Menu Description
Config (Configuration) See Section 4.3.1 on page 46 for menu structure and parameter descriptions of the Configuration menu
Format (Scale Format) See Section 4.3.2 on page 48 for menu structure and parameter descriptions of the Scale Format menu
Calibr (Calibration) See Section 4.3.3 on page 49 for menu structure and parameter descriptions of the Calibration menu
Program See Section 4.3.4 on page 50 for menu structure and parameter descriptions of the Program menu
PFormt (Print Format) See Section 4.3.5 on page 55 for menu structure and parameter descriptions of the Print Format menu
SFormt (Stream Format) See Section 4.3.6 on page 56 for menu structure and parameter descriptions of the Stream Format menu
Setpnt (Setpoint) See Section 4.3.7 on page 57 for menu structure and parameter descriptions of the Setpoint menu
Digio (Digital Inputs and 
Outputs)

See Section 4.3.8 on page 61 for menu structure and parameter descriptions of the Digital I/O menu

DfltCFG (Default 
Configuration)

See Section 3.5.6 on page 37 for instructions to reset the configuration settings

Remote See Section 4.3.9 on page 62 for menu structure and parameter descriptions of the Remote menu
Comm (Communication) See Section 4.3.10 on page 64 for menu structure and parameter descriptions of the Communications menu

Table 4-3.  Setup Menu Descriptions

Audit SetupVersion

LRV Calibr ConfigDumpAud Dest 1 Dest 2 DumpAud

Program PFormt SFormt

Setup SetpntAudit

RemoteDigioSetpnt Comm

FormatConfig CalibrComm

DfltCfg
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4.3.1 Configuration Menu
This section provides a flow chart and descriptions for the Configuration menu.

  NOTE: Not used for remote display configurations.

Figure 4-4. Configuration Menu

Menu Description
Capcity (Capacity) Maximum rated capacity of the scale; Enter value: 0.0000001–9999999.0, 10000.0 (default)
ZrkBn  
(Zero Track Band)

Automatically zeros the scale when within the range specified, as long as the input is within the Zero Range (%) and scale is 
at standstill; When weight is within the zero band, the center of zero annunciator displays; Max legal value depends on local 
regulations; Specify the zero tracking band in ± display divisions; Enter value: 0.0–100.0, 0.0 (default)

ZRange
 (Zero Range (%))

The total amount the scale can be zeroed; Zero range represents a percentage of capacity; The default value of 1.9 
represents ±1.9% around the calibrated zero point, for a total range of 3.8%; A value of 0.0 prevents zeroing; Maximum legal 
value depends on local regulations; Enter value: 0.0–100.0, 1.9 (default)

InitZro
(Initial Zero Range (%))

When the indicator is turned on and the weight value is between the ± percent range specified by Calibrated Zero, the 
indicator automatically zeros off the weight; Enter value: 0.0–100.0, 0.0 (default)

MotBnd
(Motion Band)

Sets the level, in display divisions, at which scale motion is detected; If motion is not detected for the time defined by Standstill 
Time, the standstill symbol lights; Some operations, including print, tare and zero, require the scale to be at standstill; 
Maximum legal value varies depending on local regulations; If this parameter is set to 0, the standstill annunciator is always lit 
and operations requiring standstill are performed regardless of scale motion; If 0 is selected, Zero Track Band must also be 
set to 0; Enter value: 0–100, 1 (default)

Overloa
(Overload)

Determines the point at which the display blanks and the overload error message displays (^^^^^^^); Maximum legal value 
varies depending on local regulations; Settings: FS (Full Scale), FS+2% (Full Scale+2%) (default), FS+1D (Full Scale + 1D), 
FS+9D (Full Scale + 9D)

SmpRat
(Sample Rate)

Selects measurement rate, in samples per second, of the analog-to-digital converter; Lower sample rate values provide greater 
signal noise immunity; Settings: 6.25HZ, 7.5HZ, 12.5HZ, 15HZ, 25HZ, 30HZ (default), 50HZ, 60HZ, 100HZ, 120HZ

FltrChn
(Filter Chain Type)

Sets the filter type to be used; Settings: 
AvgOnly (Average Only) (default) – Digital Rolling Average Filter (Section 7.1 on page 95); Uses Digital Filter Stage 1-
3, Digital Filter Sensitivity and Digital Filter Threshold
ADOnly (Adaptive Only) – Adaptive Filter (Section 7.2 on page 97); Uses Adaptive Filter Sensitivity and Adaptive Filter 
Threshold
DmpOnly (Damping Only) – Damping Filter (Section 7.3 on page 97); Uses Damping Value
Raw – No filtering

DigFl1-3
(Digital Filter Stage 1-3)

Sets the digital filtering rate used to reduce the effects of environmental influences from the immediate area of the scale; 
Settings indicate the number of A/D conversions per update which are averaged to obtain the displayed reading; a higher 
number gives a more accurate display by minimizing the effect of a few noisy readings, but slows down the response time of 
the indicator; Settings: 1, 2, 4 (default), 8, 16, 32, 64, 128, 256

DfSens
(Digital Filter Sensitivity)

Specifies the number of consecutive A/D readings which fall outside the Filter Threshold before filtering is suspended; 
Settings: 2OUT (default), 4OUT, 8OUT, 16OUT, 32OUT, 64OUT, 128OUT

DfThrh
(Digital Filter Threshold)

Sets a threshold value, in display divisions; when a number of consecutive A/D readings (Digital Filter Sensitivity) falls outside 
of this threshold value (when compared to the output of the filter), filtering is suspended and the A/D value is sent straight 
through the filter; Filtering is not suspended if the threshold is set to NONE; Settings: NONE (default), 2D, 5D, 10D, 20D, 50D, 
100D, 200D, 250D

Table 4-4.  Configuration Menu Descriptions

DfSens

RtlTrap

DfThrh

AdSense DmpValAdThrh

Overloa

TareFn SSTime

DigFl3SmpRat Fltrchn

Capcity

DigFl2DigFl1

ZTrkBn InitZroZRange MotBndSense

Setup SetpntAudit

Config FormatComm

Sense
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AdSense
(Adaptive Filter Sensitivity)

Controls the stability and response time of the scale; Settings: 
Light (default) – Fastest response to small weight changes, but less stable
Medium – Has a quicker response time than heavy, but more stable than light
Heavy – Results in an output which is more stable but settles slowly; small changes in weight data (a few grads) on the 
scale base are not seen quickly

AdThrh
(Adaptive Filter Threshold)

Sets the adaptive filter weight threshold value (in display divisions); a weight change exceeding the threshold resets the 
filtered values; must be set above the noise disturbances in the system (if set to zero, the filter is disabled); 
Enter value: 0–2000, 10 (default)

DmpVal
(Damping Value)

Sets the damping time constant (in 0.1 sec intervals); Enter value: 1–2560, 10 (default)

RtlTrap
(RattleTrap)

Enables RattleTrap filtering; Effective at eliminating vibration effects, environmental influences and mechanical interference 
from nearby machinery, may increase response time over standard digital filtering; Settings: Off (default), On

TareFn
(Tare Function)

Enables or disables push-button and keyed tare; Settings: 
Both (default) – Both push button and keyed tares are enabled
No Tare – No tare allowed (gross mode only)
PB Tare (Push Button Tare) – Push button tares enabled
Keyed (Keyed Tare) – Keyed tares enabled

SSTime
(Standstill Time)

Specifies the length of time the scale must be out of motion, before the scale is considered to be at standstill (in 0.1 sec 
intervals); Enter value: 0–600, 10 (default)

Sense Specifies the type of load cell cable connected to the J1 connector (Section 2.6 on page 17); this parameter must be set 
correctly to match the actual load cell cable connection to ensure the load cell functions properly with the indicator;
Settings: 4-WIRE (default), 6-WIRE

Menu Description

Table 4-4.  Configuration Menu Descriptions (Continued)
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4.3.2 Format Menu
This section provides a flow chart and descriptions for the Format menu.

Figure 4-5. Format Menu

Parameter Description
Primary Scale format and units settings for the Primary format; Sub-Parameters:

Format – Sets the decimal point and the display divisions for the Primary display weight format; 
Settings: 8888881 (Primary default), 8888882, 8888885, 8888810, 8888820, 8888850, 8888100, 8888200, 8888500, 
88.88881, 88.88882, 88.88885, 888.8881, 888.8882, 888.8885, 8888.881, 8888.882, 8888.885, 88888.81, 88888.82, 
88888.85, 888888.1, 888888.2, 888888.5

For example, select 8888.885 if a count by of 0.005 is needed or select 8888820 if a count by of 20 is needed 
(the 8s serve as placeholders and show a breakdown of how digits will display);

Units – Sets the units type; Settings: LB (Primary default), KG, OZ, TN, T, G, NONE
Secndry (Secondary) Scale format and units settings for the Secondary format; Sub-Parameters:

Format – Sets the decimal point and the display divisions for the Secondary display weight format; 
Settings: 8888881, 8888882, 8888885, 8888810, 8888820, 8888850, 8888100, 8888200, 8888500, 88.88881, 88.88882, 
88.88885, 888.8881, 888.8882, 888.8885, 8888.881, 8888.882, 8888.885, 88888.81, 88888.82, 88888.85, 888888.1, 
888888.2, 888888.5 (Secondary default)

For example, select 8888.885 if a count by of 0.005 is needed or select 8888820 if a count by of 20 is needed 
(the 8s serve as placeholders and show a breakdown of how digits will display);

Units – Sets the units type; Settings: LB, KG (Secondary), OZ, TN, T, G, NONE
Enabled – Enables the front panel UNITS button to toggle between the Primary, Secondary formats; Only displays under 
Secondary; Settings: ON (Secondary default)

Table 4-5.  Scale Format Menu Parameters

Primary SecndrySecndry

Setup SetpntAudit

FormatConfig Calibr

https://www.ricelake.com


Configuration

© Rice Lake Weighing Systems ● All Rights Reserved 49

4.3.3 Calibration Menu
This section provides a flow chart and descriptions for the Calibration menu.

  NOTE: Not used for remote display configurations.

Figure 4-6. Calibration Menu

Parameter Description
WZero
(Zero Calibration)

Executes the zero calibration process (Section 6.1 on page 92)

ZeroCnt
(Zero Counts)

Displays the raw count value at the zero weight; A zero calibration generates this raw count value; Manually changing this count value 
changes the zero weight and negates the zero calibration

WVal
(Test Weight)

Sets the test weight value for the span calibration (Section 6.1 on page 92); Enter value: 0.000001–9999999.999999, 10000.0 
(default)

WSpan
(Span Calibration)

Executes the span calibration process (Section 6.1.1 on page 92)

SpnCnt
(Span Counts)

Displays the raw count value at the span weight; A span calibration generates the raw count value; Manually changing this count value 
changes the span weight and negates the span calibration

WLin
(Linear 
Calibration)

Linear or multi-point calibration is performed by entering up to four additional calibration points (Section 6.1.2 on page 93); 
Points 1-4 have the following sub-parameters:

WLin V# (Linear Point # Weight) – Sets the test weight value for the linear calibration point
WLin C# (Calibrate Linear Point #) – Executes the linear calibration process for the point; generates the raw count value for the 

test weight value for Point #
WLin F# (Linear Point # Counts) – Displays the raw count value at the linear point weight; A linear calibration generates this raw 

count value; Manually changing this count value changes the linear point weight and negates the linear calibration for the 
point

Rezero Removes an offset value from the zero and span calibrations (Section 6.2.3 on page 93)
LstZero
(Last Zero)

Takes last push button zero in the system (from Weigh mode) and uses it as the new zero reference point, after which a new span 
calibration must be performed; this calibration cannot be performed when calibrating a scale for the first time (Section 6.2.1 on page 93)

TmpZero
(Temp Zero)

Temporarily zeros the displayed weight of a non-empty scale, after a span calibration was performed;
The difference between the temporary zero and the previously calibrated zero value is used as an offset (Section 6.2.2 on page 93)

Table 4-6.  Calibration Menu Parameter

Point 3Point 4 Point 2Point 1

WLin LstZero

Point 4

TmpZero

WZero ZeroCnt WSpanWVal SpnCnt

Setup SetpntAudit

CalibrFormat Program

TmpZero

Rezero
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4.3.4 Program Menu
This section provides a flow chart and descriptions for the Program menu.

Figure 4-7. Program Menu

Parameter Description
PwrUpM
(Power Up Mode)

When the indicator is turned on, it performs a display test, then enters a warm up period; Settings:
GO (default) – Performs display test, then enters Weigh mode after brief warm up period
DELAY – Performs display test, then enters a warm up period of 30 seconds

•  If no motion is detected during warm up period, indicator enters Weigh mode when warm up period ends
•  If motion is detected, the 30 second timer is reset and the warm up period is repeated

PstTare (Persistent Tare) Tare persists through a power cycle; Settings: Off (default), On
Regula
(Regulatory Mode)

Specifies the regulatory agency having jurisdiction over the scale site; the value specified for this parameter affects the function 
of the front panel tare and zero keys; Settings: NTEP (default), OIML, Canada (Measurement Canada), Indust (Industrial), 
None

OIML, NTEP and Measurement Canada modes allow a tare to be acquired at a weight greater than zero; None allows 
tares to be acquired at any weight value
OIML, NTEP and Measurement Canada modes allow a tare to be cleared only if the gross weight is at no load; None 
allows tares to be cleared at any weight value
NTEP and OIML modes allow a new tare to be acquired even if a tare is already present; In Measurement Canada 
mode, the previous tare must be cleared before a new tare can be acquired
None, NTEP and Measurement Canada modes allow the scale to be zeroed in either gross or net mode as long as the 
current weight is within the specified Zero Range (%); In OIML mode, the scale must be in gross mode before it can be 
zeroed; pressing the ZERO key in net mode clears the tare
Industrial provides a set of sub-parameters to allow customization of tare, clear and print functions in non-Legal for 
Trade scale installations

IndSet Displays when Regulatory Mode parameter is set to Industrial; See Section 4.3.4.1 on page 53
Dsplay (Display Type) Changes how information is presented on the display with three parameters. 

Bright configures the intensity of brightness displayed. Ambient light sensor detects light or brightness similar to a human eye. 
These parameters configure how the ambient light sensor adjusts the brightness on the LaserLight3:

Day – Select brightness during day; Brightness is set from 1–6 (16.67–100%) of full brightness; light sensor 
averages measured ambient light continuously over a 5-second time span; Day values = % of maximum 
brightness; Settings: 1, 2, 3, 4 (default), 5, 6

Night – Select brightness during night; Brightness is set from 1–6 (16.67–100%) of full brightness; light sensor 
averages measured ambient light continuously over a 5-second time span; Night values = % of maximum 
brightness; Settings: 1, 2, 3, 4 (default), 5, 6

Table 4-7.  Program Menu Parameters

Time

PwrUpM PstTare IndSetGrvDest

Setup SetpntAudit

Program PFormtCalibr

Zeronly

EleOrigLatOrig

Date

MaxWgh

MaxDate

Contact Accum NumWeghWmtThrhUID

Displays if Locale is set to On

KbdLock

GrvOrig GrvDest

Displays if Locale is set to Factor

Regula

Constu

ConsNu

EleDest

Displays if Locale is set to On

LatDest

KeyHold Locale

Dsplay

Displays if Regula
is set to Indust
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Dsplay (Display Type) - 
Continued

DayLVL – DYLVL is The ambient brightness threshold at which the display changes from night to day mode and 
vice versa; Settings range between 1 through 10 with 1 requiring less intense light to change to day mode 
and 10 requiring more intense light to change from night to day mode; Select the daylight level at which the 
display switches to DAY brightness mode; This may require some trial and error, due to the unique lighting 
conditions of the environment; Settings: 1, 2, 3, 4 (default), 5, 6, 7, 8, 9, 10

Intnsty – Brightness is set from 1–6 (16.67–100%) of full brightness or as DayLVL (uses Day, Night and DayLVL 
parameters to automatically adjust brightness for day and night); Settings: 1, 2, 3, 4, 5, 6 (default), DayLVL

Type sets a predefined arrangement of information on the display; Settings:
Standard (default) – sets display with about 5 in weight digits with annunciators stacked on the right side
Legacy – Sets display with about 3.75 in weight digits with annunciators along the bottom. This configuration also 

provides functionality for serial commands or digital inputs to function with traffic symbols (see Section 5.5 on 
page 86 and Section 5.6 on page 90)

Cardnal – Sets LaserLight3 as remote display and replicates Cardinal display for Message Board and Score Board 
formats (see Section 13.9 on page 145)

Color configures the color the display uses for characters. Settings; Red (default), Yellow, Green, Blue, Magenta, Cyan or 
White

ConsNu
(Consecutive Number)

Allows sequential numbering for print operations; the value is incremented following each print operation which includes 
<CN> in the ticket format; Enter value: 0–9999999, 0 (default)

Constu
(Consecutive Number 
Start)

Specifies the initial consecutive number value used when the consecutive number is reset by sending Clear Consecutive 
Number digital input; Enter value: 0–9999999, 0 (default)

UID (Unit ID) Specifies the unit identification with an alphanumeric value; Enter characters: Up to 8 alphanumeric characters, 1 (default)
Contact Contact Information; See Section 4.3.4.2 on page 54
Accum
(Accumulator)

Accumulation can be toggled On/Off; if On, accumulation occurs on print operation; if Off, an accumulation does not occur; 
Settings: Off (default), On

WmtThrh
(Weighment Threshold)

When the weight falls below the value set, the accumulator is rearmed; Enter value: 0.0–9999999.0, 1000.0 (default)

NumWegh
(Number of Weighments)

Displays the total number of weighments (read only)

MaxWgh
(Maximum Weight)

Displays the maximum weight/weighment allowed (read only)

MaxDate
(Date of Maximum Weight)

Displays the date and time the maximum weight/weighment occurred (read only)

Date Allows setting of the date format and date separator character
Format – Settings: MMDDYY (default), DDMMYY, YYMMDD, YYDDMM
Date Separator – Settings: Slash (default), Dash, Semi, Dot

Time Allows setting of the time format and the separator character
Format – Settings: 12HOUR (default), 24HOUR
Time Separator – Settings: Colon (default), Comma, Dot

KbdLock Keyboard lock, disables keyboard except for the menu and power key. Settings: Off (default), On
Zeronly Disables keyboard except for the zero, menu and power keys. Settings: Off (default), On
KeyHold Allows setting of the key hold time and interval

Key Hold Time – How long a key needs to be held before a key hold action is initiated (in tenths of a second); 
20 equals 2 seconds; Enter value: 10–50, 20 (default)

Key Hold Interval – The amount of time between increments during a key hold (in twentieths of a second);
2 equals a tenth of a second (10 increments per second during a key hold); Enter value: 1–100, 2 (default)

Locale Enables location gravity compensation; Settings: 
Off (default) – gravity compensation disabled
On – calculates gravity compensation using the origin and destination latitudes and elevations
Factor – uses origin and destination gravity factors to find gravity compensation

LatOrig
(Origin Latitude)

Origin latitude (to nearest degree) for gravity compensation; displays when Locale parameter is set to On; 
Enter value: 0–90, 45 (default)

EleOrig
(Origin Elevation)

Origin elevation (in meters) for gravity compensation; displays when Locale parameter is set to On; 
Enter value: -9999–9999, 345 (default)

Parameter Description

Table 4-7.  Program Menu Parameters (Continued)
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Figure 4-8. Day and Night Brightness

LatDest
(Destination Latitude)

Destination latitude (to nearest degree) for gravity compensation; displays when Locale parameter is set to On; 
Enter value: 0–90, 45 (default)

EleDest
(Destination Elevation)

Destination elevation (in meters) for gravity compensation; displays when Locale parameter is set to On; 
Enter value: -9999–9999, 345 (default)

GrvOrig
(Origin Gravity)

Origin gravity factor (in m/s2) for gravity compensation; displays when Locale parameter is set to Factor; 
Enter value: 9.00000–9.99999, 9.80665 (default)

GrvDest
(Destination Gravity)

Destination gravity factor (in m/s2) for gravity compensation; displays when Locale parameter is set to Factor; 
Enter value: 9.00000–9.99999, 9.80665 (default)

Parameter Description

Table 4-7.  Program Menu Parameters (Continued)
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4.3.4.1 Industrial Settings Menu
This section provides a flow chart and descriptions for the Industrial Settings menu. The Industrial Settings menu only displays 
if the Regula (Regulatory Mode) parameter is set to IndSet (Industrial).

Figure 4-9. Industrial Settings Menu

Parameter Description
AudAgcy (Audit Agency) Audit trail display agency format; Settings: NTEP (default), Measurement Canada, None, OIML
Snapsht (Snapshot) Display or scale weight source; Settings: DISPLAY (default), SCALE
HTare (Display Hold Tare) Allow tare in display hold; Settings: No (default), Yes
ZTare (Remove Tare on Zero ) Remove tare on zero; Settings: No (default), Yes
KTare (Allow Keyed Tare) Always allow keyed tare; Settings: Yes (default), No
MTare (Multiple Tare Action) Replaces existing tare when the tare key is pressed; Settings: Replace (default), Remove, Nothing
NTare (Allow Negative Tare) Allow negative or zero tare; Settings: No (default), Yes
CTare (Allow Clear Tare Key) Allow clear key to clear tare or accumulator when displayed; Settings: Yes (default), No
NegTotl (Negative Total) Allow total scale to display negative value; Settings: No (default), Yes
PrntMot (Allow Print in Motion) Allow print while in motion; Settings: No (default), Yes

PrntPt (Add PT to Keyed Tare
Print)

Add preset tare (PT) to keyed tare print; Settings: Yes (default), No

PrntHld (Print Display Hold) Print during display hold; Settings: No (default), Yes
HoldWgh (Weighment Display
Hold)

Allow weighment during display hold; Settings: NO (default), Yes

MotoWgh (Weighment in
Motion)

Allow weighment in motion; Settings: No (default), Yes

OvrBase (Zero Base for
Overload)

Zero base for overload calculation; Settings: Calibrated Zero (default), Captured Scale Zero

RTare (Round Button Tare) Round pushbutton tare to the nearest display division; Settings: NO (default), Yes
RKTare (Round Keyed Tare) Round keyed tare to the nearest display division; Settings: No (default), Yes

Azt Net (Auto-Zero Tracking on
Net Zero)

Perform auto zero tracking on net zero; Settings: No (default), Yes

MCLTare (Manual Clear Tare) Allow manual clearing of the tare value; Settings: Yes (default), No
TareMot (Tare in Motion) Allow tare in motion; Settings: No (default), Yes
ZeroMot (Zero in Motion) Allow scale to be zeroed while in motion; Settings: No (default), Yes
UldWgh (Underload Weight) Underload weight value in display divisions; Enter value: 1–9999999, 20 (default)

Table 4-8. Industrial Settings Menu Parameters

AudAgcy SnapshtULDWGH

PrintPtNTare CTare PrntMotNegTotl

MTare

PrntHld HoldWgh

Azt NetMotoWgh OvrBase RkTareRTare

UldWgh

MCLTare

ZeroMot

TareMot

KTareHTare ZTare

IndSet Dsplay

Setup SetpntAudit

Program PFormtCalibr

Regula
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4.3.4.2 Contact Information Menu
This section provides a flow chart and descriptions for the Contact Information menu.

Figure 4-10. Contact Information Menu

Parameter Description
Company Contact company name; Enter characters: Alphanumeric entry up to 30 characters
Addr 1-3 (Address 1-3) Contact company address lines; Enter characters: Alphanumeric entry up to 20 characters (for each line)
Name 1-3 Contact names; Enter characters: Alphanumeric entry up to 30 characters (for each line)
Phone 1-3 Contact phone numbers; Enter characters: Alphanumeric entry up to 20 characters (for each line)
Email Contact email address; Enter characters: Alphanumeric entry up to 40 characters
LastCal (Last Calibration) Last calibration date; Enter value: 8-digit number (MMDDYYYY)
NextCal (Next Calibration) Next calibration date; Enter value: 8-digit number (MMDDYYYY)

Table 4-9.  Contact Information Menu Parameters

Name 2Company Addr 1 Addr 3Addr 2 Name 1NextCal

Setup SetpntAudit

Program PFormtCalibr

NextCalLastCalPhone 1 Phone 2 EmailPhone 3Name 3

Contact AccumUID
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4.3.5 Print Format Menu
This section provides a flow chart and descriptions for the PFormt (Print Format) menu.

Figure 4-11. Print Format Menu

Parameter Description
Gfmt
(Gross Format)

Gross demand print format string
Format – Enter characters: Alphanumeric entry up to 1,000 characters, GROSS<G><NL2><TD><NL> (default)
Dest 1-2 (Destination Port 1-2) – Destination ports; Settings: RS-232 Port 1 (Port 1 default), RS-232 Port 2, 20MA, RS-485, 
TCP Client 1, TCP Server, USB, WiFi, None (Port 2 default)

NetFmt
(Net Format)

Net demand print format string
Format – Enter characters: Alphanumeric entry up to 1,000 characters, 
GROSS<G><NL>TARE<SP><T><NL>NET<SP2><N><NL2><TD><NL> (default)
Dest 1-2 (Destination Port 1-2) – Destination ports; Settings: RS-232 Port 1 (Port 1 default), RS-232 Port 2, RS-485, 20MA, 
TCP Client 1,  TCP Server, USB, WiFi, None (Port 2 default)

AcumFmt
(Accumulator 
Format)

Accumulator print format string
Format – Enter characters: Alphanumeric entry up to 1,000 characters, ACCUM <A><NL><DA> <TI><NL> (default)
Dest 1-2 (Destination Port 1-2) – Destination ports; Settings: RS-232 Port 1 (Port 1 default), RS-232 Port 2, 20MA, RS-485, 
TCP Client 1, TCP Server, USB, WiFi, None (Port 2 default)

StptFmt
(Setpoint Format)

Setpoint print format string
Format – Enter characters: Alphanumeric entry up to 1,000 characters, <SCV><SP><SPM><NL> (default)
Dest 1-2 (Destination Port 1-2) – Destination ports; Settings: RS-232 Port 1 (Port 1 default), RS-232 Port 2, RS-485, 20MA, 
TCP Client 1, TCP Server, USB, WiFi, None (Port 2 default)

HdrFmt
(Header Format)

Ticket header format strings
HdrFmt1  (Header Format 1) – Header 1 Format String; Enter characters: Alphanumeric entry up to 1,000 characters, 
COMPANY NAME<NL>STREET ADDRESS<NL>CITY, ST   ZIP<NL2> (default)
HdrFmt2 (Header Format 2) – Header 2 Format String; Enter characters: Alphanumeric entry up to 1,000 characters, 
COMPANY NAME<NL>STREET ADDRESS<NL>CITY, ST   ZIP<NL2> (default)

Table 4-10.  Print Format Menu Parameters

Gfmt NetFmtHrdFmt

Setup SetpntAudit

PFormtProgram SFormt

StptFmtAcumFmt HdrFmt
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4.3.6 Stream Format Menu
This section provides a flow chart and descriptions for the Stream Format menu.

Figure 4-12. Stream Format Menu

Parameter Description
SFormt (Stream 
Format)

Specifies the stream format used for streaming output of scale data or specifies the expected input for a serial scale; Settings: 
RLWS (default) – Rice Lake Weighing Systems stream format (Section 13.8.2 on page 141)
Cardinal – Cardinal stream format (Section 13.8.3 on page 141)
Weigh-Tronix – Avery Weigh-Tronix stream format (Section 13.8.4 on page 142)
Toledo – Mettler Toledo stream format (Section 13.8.5 on page 142)
Custom – Custom stream format

Custom Specifies the custom stream format; only displays if SFORMT is set to CUSTOM; see Section 13.8.6 on page 143 for available 
stream format tokens; Enter characters: Alphanumeric entry up to 1,000 characters

Gross Mode token when streaming the gross weight; Enter characters: Alphanumeric entry up to 8 characters, G (default)
Tare Mode token when streaming the tare weight; Enter characters: Alphanumeric entry up to 8 characters, T (default)
Net Mode token when streaming the net weight; Enter characters: Alphanumeric entry up to 8 characters, N (default)
Pos (Positive) Polarity token when the weight is positive; Settings: Space (default), None, +
Neg (Negative) Polarity token when the weight is negative; Settings: Space, None, – (default)
Sec (Secondary) Units token when streaming secondary units; Enter characters: Alphanumeric entry up to 8 characters, K (default)
Pri (Primary) Units token when streaming primary units; Enter characters: Alphanumeric entry up to 8 characters, L (default)
Zero Status token when the weight is at center of zero; Enter characters: Alphanumeric entry up to 2 characters, Z (default)
Motion Status token when the weight is in motion; Enter characters: Alphanumeric entry up to 2 characters, M (default)
Range (Out of Range) Status token when the weight is out of range; Enter characters: Alphanumeric entry up to 2 characters, O (default)
OK Status token when the weight is OK (not invalid, out-of-range, at zero or in-motion); 

Enter characters: Alphanumeric entry up to 2 characters (default is a space)
Invalid Status token when streaming an invalid weight; Enter characters: Alphanumeric entry up to 2 characters, I (default)
Units Units – Specifies whether the streaming unit tokens remain static or dynamically updated with the configured units; Static uses set 

Primary/Secondary unit tokens and Dynamic defaults to configured units of the scale; Settings: Dynamic (default), Static

Table 4-11.  Stream Format Menu Parameters

SFormt Custom TareGrossUnits

Setup SetpntAudit

SFormtPFormt Setpnt

Net

SecPriNeg Zero Motion

Pos

InvalidOK

Range

Units

If SFormt = Custom
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4.3.7 Setpoint Menu
The following sections provide flow charts and descriptions for the Setpoint menu.

Figure 4-13. Setpoint Menu

Parameter Description
StptCfg
(Setpoint 
Configuration)

Access to configuration parameters and settings for up to eight setpoints; Settings: Setpoint 1-8
Kind – Setpoint Kind; Settings: Off (default), Gross, Net, -Gross (Negative Gross), -Net (Negative Net), Accum (Accumulate), 

PosRel (Positive Relative), NegRel (Negative Relative), PctRel (Percent Relative), Pause, Delay, WaitSS (Wait 
Standstill), Counter, AutoJog, Coz (Center of Zero), InMoton (In Motion), InRange, BatchPr (Batch in Process), Timer, 
Concurr (Concurrent), TOD (Time Of Day), Always, Never, Off

Batchng (Batching) Batch sequence runs when set to Auto or Manual; Settings: 
Off (default)
Auto – Allows the batch sequence to repeat automatically once it has been started
Manual – Requires a Batch Start input/command to run the batch sequence

Table 4-12.  Setpoints Menu Parameters

StptCfg BatchngBatchng

Setup SetpntAudit

Setpnt DigioSFormt

Setpnt 1 Setpnt 2-8Setpnt 8

Kind KindKind

InRangeAutoJog InMotonCoz

AccumOff Gross -GrossNet -NetNever

CounterWaitSSNegRel PctRel DelayPausePosRel

BatchPr ConcurrTimer

AlwaysTOD Never

Section 4.3.7.1 Section 4.3.7.3 
on page 59

Section 4.3.7.1 Section 4.3.7.3 
on page 59Section 4.3.7.2 on page 58

Section 4.3.7.3 on page 59 Section 4.3.7.3 on page 59Section 4.3.7.2 
on page 58

Section 4.3.7.3 
on page 59

Section 4.3.7.2 
on page 58
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4.3.7.1 If Kind = Gross, Net, Negative Gross, Negative Net, Positive Relative, Negative Relative, Percent Relative

Figure 4-14. Setpoints Parameter Group A

4.3.7.2 If Kind = Accumulate, Delay, Wait Standstill, Auto-Jog, Time Of Day

Figure 4-15. Setpoints Parameter Group B

StptCfg BatchngBatchng

Setup SetpntAudit

Setpnt DigioSFormt

Setpnt 1 Setpnt 2-8Setpnt 8

Alias

PshTareClrTare PshPrintPshAcc

PreactKind Value BandValTrip Hysteres

ClrAcumAlarmPreAdj PreStab RelNumPCountPreVal

DSlot SenseDigOut

BranchBatch Enable Access Alias

If Trip = Inband
or Outband

If Trip = Higher
or Lower

If Preact =
On or Learn If Preact = Learn

Based on Digital I/O
set as DigOut

If Batch = On

If Kind = PosRel,
 NegRel or PctRel

StptCfg BatchngBatchng

Setup SetpntAudit

Setpnt DigioSFormt

Setpnt 1 Setpnt 2-8Setpnt 8

Alias

BranchDigOut BatchSense

DuratonKind Value BandValTrip Time

DSlotPshTareClrAcum ClrTare PshPrintPshAccAlarm

Enable AliasAccess

If Trip = Inband
or Outband

If Kind = Accumulate,
Delay or Wait Stanstill

If Kind =
Accumulate

If Batch = On, and
Kind = Accumulate

If Kind = Accumulate
or Time Of Day

If Kind = Accumulate
or Delay

If Kind =
Accumulate If Kind = Time Of Day
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4.3.7.3 If Kind = Pause, Counter, Center of Zero, In Motion, In Range, Batch in Process, Timer, Concurrent

Figure 4-16. Setpoints Parameter Group C

Parameter Description
Value For weight-based setpoints: Enter value: 0.0–9999999.0, 0.0 (default)

For time-based setpoints: Enter value: 0.0–65535.0, 0.0 (default)
For Counter setpoints: Enter value: 0.0–65535.0, 0.0 (default)

Trip Specifies whether the setpoint is satisfied when the weight is higher or lower than the setpoint value, within a band established around 
the value, or outside of the band; in a batch sequence with Trip = Higher, the associated digital output is active until the setpoint value is 
reached or exceeded; with Trip = Lower, the output is active until the weight goes below the setpoint value; 
Settings: Higher (default), Lower, Inband, Outband

BandVal
(Band Value)

For setpoints with Trip = Inband or Outband, specifies a weight equal to half the band width; The band established around the setpoint 
value is Value ± Band Value; Enter value: 0.0–9999999.0, 0.0 (default)

Hysteres 
(Hysteresis)

Specifies a band around the setpoint value which must be exceeded before the setpoint, once off, can trip
on again; Enter value: 0.0–9999999.0, 0.0 (default)

Preact Allows the digital output associated with a setpoint to shut off before the setpoint is satisfied to allow for material in suspension; 
Settings:

Off (default)
On – Adjusts setpoint trip value up or down (depending on the Trip parameter setting) from setpoint value using a fixed value 
specified on the Preact Value parameter
Learn – Can be used to automatically adjust the Preact value after each batch; it compares the actual weight at standstill to the 
target setpoint value and adjusts the Preact Value by the Preact Adjust (%) value times the difference after each batch

Start Specifies starting setpoint number; do not specify number of the Timer or Concurrent setpoint itself; Timer or Concurrent setpoint begins 
when starting setpoint begins; Enter value: 1–8, 1 (default)

End Specifies ending setpoint number; do not specify number of the Timer or Concurrent setpoint itself; Timer or Concurrent setpoint stops 
when ending setpoint begins; Enter value: 1–8, 1 (default)

Time For Time Of Day setpoints, specifies the time at which the setpoint becomes active; the format used to enter the time (12hour or 24hour) 
is based on the value specified for the Time Format parameter in the Program menu (HHMM); Enter value: 0000 (default)

Duraton (Duration) For Time Of Day setpoints; specifies the length of time the digital output associated with this setpoint changes state; value is entered in 
hours, minutes and seconds (HHMMSS); Enter value: 000000 (default)

PreVal (Preact Value) Specifies the preact value for setpoints with Preact set to On or Learn; depending on the Trip setting specified for the setpoint, the 
setpoint trip value is adjusted up or down by the Preact Value; Enter value: 0.0–9999999.0, 0.0 (default)

PreAdj
(Preact Adjust)

Setpoints with Preact set to Learn, specifies a decimal representation of the percentage of error correction applied (50.0 = 50%, 100.0 
= 100%) each time a Preact adjustment is made; Enter value: 0.0–100.0, 50.0 (default)

PreStab (Preact 
Stability)

Setpoints with Preact set to Learn, specifies the time, in 0.1-sec intervals, to wait for standstill before adjusting the Preact value; setting 
this parameter to a value greater than zero disables the learn process if standstill is not achieved in the specified interval (in tenths of a 
second); Enter value: 0–65535, 0 (default)

Table 4-13.  Kind Parameter Descriptions

StptCfg BatchngBatchng

Setup SetpntAudit

Setpnt DigioSFormt

Setpnt 1 Setpnt 2-8Setpnt 8

Alias DigOutKind Value EndStart DSlot

Branch Access AliasSense

If Kind = Counter

If Kind = Counter,
Timer or Concurrent

If Kind = Timer
or Concurrent
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PCount
(Preact Count)

Setpoints with Preact set to Learn, specifies the number of batches after which the preact value is recalculated; the default value, 1, 
recalculates the preact value after every batch cycle; Enter value: 1–65535, 1 (default)

RelNum
(Relative Setpoint
Number)

For relative setpoints, specifies the number of the relative setpoint; Enter value: 1–8, 1 (default)
Target weight for this setpoint is determined as follows:

Positive Relative setpoints, the value of the relative setpoint plus the value (Value parameter) of the Positive Relative setpoint
Negative Relative setpoints, the value of the relative setpoint minus the value of the Negative Relative setpoint
Percent Relative setpoints, the percentage (specified on Value parameter of the Percent Relative setpoint) of the target value of 
the relative setpoint

Alarm Specify On to display the word Alarm on the primary display while the setpoint is active (batch setpoints) or while the setpoint is not 
tripped (continuous setpoints); Settings: Off (default), On

ClrAcum (Clear 
Accumulator)

Specify On to clear the accumulator when the setpoint is satisfied; Settings: Off (default), On

ClrTare (Clear Tare) Specify On to clear the tare when the setpoint is satisfied; Settings: Off (default), On
PshAcc (Push 
Accumulator)

Specify On to update the accumulator and perform a print operation when the setpoint is satisfied; specify On Quiet to update the 
accumulator without printing; Settings: Off (default), On, On Quiet

PshPrint (Push Print) Specify On to perform a print operation when the setpoint is satisfied; specify Wait Standstill to wait for standstill after setpoint is 
satisfied before printing; Settings: Off (default), On, Wait Standstill

PshTare
(Push Tare)

Specify On to perform an acquire tare operation when the setpoint is satisfied; Settings: Off (default), On
NOTE: Push Tare acquires the tare regardless of the value specified for the Regulatory Mode parameter in the Program menu.

DSlot
(Digital Output Slot)

Lists all available digital I/O slots; this parameter specifies the slot number of the Digital I/O card referenced by the Digital Output 
setpoint; Settings: None (default), 0, 1

DigOut
(Digital Output)

Lists all digital output bit numbers available for the specified Digital Output Slot; this parameter is used to specify the digital output bit 
associated with this setpoint; use the Digital I/O menu to assign bit function to Output; Enter value: 1–4, 1 (default)
NOTE: For continuous setpoints, the digital output becomes active (low) when the condition is met; for batch setpoints, the digital output is 
active until the setpoint condition is met.

Sense Specifies whether the value of the digital output associated with this setpoint is inverted when the setpoint is satisfied; 
Settings: Normal (default), Invert

Batch Specifies whether the setpoint is used as a batch (On) or continuous (Off) setpoint; Settings: Off (default), On
Branch Specifies the setpoint number to which the batch sequence is to branch, if the current setpoint is not satisfied upon initial evaluation 

(0 = do not branch); Enter value: 0–8, 0 (default)
Enable Specifies if setpoint parameters display in Menu mode; Settings: On (default), Off
Access Specifies the access allowed to setpoint parameters in Menu mode; Settings: 

On (default) – Values can be displayed and changed
HIDE – Values cannot be displayed or changed
OFF – Values can be displayed but not changed

Alias Name for the setpoint; Enter characters: Alphanumeric entry up to 8 characters, SETPT# (default)

Parameter Description

Table 4-13.  Kind Parameter Descriptions (Continued)
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4.3.8 Digio (Digital I/O) Menu
This section provides a flow chart and descriptions for the Digio menu.

Figure 4-17.  Digital I/O Menu

Parameter Description
Bit 1-4 Digital I/O Bit 1-4 – Specifies the mode and function of the digital I/O pins; Settings: Off (default), Print, Zero, Tare, Units, 

Primary, Secndry, Clear, DspAcc (Display Accumulator), DspTare (Display Tare), ClrAcc (Clear Accumulator), ClrTare (Clear Tare), 
NT/GRS (Net/Gross), Gross, Net, ClrCN (Clear Consecutive Number), KbdLock (Keyboard Lock), BatRun (Batch Run), BatStry 
(Batch Start), BatPaus (Batch Pause), BatRest (Batch Reset), BatStop (Batch Stop), Output, Input

Table 4-14.  Digio Menu Parameters

Slot 0 Slot 0Slot 0

Setup SetpntAudit

DigioSetpnt DfltCfg
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4.3.9 Remote Menu
This section provides a flow chart and descriptions for the Remote menu.

Figure 4-18. Remote Menu

Menu Description
Manual Advances to MnLMode (Manual Mode) (see Table 4-15 on page 62)
HoldWt (Hold Weight) Holds last weight on display; Settings: On, Off (default), Demand

On – Holds last weight displayed if communication is lost and prevents remote display from going into an error condition.
Off – Hold weight function is not used.
Demand – Holds last weight until a new weight prints.

Mirror Select On to display LED readout in reverse; The menu is viewed normally; Settings: On, Off (default), Toggle
Addres (Address) Assign a command address by selecting a number from 0–ff (255), 0 (default)
MsgTim (Message Time) Input the amount of time a message displays on the remote display; Time can display from 1-seconds to 65535-seconds 

(default 5 seconds); If 0 is entered the message displays indefinitely
NOTE: For information about clearing or sending messages with DM commands, see Section 5.5.2 on page 88.

DspTest (Startup Display 
Test)

Set this parameter On to view the splash screen on start up; Settings: On, Off (default)

Tm/Dt (Time/Date) Time and date on displays when weight is zero for increments of five seconds; Settings: On, Off (default)
Keys Contains 5 options that can be assigned strings that transmit to the host indicator via the configured RemoteIn port when the 

corresponding front panel key is pressed. The strings are typically edited if the serial commands for these functions on the host are 
different. If the parameter is configured without values (not including spaces), the key does not transmit strings to the host indicator.

Print - Defines Print key string. Settings: 0 to 20 alphanumeric characters, KPRINT (default)
Units - Defines Units key string. Settings: 0 to 20 alphanumeric characters, KUNITS (default)
Tare - Defines Tare key string. Settings: 0 to 20 alphanumeric characters, KTARE (default)
GR/NT - Defines Gross/Net key string. Settings: 0 to 20 alphanumeric characters, KGROSSNET (default)
Zero - Defines Zero key string. Settings: 0 to 20 alphanumeric characters, KZERO (default)

Table 4-15.  Remote Menu Descriptions

Manual MirrorHoldWtkeys

Setup SetpntAudit

Remote Comm
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DspTest Tm/Dt Keys

DfltCfg
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4.3.9.1 Manual Mode Menu
This section provides a flow chart and descriptions for the Manual Mode menu.

Figure 4-19. Manual Mode Menu

NOTE: Manual Mode parameter configuration behaves differently when compared to other parameters. Many of these 
parameters will bring up the entire raw format display including control characters. A cursor accompanies the raw format, the arrows 
keys moves the cursor and pushing  sets the configuration at the cursor’s position.

Menu Description
MnlMode (Manual Mode) Enables or disables Manual Mode parameters; Settings: On, Off (default)
MnlMVal (Manual Mode 
Validation)

Display one parameter at a time that causes a Manual Mode issue

AnchrSq (Anchor Sequence) The beginning or end character in a stream, used to determine boundaries of incoming text frame
WgtBeg (Weight Start) Select start of weight string with cursor
WgtEnd (Weight End) Select end of weight string with cursor
UnitBeg (Unit Start) Select the first character of the unit string (for example: lb, kg, oz, g, T and tn)
UnitEnd (Unit End) Select the last character of the unit string (for example: lb, kg, oz, g, T and tn)
ModeBeg (Mode Start) Select the first character of the Mode string (for example: gross or net)
ModeEnd (Mode End) Select the character of the Mode string (for example: gross or net)
StatBeg (Status Start) Select the first character of the status string (for example: center of zero, invalid, motion, OK, overload or underload)
StatEnd (Status End) Select the last character of the status string (for example: center of zero, invalid, motion, OK, overload or underload)
PolBeg (Priority Start) Select the first character of the of the polarity string (for example: space, + or -)
PolEnd (Priority End) Select the last character of the of the polarity string (for example: space, + or -)
UnitDef (Unit Definitions) Define the name for each unit:

Lbs – Defines Status name for Invalid. Settings: Enter up to eight A-Z characters, L (default)
Kg – Defines Status name for Motion. Settings: Enter up to eight A-Z characters, K (default)
Tons – Defines Status name for Overload. Settings: Enter up to eight A-Z characters, T (default)
ShortTon – Defines Status name for Underload. Settings: Enter up to eight A-Z characters, t (default)
Ounces – Defines Status name for Center of Zero. Settings: Enter up to eight A-Z characters, O (default)
Grams – Defines Status name for OK. Settings: Enter up to eight A-Z characters, G (default)
NOTE: Each unit must have the same quantity of characters. Use leading space to increase character count if 
needed.

ModeDef (Mode Definitions) Defines the name for each mode:
Gross – Defines Mode name for Gross. Settings: Enter up to eight A-Z characters, G (default)
Net – Defines Mode name for Net. Settings: Enter up to eight A-Z characters, N (default)
NOTE: Each unit must have the same quantity of characters. Use leading space to increase character count if 
needed.

Table 4-16.  Remote Menu Descriptions

MnlMode MnlMVal WgtBegAnchrSqSetAnn

Setup SetpntAudit

Remote Comm
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PolEnd UnitDef StatDefModeDef PolDefs
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4.3.10 Communications Menu
This section provides a flow chart and descriptions for the Communications menu.

Figure 4-20. Communications Menu

StatDef (Status Definitions) Define the name for each status:
Invlid (Invalid) – Defines Status name for Invalid. Settings: Enter up to eight A-Z characters, I (default)
Motion – Defines Status name for Motion. Settings: Enter up to eight A-Z characters, M (default)
OvrLoad (Overload) – Defines Status name for Overload. Settings: Enter up to eight A-Z characters, O (default)
UdrLoad (Underload) – Defines Status name for Underload. Settings: Enter up to eight A-Z characters, U (default)
COZ (Center of Zero) – Defines Status name for Center of Zero. Settings: Enter up to eight A-Z characters, Z (default)
OK – Defines Status name for OK. Settings: Enter up to eight A-Z characters, (space) (default)
NOTE: Each unit must have the same quantity of characters. Use leading space to increase character count if 
needed.

PolDefs (Polarity Definitions) Define the name for each status (8 alpha character limit). Each unit must have the same quantity of characters. Use leading 
space to increase character count if needed. Default Settings: space (positive) and - (negative)
es the name for each mode:

Negativ (Negative) – Defines Mode name for Gross. Settings: Enter up to eight A-Z characters, - (default)
Positiv (Positive) – Defines Mode name for Net. Settings: Enter up to eight A-Z characters, (Space) (default)
NOTE: Each unit must have the same quantity of characters. Use leading space to increase character count if 
needed.

SetAnn (Set Annunciator) Disable or select which unit/mode annunciators are enabled manually. If disabled, the appropriate annunciator does not dis-
play. If selected, the appropriate annunciator displays.

Disable – Disables annunciator for Unit, Mode, Status or Polrity. Settings: Yes, No (default)
NOTE: Unit, Mode, Status are applicable to Manual and Auto Learn Modes, while Polrity is only applicable to 
manual mode.
UnitAnn (Unit Annunciator) – Defines Status name for Invalid. Settings: Primary, Secondary, Off (default)
ModeAnn (Mode Annunciator) – Defines illuminated mode annunciator. Settings: Gross, Net, Off (default)

Menu Description
Serial RS-232, RS-485/422 or 20 mA serial communications (Section 4.3.10.1 on page 65)
USB Intended to be connected to a PC only; appears as a Virtual COM Port and is assigned a “COMx” designation; 

Applications communicate through the port like a standard RS-232 communications port (Section 4.3.10.2 on page 66)
Ethrnet Features Ethernet TCP/IP 10Base-T/100Base-TX communication and can support two simultaneous connections, one as a 

server, the other as a client (Section 4.3.10.3 on page 67)
WiFi Supports Wi-Fi communications (Section 4.3.10.4 on page 68)

Table 4-17.  Communications Menu Descriptions

Menu Description

Table 4-16.  Remote Menu Descriptions (Continued)

Serial USB WiFiEthrnetWiFi

Setup SetpntAudit

CommRemote Config
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4.3.10.1 Serial Menu
This section provides a flow chart and descriptions for the Serial menu.

Figure 4-21. Serial Menu

Parameter Description
RS-232 Port 1-2
RS-485/422
20 mA Current Loop

Configurable parameters for serial communications ports; Sub-Parameters:
Trigger – Sets the input trigger type; Settings: 

RmtIn (Remote In) – Configures the port to operate as a serial input. This option is used with Remote display 
configurations.

RmtOut (Remote Out) – Configures the port to operate as a serial output (similar to an echo), it bypasses processing 
and sends what is received on the RmtIn port out on the configured port. This is available for multiple ports 
simultaneously

NOTE: For the RS-485/422 port when Stream Industrial, Stream Legal for Trade, RmtIn and RmtOut is 
configured and only RS422 streams data (RS-485 port does not stream data).
CMD (Command) (default) – Allows operation of EDP commands and printing
StrInd (Stream Industrial) – Scale data is updated up to configured sample rate; Allows operation of EDP commands 

and printing
StrLft (Stream Legal for Trade) – Scale data is updated at configured display update rate; Allows operation of EDP 

commands and printing
Baud – Sets the transmission speed for the port; Settings: 1200, 2400, 4800, 9600 (default), 19200, 28800, 38400, 

57600, 115200, Auto
Bits – Sets number of data bits transmitted or received by the port and specifies the parity bit to odd, even or none; 

Settings: 8NONE (default), 8EVEN, 8ODD, 7EVEN, 7ODD
Stop Bits – Sets the number of stop bits transmitted or received by the port; Settings: 1 (default), 2
LnTerm (Line Terminator) – Sets the termination character for data sent from the port; Settings: CR/LF (default), CR
Eoldly (End of Line Delay) – Sets the delay period from when a formatted line is terminated to the beginning of the next 

formatted serial output (0.1-second intervals); Enter value: 0–255, 0 (default)
Echo – Specifies if characters received by the port are echoed back to the sending unit; Settings: On (default), Off
NOTE: When the RmtIn parameter is enabled, the Echo parameter is unavailable.
Respnse (Response) – Specifies if the port transmits replies to serial commands; Settings: On (default), Off
RS-485/422 specific parameters:
Address – Specifies address used to connect to the port; Must be set to 0 for RS-422; Enter value: 0–255, 0 (default)
Duplex – Specifies FULL (4-wire) or HALF (2-wire) duplex used to connect to the port; Settings: FULL (default), HALF

Table 4-18.  Serial Menu Parameters

RS232 1 RS32 2 RS48520MA

Serial USBWiFi

CommRemote Config

20MA

Setup SetpntAudit
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4.3.10.2 USB Menu
This section provides a flow chart and descriptions for the USB menu.

Figure 4-22. USB Menu

Parameter Description
Trigger Sets the input trigger type; Settings: 

Command (default) – Sets input trigger to command; allows operation of EDP commands and can print
Stream Industrial – Scale data is updated up to configured sample rate; allows operation of EDP commands and printing
Stream Legal For Trade – Scale data is updated at configured display update rate; allows operation of EDP commands 

and printing
RmtIn (Remote In) – Configures the port to operate as a serial input. This configuration is used with Remote display 

configurations.
RmtOut (Remote Out) – Configures the port to operate as a serial output

LnTerm (Line Termination) Sets the termination character for data sent from the port; Settings: CR/LF (default), CR
Echo Specifies if characters received by the port are echoed back to the sending unit; Settings: On (default), Off
Respnse (Response) Specifies if the port transmits replies to serial commands; Settings: On (default), Off
Eoldly (End of Line Delay) End of line delay sets the delay period from when a formatted line is terminated to the beginning of the next formatted serial 

output (0.1-second intervals); Enter value: 0–255, 0 (default)

Table 4-19.  USB Menu Parameters

Trigger LnTerm EchoEoldly

USB EthrnetSerial

Setup SetpntAudit

CommRemote Config

Respnse Eoldly
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4.3.10.3 Ethernet Menu
This section provides a flow chart and descriptions for the Ethrnet (Ethernet) menu.

Figure 4-23. Ethernet Menu

Parameter Description
Mac ID Displays the Ethernet MAC address (read only): 00:00:00:00:00:00
DHCP Dynamic Host Configuration Protocol (static allocation of IP address when OFF); Settings: On (default), Off
Enabled Enables Ethernet communications; Settings: Off (default), On
Ip Addr (IP Address) IP Address; Enter value: 0.0.0.0 (default)
Subnet Subnet Mask; Enter value: 255.255.255.0 (default)
Gateway Default Gateway; Enter value: 0.0.0.0 (default)
EthSrvr
(Ethernet Sever)

Allows the LaserLight3 to receive external EDP commands; Sub-parameters:
Port – Specifies IP Address port to open to establish communications; Enter value: 1025–65535, 10001 (default)
Name – Host name for Ethernet Server; Enter characters: Alphanumeric entry up to 30 characters, 0 (default)
Trigger – Sets the input trigger type; Settings: CMD (Command) (default), StrInd (Stream Industrial), StrLft (Stream Legal 
For Trade), RmtIn (Remote In), RmtOut (Remote Out)
LnTerm (Line Terminator) – Sets the termination character for data sent from the port; Settings: CR/LF (default), CR
Echo – Specifies if characters received by the port are echoed back to the sending unit; Settings: Off (default), On
Respnse (Response) – Specifies if the port transmits replies to serial commands; Settings: On (default), Off

EthClnt
(Ethernet Client)

Allows the LaserLight3 to send EDP commands to external devices; Sub-parameters: 
Echo – Specifies if characters received by the port are echoed back to the sending unit; Settings: On (default), Off
Eoldy (End of Line Delay) – Sets the delay period from when a formatted line is terminated to the beginning of the next 

formatted serial output (0.1-second intervals); Enter value: 0–255, 0 (default)
IPAddre (Remote IP Address) – Sets the remote IP Address; Enter value: 0.0.0.0 (default)
LnTerm (Line Terminator) – Sets the termination character for data sent from the port; Settings: CR/LF (default), CR
Port (Remote Port) – Specifies IP Address port to look for to establish communications; Enter value: 1025–65535, 10001 

(default)
Respnse (Response) – Specifies if the port transmits replies to serial commands; Settings: On (default), Off
Trigger – Sets the input trigger type; Settings: Command (default), Stream Industrial, Stream Legal For Trade, Remote In, 

Remote Out
DiscTim (Disconnect Time) – Sets the disconnect timeout (in seconds); Enter value: 0–60, 0 (default)

Table 4-20.  Ethernet Menu Parameters

Mac ID DHCP EnabledEthClnt

Ethrnet WiFiUSB

Setup SetpntAudit

CommRemote Config

Ip Addr

Gateway EthSrvr EthClnt

Subnet
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4.3.10.4 WiFi Menu
This section provides a flow chart and descriptions for the WiFi menu.

 NOTE: Wi-Fi is an factory installed LaserLight3 option and is not included with all systems.

Figure 4-24. WiFi Menu

Parameter Description
Enabled Enables the wireless module and specifies WiFi communication; Settings: OFF (default), WiFi
Trigger Sets the input trigger type; Settings: Settings: Command (default), Stream Industrial, Stream Legal For Trade, RmtIn, RmtOut

CMD (Command) (default) – Sets the input trigger to command; allows operation of EDP commands and can print
StrInd (Stream Industrial) – Scale data is updated up to configured sample rate; allows operation of EDP commands and printing
StrLft (Stream Legal for Trade) – Scale data is updated at configured display update rate; allows operation of EDP commands and 
printing
RmtIn (Remote In) – Configures the port to operate as a serial input. This configuration is used with Remote display 
configurations.
RmtOut (Remote Out) – Configures the port to operate as a serial output

LnTerm
(Line Termination)

Sets the termination character for data sent from the port; Settings: CR/LF (default), CR

Eoydly
(End of Line Delay)

End of Line Delay sets the delay period from when a formatted line is terminated to the beginning of the next formatted serial 
output (0.1-second intervals); Enter value: 0–255, 0 (default)

Echo Specifies if characters received by the port are echoed back to the sending unit; Settings: On (default), Off
Respnse (Response) Specifies if the port transmits replies to serial commands; Settings: On (default), Off
Mac ID Displays the read only Wi-Fi MAC address (in installed): 00:00:00:00:00:00 or blank (if not equipped)

Table 4-21.  WiFi Menu Parameters

Enabled Trigger LnTermMac ID

WiFiUSB

Setup SetpntAudit

CommRemote Config

Serial

Eoydly RespnseEcho Mac ID
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4.4 Accumulator Menu
This section provides a flow chart and descriptions for the Accumulator menu.

Figure 4-25. Accumulator Menu

4.5 Tare Menu
This section provides a flow chart and descriptions for the Tare menu.

Figure 4-26. Tare Menu

4.6 MAC ID
This section provides a flow chart and descriptions for the MAC ID menu.

Figure 4-27. MAC ID Date Menu

Parameter Description
DispAcm (Display Accumulator) Displays the accumulator value (read only)
PrtAcum (Print Accumulator) Prints the accumulator value to specified port, if setup
ClrAcum (Clear Accumulator) Clears the accumulator value

Table 4-22.  Accumulator Menu Parameters

Parameter Description
DispTar (Display Tare) Displays the current tare value (read only)
ClrTare (Clear Tare) Clears the current tare value

Table 4-23.  Tare Menu Parameters

Parameter Description
Wired Views read only Ethernet MAC Address: 00:00:00:00:00:00
WiFi Views read only WiFi MAC Address (if installed): 00:00:00:00:00:00 or blank (if not equipped)

Table 4-24.  MAC ID Menu Parameters

Accum TareSetpnt

DispAcm PrtAcumClrAcum ClrAcum

DispTar ClrTareClrTare

Tare Mac IDAccum

Mac ID TestTare

Wired WiFiWiFi
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4.7 Test Menu
This section provides a flow chart and descriptions for the Test menu.

Figure 4-28. Test Menu

Parameter Description
Digout (Digital Output) Provides a way to test states of digital outputs. Use the left and right arrows to select bit 1 - 4. The bit activates for three sec-

onds, displays "OK" and then becomes inactive
NOTE: Digital output bits must be configured as an output to be tested. Displays “Bit not configured” if a digital out-
put bit is not assigned.
NOTE: For more information, see Section 12.8.1 on page 133.

Digin (Digital Input) Displays a summed decimal representation of all active Digital I/O (J5 on the CPU board) input signals. The range is 0 - 15. 

NOTE: For more information, see Section 12.8.2 on page 133.
Loopbck (Loop-back) This test provides a loop-back self test for use in diagnosing serial communications errors. The loop-back self test checks the 

function of the serial port by sending and receiving data to itself. The following connections must have a jumper wire attached 
during testing:

• RS-232 1 (J3): TX 1 → RX 1
• RS-232 2 (J3): TX 2 → RX 2
• RS-485 (J4):

• TX Z → RX B
• TX Y → RX A

If the data is sent and received as expected, the test is successful and Pass displays. If the data is not sent or received, the 
test is unsuccessful and displays Fail
NOTE: For more information, see Section 12.8.3 on page 134.

LightLvL (Light Level) Displays raw data received from the light sensor.
Display Tests display with user selected color (None, Red, Green, Blue, White). Press any key will return to test menu.

Table 4-25.  Test Menu Parameters

Digout DiginDisplay

Test TimeMac ID

LightLvl DisplayLoopBack

Connector Pin Signal Input Bit
J5 1 +5 VDC, 250 mA max -

2 GND -
3 DIO1 1
4 DIO2 2
5 DIO3 4
6 DIO4 8
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4.8 Time Menu
This section provides a flow chart and descriptions for the Time menu.

Figure 4-29. Set Time Menu

4.9 Date Menu
This section provides a flow chart and descriptions for the Date menu.

Figure 4-30. Date Menu

4.10 Version
This section provides a flow chart and descriptions for the Version menu.

Figure 4-31. Version Date Menu

Parameter Description
Time Sets hour, minute and Meridian Indicator.

Table 4-26.  Time Menu

Parameter Description
Date Sets date, month and year

Table 4-27.  Set Date Menu Parameters

Parameter Description
Software Version Displays installed software version

Table 4-28.  Version Menu Parameters

Time DateTest

Date VersionTime

Version AuditDate
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5.0 Remote Display Configuration
The LaserLight3 Large-Display Weight Indicator can be configured as an indicator (with scale functionality) or a remote display. 
This section describes how to configure LaserLight3 as a remote display. 

NOTE: Configuration occurs, after unpacking (Section 2.1), wiring is complete (Section 2.6), and Setup mode access 
(Section 2.8.2 on page 25) is configured.

When configuring the LaserLight3 as a remote display, set the Display Type parameter then define Auto-Learn or Manual 
Mode. Auto-Learn mode (Section 5.2.2) attempts to parse weighment data from the connected indicator. In the event a parsed 
data format is unknown, Auto-Learn mode activates and attempts to rectify weighment data. If it is unable to parse the 
weighment data, Manual Mode must be used to configure how data is displayed (Section 5.3 on page 76). 

5.1 Configure Display Type
When configuring the display, the Dsplay (Display) Type parameter must be set. Set the parameter as Legacy (annunciators 
along the bottom, allows specific serial commands and external switches), Standard (annunciators along the right side) or 
Cardnal (replicates score board or message board displays) (see Section 4.3.4 on page 50 for definitions). 

 

Figure 5-1. Type Parameter Menu Path

1. Navigate to Audit ► Setup ▼Config ► ... ►Program ▼ PwrUpM ► ... ► Dsplay ▼ Type.
2. Press . The Type configuration displays.

3. Press  or  repeatedly until the desired Type is selected (Standard, Legacy, or Cardnal).

4. Press  to confirm the Type configuration.

5. Press  to exit the menu.

PwrUpM PstTareGrvDest

Setup SetpntAudit

Program PFormtCalibr

Regula Dsplay

Bright Type

Legacy Standard Cardnal

MENU
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5.2 Automatic Configuration
LaserLight3 provides three functions that attempt to automatically set remote display parameters:

• Automatic Baud Configuration (Section 5.2.1 on page 73)
• Auto-Learn (Section 5.2.2 on page 74)

5.2.1 Automatic Baud Configuration
The automatic baud configuration feature automatically sets the serial communication protocol (RS-232, RS-485/422 and 20 
mA current loop) parameters. Automatic baud configuration searches for serial communication settings (baud rate, bits and 
stop bits) until it finds and sets parameters that establish a serial connection.

NOTE: Prior to activating automatic baud configuration, current Baud, Bits, and Stop Bits parameter values can be 
recorded from the Serial menu to later verify and compare value changes. 

Figure 5-2 displays the menu path to the Baud parameter.

Figure 5-2. Baud Parameter Menu Path

To enable Automatic baud configuration, perform the following :
1. Navigate to Audit ► Setup ▼Config ►... ►Comm ▼Serial ▼ Communication Protocol* ▼ Trigger ► Baud. 

* RS232 1, RS232 2, RS485 or 20MA

2. Press . The configured parameter displays.

3. Press  or  repeatedly until Auto is selected.

4. Press  to confirm the parameter configuration.

5. Press  to exit the menu.
6. The automatic baud configuration function executes.

RS232 1 RS32 2 RS48520MA

Serial USBWiFi

CommRemote Config

20MA

Trigger Baud

Setup SetpntAudit

MENU
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5.2.2 Auto-Learn and Data String Recognition
Auto-Learn examines the data stream sent from the connected indicator and determines the data settings and format used by 
the indicator. Auto-Learn is capable of recognizing several common data string formats used in the weighing industry. Auto-
Learn is enabled when the Trigger parameter for a communication protocol (RS-232, RS-485/422, 20 mA current loop, Ethernet 
or Wi-Fi) is configured as RmtIn (Remote In). 

NOTE: Only configure one communication protocol as RmtIn (Remote In). If more than one communication protocol is 
configured as RmtIn (Remote In), LaserLight3 uses the first communication protocol configured with RmtIn (Remote In) 
that occurs in the system menu:

• RS232-1
• RS232-2
• 20mA
• RS485/422
• Ethernet Server
• Ethernet Client
• WiFi

For example, if RS232-2 and WiFi were set as Remote In, RS232-2 would be used as it appears before WiFi in the list above.
NOTE: For Auto-Learn to function properly, data must be sent using one of the predefined stream data formats 
(Section 13.7 on page 140). 
NOTE: Auto-Learn mode may be bypassed by using Manual Mode. For more information about Manual Mode see 
Section 5.3 on page 76.

Figure 5-3 provides a flow chart that displays each communication protocol Remote In parameter.

Figure 5-3. Remote In Parameters Menu Paths

Serial USB WiFiEthrnetWiFi

Setup SetpntAudit

CommCalibr Program

RS232 1 RS32 2 RS485 20MA

Mac ID DHCP Enabled Ip Addr

Gateway EthSrvr EthClnt

Enabled Trigger

Subnet

Trigger

Command StrInd StrLft RmtIn

Command StrInd StrLft RmtIn

Command StrInd StrLft RmtIn

EchoPort

Name

Trigger

Eoldly

IPAddre

LnTerm

Port

Respons

Trigger
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If Remote In parameter is enabled, LaserLight3 attempts to learn the incoming data steam when it is powered on, when the 
data stream starts or when the data stream is paused and restarted. In order for the Auto-Learn to function, the incoming data 
stream must be supported (Section 13.7 on page 140). 

 NOTE: Access to Setup mode parameters (see Section 2.8.2 on page 25) are required to access the Remote In parameter.

1. Enable Remote In parameter for the required communication protocol:
• For RS-232, RS-485/422 or 20 mA current loop, navigate to Audit ► Setup ▼Config ►... ►Comm ▼ Serial ▼ 

Communication protocol ▼ Trigger. 
• For Ethernet Client, navigate to Audit ► Setup ▼ Config ►... ► Comm ▼ Serial ► ... ► Ethernet ▼ Mac ID 

► ... ► EthClnt ▼ Echo▼...▼ Trigger.
• For Ethernet Server, navigate to Audit ► Setup ▼ Config ►... ► Comm ▼ Serial ► ... ► Ethernet ▼ Mac 

ID ► ... ► EthSrvr ▼ Port ▼... ▼ Trigger.
• For Wi-Fi, navigate to Audit ► Setup ▼Config ►... ►Comm ▼ Serial ► ... ► Wi-Fi ▼ Enabled ► Trigger. 

 NOTE: See Section 4.3.10 on page 64 for more details about communication parameters.

2. Press . The configured parameter displays.

3. Press  and  until RmtIn (Remote In) displays.

4. Press  to confirm the parameter configuration.

5. Press  to exit the menu.
6. One of the following occurs:

• Data displays
• NODATA display (no data is received)
• OvrRng (Over Range) error displays

NOTE: If NODATA appears, this represents that data is not received from the indicator and to verify connection from the 
indicator to LaserLight3.

 If OvrRng (over range) displays after the Auto-Learn process parses data, then the weighment value sent is beyond the 
capabilities of the display (six characters). Setting WgtBeg (Weight Begin) and WgtEnd (Weight End) parameters in Manual 
Mode frequently resolves character quantity issues (see Section 5.3.2 on page 77). 

NOTE: If LaserLight3 does not match a data format, it automatically attempts to parse the weight, units, mode, status and 
weight data out of frame. At a minimum weight, unit and mode data are required. If a valid weight cannot be found, Manual 
Mode (Section 5.3 on page 76) must be used to configure LaserLight3.

MENU
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5.3 Manual Mode
Manual Mode is used when the data stream (Section 13.7 on page 140) in not recognized by LaserLight3, or weight data can 
not be extracted during Auto-Learn mode. 

  NOTE: Always attempt Auto-Learn mode (Section 5.2.2 on page 74) before configuring the LaserLight3 in Manual Mode. 
Perform Manual Mode configuration in the following order:

• Set communication protocol trigger to Remote In (detailed in Auto-Learn configuration, Section 5.2.2 on page 74)
• Enable Manual Mode (Section 5.3.1)
• Configure Manual Mode parameters (Section 5.3.2 on page 77)
• (If needed) Configure Set Annunciator parameters (Section 5.3.2.4 on page 83)
• Validate Manual Mode configuration (Section 5.3.3 on page 85)

  NOTE: Configuring parameters for Manual Mode requires access to Setup mode (Section 2.8.2 on page 25).

5.3.1 Enable Manual Mode
Figure 5-4 displays a menu path to the MnlMode (Manual Mode) parameter.

Figure 5-4. MnlMode Parameter Menu Path

1. Navigate to Audit ► Setup ▼ Config ►... ►Remote ▼ Manual ▼ MnlMode.

2. Press . The parameter configuration displays.

3. Press  until On display.

4. Press . MnlMVal displays.

5. Press  to exit the menu.

MnlModeSetAnn

Setup SetpntAudit

Remote Comm

Manual HoldWtKeys

DfltCfg

OffOn

MnlMVal

MENU
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5.3.2 Configuring Manual Mode Parameters
After Manual Mode is enabled, many parameters must be configured. Manual Mode parameter configuration differs from most 
other parameters found on LaserLight3. Instead of selecting from a list of predefined values, most Manual Mode parameters 
are configured by:

• Selecting characters from a parsed data string (Section 5.3.2.1)
• Using a text string editor to edit a text string (Section 5.3.2.2 on page 79)

Figure 5-5 displays a menu path to the Manual Mode parameters.

Figure 5-5. Manual Mode Parameters

5.3.2.1 Character Selection Parameter Overview
During Manual Mode configuration, specific data string characters must be selected while setting the following parameters: 

  NOTE: For parameter definitions, see Section 4.3.9.1 on page 63.

Figure 5-6 displays a menu path to Manual Mode parameters that require cursor selection.

Figure 5-6. Manual Mode Cursor Selection Parameters Menu Paths

• WgtBeg (Weight Begin) •  ModeBeg (Mode Start) •  PolEnd (Polarity End)
• WgtEnd (Weight End) •  ModeEnd (Mode End) •  PolBeg (Polarity Start)
• UnitBeg (Unit Begin) •  StatBeg (Status Begin)
• UnitEnd (Unit End) •  StatEnd (Status End)

MnlMode MnlMVal WgtBegAnchrSqSetAnn

Setup SetpntAudit

Remote Comm

WgtEnd

UnitBeg UnitEnd ModeBeg StatBegModeEnd StatEnd

PolBeg

Manual HoldWtKeys

PolEnd UnitDef StatDefModeDef PolDefs

SetAnn

DfltCfg

Manual Mode Parameters

MnlMode MnlMVal WgtBegAnchrSqSetAnn

Setup SetpntAudit

Remote Comm

WgtEnd

UnitBeg UnitEnd ModeBeg StatBegModeEnd StatEnd

PolBeg

Manual HoldWtKeys

PolEnd UnitDef StatDefModeDef PolDefs

SetAnn

DfltCfg

Cursor Selection Parameters
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Figure 5-7 illustrates a data string example. LaserLight3 captures and displays one frame based on the AnchrSq (Anchor 
Sequence) parameter configuration. Data strings vary depending on the format of data transmitted by the indicator.

Figure 5-7. Cursor Selection Parameter Example

Data string elements are described in Table 5-1.

  NOTE: For a list of possible displayed characters, see Section 13.5 on page 137.

Configure cursor selection parameters by performing the following:
1. Navigate to Audit ► Setup ▼ Config ►... ►Remote ▼ Manual ▼ MnlMode ►... ► *required parameter.

*see Figure 5-6 on page 77

2. Press . LaserLight3 displays a text string with a cyan cursor. 

3. Move the cyan cursor with  or  to the character in data string that represents selected parameter.

4. Press  to confirm character selection.
5. LaserLight3 returns to Manual Mode menu with next parameter (if available) displays.

Item Element Description
1 The first character in this example is a positive polarity character. In some data strings a space or a positive symbol (+) 

may occur for positive polarity. The character could also appear as a negative (-) character if the scale or simulator causes 
a negative weight measurement

2 _ A cyan underline that acts a cursor and used to select characters for configuration

3 A symbol indicating a space
4 10197 The current weight measurement

NOTE: In this example the weight has 6 digits, but only 5 are shown. The leading blank character is the sixth digit. If the 
quantity of digits in a data string are unknown, a simulator or loading the scale to near capacity can populate all weight 
digits.

5 L The unit of measure. The units may appear abbreviated, in this case L is short for lb
NOTE: If there is only one character for the unit Lb (L) the same character is selected for both the UnitBeg (Unit 
Begin) and UnitEnd (Unit End) parameters.

6 G The configured weigh mode, Gross (G) or Net (N)
7 M The status of the scale (Center of Zero, Invalid, Motion, OK, Overload or Underload). The units may appear abbreviated, in 

this case M is short for Motion. Also, if there no status affecting the scale, the digit may be blank
NOTE: If there is no status affecting the scale, the digit for status may be blank. If the status character location is 
unknown, a simulator can be used to input a status and cause the character to populate on screen.

8 ♪ The symbol indicating a carriage return (CR)
9 The symbol indicating a line feed (LF)

10 NODATA
(Not Displayed)

Displays when set to a remote display and indicates that a data stream is not currently received by the LaserLight3. Ensure 
Indicator is transmitting a data stream to LaserLight3, LaserLight3 is set to RmtIn (Remote In), and wiring is correct/
undamaged.

Table 5-1.  Data String Elements Descriptions

10197LGM  

3 1 2 4 5 6 7 8 9
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5.3.2.2 Text String Parameter Configuration Overview
Text string parameters are configured by using a text string editor to change character value. The following parameters are 
configured with a text string editor:

  NOTE: For parameter definitions, see Section 4.3.9.1 on page 63.

Figure 5-6 displays a menu path to Manual Mode parameters that require text string configuration.

Figure 5-8. Manual Mode Text String Parameters Menu Paths

Figure 5-9 illustrates a text string parameter.

Figure 5-9. Text String Parameter Example

• AnchrSq (Anchor 
Sequence)

• ModeDef (Mode 
Definition)

• PolDefs (Polarity 
Definition)

• UnitDef (Unit Definition) • StatDef (Status Definition)

MnlMode MnlMVal WgtBegAnchrSqSetAnn

Setup SetpntAudit

Remote Comm

WgtEnd
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PolBeg

Manual HoldWtKeys

PolEnd UnitDef StatDefModeDef PolDefs

DfltCfg
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Invlid Motion Ovrload COZUdrload OK
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Table 5-2 describes text string elements are described in Figure 5-9.

Perform the following to configure text string parameters:
1. Navigate to Audit ► Setup ▼ Config ►...►Remote ▼ Manual ▼ MnlMode ► ... ► *required parameter.

*see Figure 5-8 on page 79

2. Press . The first parameter option displays. 

3. Press . The configuration for the parameter option appears.

4. Press  and  to select a position/character.

5. (Optional) Press  to insert a space/empty character.

6.  Press . The selected character enters an edit mode and an underscore (_) appears under the character.

7. Press  and  to change the character.

8. Press  to confirm the character change and exit character edit mode.
9. Repeat steps 2 through 8 until all characters parameters are configured. 

10. Press  to save and exit menu.
11. Repeat steps 1 through 10 until all parameters are configured. 

12. Press  to save and exit menu.

  NOTE:  Press  twice to a delete character.

Element Description
General Screen Elements See Section 3.4 on page 33 for more information.
G A single character text string. In this example only one character comprises the text string. 
Underscore (_) Appears under a character when string editor is active. 

Table 5-2.  Data String Elements Descriptions
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5.3.2.3 MnlMode (Manual Mode) Parameter Configuration
Cursor selection and text string parameters are contained in Manual Mode configuration. This section provides a general guide 
of how to configure Manual Mode parameters. For information about hows to configure each parameter and menu paths, see 
Section 5.3.2.1 on page 77 and Section 5.3.2.2 on page 79.

1. Navigate to Audit ► Setup ▼Config ►... ►Remote ▼ Manual ▼ MnlMode ► MnlMVal ► AnchrSq.

2. Press . The AnchrSq (Anchor Sequence) parameter configuration displays. 
3. Configure AnchrSq parameter.

NOTE: The AnchrSq is a text string parameter that defines the repeating anchor point in a text string. This point can be any 
repeating characters at front or end of the text string. The repeating character must reoccur in the same position across all 
received data strings. In addition, there are additional constraints that must be adhered to when configuring this parameter: 

• Non-printable characters must be entered in hex code and placed inside “< >” brackets (see Section 13.5 on page 137). 
The exceptions are carriage return <CR> and line feed <LF>.

• Several data strings end with termination type characters: <CR>, <LF>, <CR><LF>, <02> (STX) or <03> (ETX)

Figure 5-10. AnchrSq Parameter Configuration Example

4. Configure cursor selection parameters (Section 5.3.2.1 on page 77):
4.1    Set WgtBeg as the start of the weight and WgtEnd as the end of the weight.

Figure 5-11. WgtBeg and WgtEnd Configuration

NOTE: In this example the weight has 6 digits, but only 5 are shown. The leading blank character is the sixth 
digit. If the quantity of digits in a data string are unknown, a simulator or loading the scale to near capacity can 
populate all weight digits.

4.2    Set UnitBeg as the start of the unit and UnitEnd as the end of the unit.

Figure 5-12. UnitBeg and Unitnd Configuration

NOTE: In this example there is only one character for the unit, Lb (L), therefore the same character is selected 
for both the UnitBeg and UnitEnd parameters.

4.3    Set MdeStr as the start of the mode and MdeEnd as the end of the mode.

Figure 5-13. MdeStr and MdeEnd Configuration

NOTE: In this example there is only one character for the Mode (M), Gross (G), therefore the same character is 
selected for both the ModeBeg and ModeEnd parameters.

4.4    Set StatBeg as the start of the status and StatEnd as the end of the status.

Figure 5-14. Status Configuration

NOTE: If there is no status displayed, the character for status may be blank. If the status character location is 
unknown, a simulator can be used to input a status and cause the character to populate. 

<CR>

10197LGM  10197LGM  

10197LGM  

10197LGM  

10197LG  10197LGM  
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4.5    Set PolBeg as the start of the polarity and PolEnd as the end of the polarity.

Figure 5-15. Polarity Configuration
NOTE: The character for positive polarity may be a blank character as some data streams do not define positive polarity 
with a positive (+) symbol. If polarity character location is unknown, a simulator can be used to apply a negative weight 
value to the scale and populate the negative (-) character onscreen. 
In this example there is only one character for Polarity, therefore the same character is selected for both the PolBeg and 
PolEnd parameters. 

5. Configure UnitDef (Unit Definition), ModeDef (Mode Definition), StatDef (Status Definition), PolDefs (Polarity 
Definition) sub-parameters as described in Section 5.3.2.2 on page 79.

NOTE: By default each UnitDef, ModeDef, StatDef, and PolDefs parameter are configured with one character in their 
parameters. Each parameter must contain the same quantity of characters. If more characters are required, ensure the 
same quantity is used across the parameter group. If required, use leading spaces to increase character quantity (for 
example, _G).

5.1    Set UnitDef sub-parameters lb, kg, Tons, ShortTn, ounces, grams.

Figure 5-16. Configured UnitDef Parameters

5.2    Set ModeDef parameters Gross and Net.

Figure 5-17. Configured ModeDef Parameters

5.3    Set StatDefs parameters Invlid (Invalid), Motion, OvrLoad (Over Load), UdrLoad (Under Load), COZ (Center of 
Zero) and OK.

Figure 5-18. Configured StatDefs Parameters

5.4    Configure PolDefs parameters Positiv (Positive) and Negativ (Negative)

Figure 5-19. Configured PolDefs Parameters

10197LGM  10197LGM  -

L K T t O G

lb Configuration kg Configuration Tons 
Configuration

ShortTn 
Configuration

Ounces 
Configuration

Grams Configuration

K

Net ConfigurationGross 
Configuration

N

I M O U Z _

Invlid 
Configuration

Motion 
Configuration

OvrLoad 
Configuration

UdrLoad 
Configuration

COZ 
Configuration

OK Configuration

-

Negativ 
Configuration

Positiv
Configuration
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5.3.2.4 SetAnn (Set Annunciator) UnitAnn and ModeAnn Options
SettAnn UnitAnn and Mode options lock a selected mode (Gross or Net) or unit annunciators in place on screen.
Figure 5-20 displays a menu path to SetAnn parameters.

Figure 5-20. SetAnn UnitAnn and Mode Option Menu Path

1. Navigate to Audit ► Setup ▼ Config ►... ►Remote ▼ Manual ▼ MnlMode ► ... ► SetAnn.

2. Press . Disable displays.

3. Press . UnitAnn (Unit Annunciator) displays.

4. Press . Off displays.

5. Press  or  to select Primary or Secondary.

  NOTE: Primary and Secondary parameters are configured in the Format menu (Section 4.3.2 on page 48).

6. Press . ModeAnn (Mode Annunciator) displays.

7. Press . Off displays.

8. Press  or  to select Gross or Net.

9. Press . UnitAnn displays.

10. Press  to exit the menu.

MnlMode MnlMVal WgtBegAnchrSqSetAnn

Setup SetpntAudit

Remote Comm

WgtEnd

UnitBeg UnitEnd ModeBeg StatBegModeEnd StatEnd

PolBeg

Manual HoldWtKeys

PolEnd UnitDef StatDefModeDef PolDefs

SetAnn

DfltCfg

Disable UnitAnn ModeAnn

Off Primary Secndry

Off Gross Net

MENU
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5.3.2.5 SetAnn (Set Annunciator) Disable Option
SettAnn Disable option disables specific annunciators (Unit, Mode, Status or Polarity).
Figure 5-20 displays a menu path to SetAnn Disable option.

Figure 5-21. SetAnn Disable Option Menu Path

1. Navigate to Audit ► Setup ▼ Config ►... ►Remote ▼ Manual ▼ MnlMode ► ... ► SetAnn.

2. Press . Disable displays.

3. Press . Unit displays. 

4. Press . Yes displays.

5. Press  or  to select Yes or No.

6. Press . Mode displays.
7. If needed, repeat steps 4 through 6 for remaining options.

8. Press  to exit the menu.
NOTE: Unit, Mode and Status options apply to Automatic Configuration and Manual Mode. Polrity only applies to Manual 
Mode. 

MnlMode MnlMVal WgtBegAnchrSqSetAnn

Setup SetpntAudit

Remote Comm

WgtEnd

UnitBeg UnitEnd ModeBeg StatBegModeEnd StatEnd

PolBeg

Manual HoldWtKeys

PolEnd UnitDef StatDefModeDef PolDefs

SetAnn

DfltCfg

Unit Mode Status Polrity

Yes No

Disable UnitAnn ModeAnn

MENU
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5.3.3  MnlMVal (Manual Mode Validation) Operation
After Manual Mode is configured, the built-in validation tool should be used to ensure the configuration is correct. 
Figure 5-22 displays a menu path to the MnlMVal (Manual Mode Validation) parameter.

Figure 5-22. Manual Mode Validation Parameter Menu Path

NOTE: The Validation tool shows one error at time or none at all. Be prepared to run the Validation tool several 
times until the all Manual Mode parameters are validated.

1. Navigate to Audit ► Setup ▼ Config ►... ►Remote ▼ Manual ▼ MnlMode ► MnlMVal.

2. Press . One of the following occurs:
• OK displays, indicating errors were not detected in configuration
• A parameter error displays

3. If an error is received, press  or  to scroll through the error message. 
4. Review the displayed parameter’s configuration, make changes and then rerun MnlMVal. 
5. Repeat the procedure until errors are not received.

6. Press  to exit the menu.

MnlMode MnlMValSetAnn

Setup SetpntAudit

Remote Comm

Manual HoldWtKeys

DfltCfg

MENU
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5.4 Demand Print String Displaying
The indicator and LaserLight3 remote display can be configured tor display a demand print string. Demand print display is set 
up using Auto-Learn when the HoldWt (Hold Weight) parameter is turned on (see Section 4.3.9 on page 62). It can also be set 
up manually by configuring the parameters of the remote display and indicator. Using Auto-Learn, ensure HoldWt is on and 
continuously push the print button on the indicator to acquire a demand print display.

5.5 Serial Commands
The LaserLight3 has the ability to receive commands, display messages, or use digital I/O. Commonly used serial command 
scenarios, include:

• When interfaced to an indicator which has a configurable serial string, the print ticket format can be configured, allowing 
the user to press Print on the indicator and send a message which temporarily interrupts the streamed weight display. 
The length of time the message displays is defined by the MSG TM (Message Time) parameter in the Config menu 
(Section 4.3.9 on page 62).

• If the LaserLight3 remote display is interfaced with a programmable smart indicator, a user program can be written 
allowing the user to send messages. The user can send one message to temporarily override the streamed weight 
display.

• The remote display accepts serial commands to return the current time and date or to set the time and date to a new 
setting. This information can be used in conjunction with user programs in the indicator and remote display to ensure 
both have the same time and date settings.

5.5.1 Remote Display Command Format:
The following is an example of serial command format or message formatting commands:
|<AA><CC>|<Data>!

Where:
| = Pipe character (Ox7C)
AA = Two byte address, ASCII digits (0-31)
CC = Two byte command, ASCII characters
| = Pipe character (Ox7C)
Data = Data depending on command
! = Exclamation point character (0 x21)

NOTE: Commands, GT, ST, DI, DO, GV, and the feedback results are not displayed on remote display. Display message 
commands must not be sent faster than once every second.

Command Description Example
DM Display message <Data> is a six character message |00DM|HELLO !

Alternative command |00DM HELLO !
GT Get time and date; Information gathered is sent back to the indicator; Ensure both remote 

display and indicator match
|00GT!

ST Set time and date
NOTE: Two spaces are required between time and date entries. Time must be 
entered in a 24-hour format.

|00ST08:00:00  2003-01-31!
|00ST15:00:00  2003-01-31!
To obtain a P.M. time of 3:00P.M.

DI Read digital input levels and returns a hex representation of 0 - F (0 - 15) of all active
digital inputs bits. Digital Input bits follow:

• Digital input bit 1 = 1
• Digital input bit 2 = 2
• Digital input bit 3 = 4
• Digital input bit 4 = 8

NOTE: The returned value must be converted from hex to decimal. For example, all 
bits turned on would be a hex value of F (15 in decimal).

|00DI!

Table 5-3.  Remote Display Commands

https://www.ricelake.com


Remote Display Configuration

© Rice Lake Weighing Systems ● All Rights Reserved 87

DO Set digital output levels with digital output bits. Digital output bits follow:
• Digital output bit 1 = 1
• Digital output bit 2 = 2
• Digital output bit 3 = 4
• Digital output bit 4 = 8

NOTE: The value must be cumulative and converted to hex. For example, to turn on 
all bits the command "DOF" would be sent.

|00DOx!
Where x references the hex value 0–F

DO (with 
Legacy Display 
Mode Enabled)

Sets Legacy Mode traffic symbol:

NOTE: The Display Type must set as Legacy in order to display traffic symbols in 
this orientation (see Section 5.1 on page 72.)
NOTE: Even while Legacy mode is enabled, the DO command still controls the Digi-
tal output bits if they are set to output (see Section 4.3.8 on page 61).
NOTE: Using external switches (see Section 5.6 on page 90) and serial commands to 
control traffic lights may results in unpredictable displays.

00DOx!
Where x references numbers 0–3

GV Get the version number |00GV!
Time and date are sent from remote display in the current time format of remote display;
Time and date are sent to remote display in ISO format;
      USA Format:   HH:MM:SS  AM/PM   MMM/DD/YYYY
       ISO Format:   HH:MM:SS   YYYY-MM-DD

Command Description Example

Table 5-3.  Remote Display Commands (Continued)

Serial Command
Traffic 
Symbol  Traffic Symbol Example

|00DO3! Stop

|00DO2! Green Circle

|00DO1! Green Arrow

|00DO0! Off -

00
lbGR

00
lbGR

00
lbGR
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5.5.2 Advanced Display Message (DM) Commands
In addition to the DM command listed in Table 5-3 on page 86, there are additional DM commands with expanded capabilities 
available (Table 5-4).

NOTE: The total character quantity allowed in messages is limited depending on the selected command. Adding multiple-
digit timeouts or scrolls limits it even further. For example: 

• DM1 - 99 available characters. 95 characters if both the timeout and scroll count are 3-digits long
• DM1 (with mode and units) - 96 available characters. 92 characters if both the timeout and scroll count are 3-digits 

long
• DM2 - 93 available characters. 89 characters if both the timeout and scroll count are 3-digits long
• DMT- 95 available characters. 91 characters if both the timeout and scroll count are 3-digits long 
• DM4/DMQ - 81 available characters. 77 characters if both the timeout and scroll count are 3-digits long

For example, in DM2 listed above one line could have 92 characters while a second line could have 1 (without timeout or 
scroll count)

Display Message Description
DMC A remote display function where an EDP command is performed on the LaserLight3 and the result is returned to the host 

through the configured RemoteIn port (Section 5.2.2 on page 74):
|00DMC|xxxxxx! 

Where xxxxxx is a standard EDP command (see Section 9.0 on page 100). For example, to view the LaserLight3 firmware ver-
sion on the host, send “|00DMC|VERSION!”.

DM1 One Line Message:
|<AA><DM1>|<Timeout>|<Flash1>|<Slide1>|<Scroll1>|<Scroll Count>|<FC1><BC1>|<Data>!

DM1 One Line Message with Annunciators:
|<AA><DM1>|<Timeout>|<Flash1>|<Slide1>|<Scroll1>|<Scroll Count>|<FC1><BC1>|Mode|Units|<Data>!

DMT One Line Message for Traffic Symbols:
|<AA><DMT>|<Timeout>|<Flash1>|<Slide1>|<Scroll1>|<Scroll Count>|<FC1><BC1>|Mode|Units|<Traffic symbol>|<Data>!

DM2 Two Line Message:
|<AA><DM2>|<Timeout>|<Flash1><Flash2>|<Slide1><Slide2>|<Scroll1><Scroll2>|<Scroll 
Count>|<FC1><BC1><FC2><BC2>|<Data1>|<Data2>!

DM4 Four Line Message:
|<AA><DM4>|<Timeout>|<Flash1><Flash2><Flash3><Flash4>|<Slide1><Slide2><Slide3><Slide4>|<Scroll1><Scroll2>
<Scroll3><Scroll4>|<Scroll Count>|<FC1><BC1><FC2><BC2><FC3><BC3><FC4><BC4>|<Data1>| <Data2>|<Data3>
 |<Data4>!
NOTE: Multi-line messages start with Data1 at the top.

DMM Sets the display to immediately show a mirror image:
|00DMM!

DMN Sets the display to immediately show a normal image:
|00DMN!

DMQ 4 Quadrant Message:
|<AA><DMQ>|<Timeout>|<Flash1><Flash2><Flash3><Flash4>|<Slide1><Slide2><Slide3><Slide4>|<Scroll1><Scroll2>
<Scroll3><Scroll4>|<Scroll Count>|<FC1><BC1><FC2><B2><FC3><BC3><FC4><BC4>|<Data1>|<Data2>|<Data3>
 |<Data4>!
NOTE: Quadrant Locations follow:

DMX Clears the current message and returns to the original display:
|<AA><DMX!>|

Table 5-4.  Advanced Display Message Commands

Data1 Data2
Data3 Data4
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Advanced Display Message Options listed Table 5-4 are described in Table 5-5.

Option Description
| Pipe characters separate parameters or data in command
! Exclamation points indicate the end of a command

<AA> NOTE: This is the same as the address configured in the remote menu (see Table 4.3.9 on page 62).
Address{00 – 99} This will always be 2 characters, for example: Address “1” will need to be “01” 

<DMn> Defines which display message command is used:
Command{DM1, DM2, DM4, DMQ, DMT}

<Timeout> 0 - 65535 milliseconds seconds; Use “0” to continue infinitely until interrupted by another message. If Scroll Count and Timeout are 
both used, timeout overrides.

<Scroll(n)> Configured with Y or N. Text cycles from right to left continuously for the duration defined by Timeout or Scroll Count. n = line number
<Slide(n)> Configured with Y or N. Text moves from right side of display and stops at the left side of the display. n = line number
<Flash(n)> Configured with Y or N. Message flashes continuously for the defined timeout. n = line number. 

<Scroll Count> 0 – 999; defines the number of times the message scrolls across the display. Use “0” to scroll infinitely until interrupted by another 
message. If Scroll Count and Timeout are both used, Timeout overrides.

<FC(n)> Defines foreground color, where:

<BC(n)> Defines background color, where:

<Mode> Defines modes displayed in a message. Only G or N are accepted
<Units> Defines units displayed in message. lb, kg, t, tn, oz or gr accepted

<Traffic Symbol> Defines traffic symbols displayed in message. Character 0 – 7; where:

<Data(n)> User configurable message with a variable character quantity depending on commands. (n) = line number
NOTE: This parameter must be adhere to the total character limit described for commands listed in Table 5-5.

Table 5-5.  Advanced Display Message Options

Space = Black B = Blue
R = Red M = Magenta
Y = Yellow C = Cyan
G = Green W = White

Space = Black B = Blue
R = Red M = Magenta
Y = Yellow C = Cyan
G = Green W = White

0 = Red Stop Light 4 = Arrow Right
1 = Green Go light 5 = Arrow Down
2 = Red X 6 = Arrow Left
3 = Arrow Up 7 = No Icon
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5.6 Control Traffic Lights with External Switches (Digital Inputs)
Traffic lights may be controlled with switches connected to digital inputs. This sections describes wiring connections needed to 
connect external switches to the LaserLight3.

IMPORTANT: Legacy mode (Section 5.1 on page 72) must be enabled in order for traffic lights to function with external 
switches. 
NOTE: Only Ground, DIO1 and DIO2 are used to connect to switches. Using external switches and serial commands to 
control traffic lights may results in unpredictable displays.

5.6.1 Single Switch Wiring
A single switch may be wired as either stop and green arrow lighting or stop and go lighting. Wire switch as indicated in 
Figure 5-23.

Figure 5-23. Single Switch DIO Wiring

See Table 5-6 for single switch operations details.  

Stop and Green Arrow Switch Interactions Stop and Go Switch Interactions

SW1 DIO1 (P3) Symbol SW1 DIO2 (P4) Symbol
Open 5V (H) Open 5V (H)

Closed 0V (L) Closed 0V (L)

Table 5-6.  Single Switch Traffic Light Interaction

SW1 SW1

Stop and GoStop and Green Arrow

00
lbGR

00
lbGR

00
lbGR

00
lbGR
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5.6.2 Two Switch Wiring
It is possible to obtain a variety of combinations of the four possible states using two switches to control the traffic symbols:
• Both switches with contacts open cause the stop condition
• Both switches with contacts closed cause the off condition
• One switch open and the other closed causes either the go or arrow condition
Wire switch as indicated in Figure 5-24.

Figure 5-24. Two Switch DIO Wiring

See Table 5-7 for two switch operations details.

SW1 SW2 DIO1 (P3) DIO2 (P4) Symbol
Open Open 5V (H) 5V (H)

Closed Open 0V (L) 5V (H)

Open Closed 5V (H) 0V (L)

Closed Closed 0V (L) 0V (L) No Symbol

Table 5-7.  Two Switch Traffic Light Interaction

SW1

SW2

00
lbGR

00
lbGR

00
lbGR
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6.0 Calibration
The LaserLight3 can be calibrated using the front panel and EDP commands. The following sections describe the procedures 
required for these calibration methods.

NOTE: The LaserLight3 requires a Zero Calibration and Span Calibration to be calibrated. The Linear Calibration points are 
optional; they must fall between zero and span, but must not duplicate zero or span.

Figure 6-1. Setup – Calibration Menu

6.1 Front Panel Calibration
6.1.1 Span Calibration
Use the following procedure to perform a standard span calibration on a connected scale. Access to Setup mode (Section 2.8.2 
on page 25) is required.

1. Navigate to Audit ► Setup ▼ Config ► ... ► Calibr.

2. Press . WZero (zero calibration) displays.

  NOTE: See Section 6.2 on page 93 if the application requires a rezero, last zero or temporary zero.

3. Ensure there is no weight on the scale.

4. Press  to perform a zero calibration. OK displays.

5. Press . ZeroCnt (zero counts) displays. See Section 4.3.3 on page 49 for more information on zero counts.

6. Press . WVal (test weight value) displays.

7. Press . The current test weight value displays.

8. Use the arrow keys to enter a new value, if necessary.

9. Press  to accept value. WSpan (span calibration) displays.

10. Place the specified amount of test weight on the scale.

11. Press  to perform a span calibration. Please Wait displays briefly and then calibration completes.

12. Press . SpnCnt (span counts) displays. See Section 4.3.3 on page 49 for more information on span counts.
NOTE: Span calibration is complete. To continue with a linear calibration, see Section 6.1.2 on page 93 before returning to 
Weigh mode.

13. Press  to exit the menu.

Point 3Point 4 Point 2Point 1

WLin LstZero

Point 4

TmpZero

WZero ZeroCnt WSpanWVal SpnCntTemp Zero

Setup SetpntAudit

CalibrFormat Program

Rezero

MENU
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6.1.2 Linear Calibration
Linear calibration points provide increased scale accuracy by calibrating the indicator at up to four additional points between the 
zero and span calibrations. Access to Setup mode (Section 2.8.2 on page 25) is required.

1. Complete Steps 1–12 in Section 6.1.1 on page 92. Press . WLIN (linear calibration) displays.

2. Press . Point 1 displays.

3. Press . WLin V1 displays.

4. Press . The current test weight value for point 1 displays.

5. Use the arrow keys to enter a new value, if necessary.

6. Press  to accept value. WLin C1 displays.

7. Place the specified amount of test weight on the scale.

8. Press  to perform a linear point calibration. Please Wait displays briefly and then calibration completes.

9. Press . WLin F1 displays. See Section 4.3.3 on page 49 for more information on linear point counts.

10. Press . Point 1 displays.

11. Press . Point 2 displays.

12. Repeat previous steps for points 2-4, if necessary.

  NOTE: The linear calibration for a point is saved once point is calibrated.

13. Press  to exit the menu.

6.2 Alternative Zero Calibrations
During a calibration, the zero value can be replaced with a temporary zero or last zero. 
A rezero can be done after calibration. See below for information on alternative zeros.

6.2.1 Last Zero
This takes the last push-button zero in the system (from Weigh mode) and uses it as the new zero reference point, after which 
a new span calibration must be performed. This calibration cannot be performed when calibrating a scale for the first time. 
A last zero calibration is typically used on truck scales to allow a scale verification to become a calibration without having to 
remove the test weights.

6.2.2 Temporary Zero
A temporary zero calibration temporarily zeros the displayed weight of a non-empty scale. After span calibration, the difference 
between the temporary zero and the previously calibrated zero value is used as an offset. 
A temporary zero calibration is typically used on hopper scales to calibrate the span without losing the original zero calibration.

6.2.3 Rezero
A rezero calibration is needed to remove a calibration offset when hooks or chains are required to suspend the test weights.
Once a span calibration is complete, remove the hooks or chains and the test weights from the scale. With all the weight 
removed, a rezero calibration is used to adjust the zero and span calibration values.

MENU
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6.3 EDP Command Calibration
Use the following instructions to calibrate the LaserLight3 using EDP commands. For information on the EDP commands of the 
LaserLight3, see Section 9.0 on page 100. Access to Setup mode (Section 2.8.2 on page 25) is required.

NOTE:  OK must display after each step or the calibration procedure must be done again. For commands ending with #s, s 
is the scale number (1).

1. Put the LaserLight3 in Setup mode.
2. For a standard calibration, remove all weight from scale (except hooks or chains which are needed to attach weights).
3. Send the command SC.WZERO#s to perform a standard calibration of the zero point.

• Send SC.TEMPZERO#s to perform a temporary zero calibration
• Send SC.LASTZERO#s to perform a last zero calibration

4. Apply the span calibration weight to the scale.
5. Send the command SC.WVAL#s=xxxxx, where xxxxx is the value of the span calibration weight applied to the scale.
6. Send the command SC.WSPAN#s to calibrate the span point. Continue on to Step 6 to calibrate additional linear 

points, or proceed to Step 10.
7. Apply weight equal to the first linear point to the scale. 
8. Send the command SC.WLIN.Vn#s=xxxxx, where n is the linear point number (1-4) and xxxxx is the exact value of 

the weight applied.
9. Send the command SC.WLIN.Cn#s to calibrate the linear point, where n is the linear point number (1-4).
10. Repeat Steps 6–8 for up to four total linear points.
11. If hooks or chains were used to attach the weights, remove all weight, including the hooks and chains, and send the 

command SC.REZERO#s to remove the zero offset.
12. Send the command KSAVEEXIT to return to Weigh mode.
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7.0 Digital Filtering
Digital filtering is used to create a stable scale reading in challenging environments. The LaserLight3 allows selection of Digital 
Rolling Average Filtering (Section 7.1), Adaptive Filtering (Section 7.2 on page 97), Damping (Section 7.3 on page 97) or 
Raw for no filtering. See Section 4.3.1 on page 46 for configuration menu layout and the location of the Filter Chain Type 
parameter.
The scale’s sample rate effects all types of filtering. The A/D sample rate is selected by the Sample Rate parameter. The A/D 
sample rate is the number of weight readings the indicator takes per second. This can be 6.25, 7.5, 12.5, 15, 25, 30, 50, 60 or 
120 hertz (readings per second). Set the A/D sample rate to the lowest setting required for the application. Lower settings result 
in better stability.

 NOTE: See Section 4.3.1 on page 46 for more details about Configuration parameters.

7.1 Digital Rolling Average Filter (Average Only)
The digital rolling average filter uses mathematical averaging with three stages. These configurable stages control the effect of 
a single A/D reading on the displayed weight. When an A/D reading outside of a predetermined band is encountered, the digital 
rolling average filter is overridden and the display jumps directly to the new value.

7.1.1 Digital Filter Stages 1-3
The filter stages can each be set to a value of 1–256. The value assigned to each stage sets the number of readings received 
from the preceding filter stage before averaging. Setting the filter stages to 1 effectively disables the rolling filter.
A rolling average is passed to successive filtering stages for an overall filtering effect which is effectively a weighted average of 
the product of the values assigned to the filter stages (Digital Filter Stage 1 x Digital Filter Stage 2 x Digital Filter Stage 3) within 
a time frame corresponding to the sum of the values (Digital Filter Stage 1 + Digital Filter Stage 2 + Digital Filter Stage 3). 

7.1.2 Digital Filter Sensitivity and Digital Filter Threshold
The rolling averaging filter can be used by itself to eliminate vibration effects, but heavy filtering also increases settling time. 
The Digital Filter Sensitivity (DFSENS) and Digital Filter (DFTHRH) Threshold parameters can be used to temporarily override 
filter averaging and improve settling time.

• Digital Filter Sensitivity specifies the number of consecutive A/D readings which must fall outside the Digital Filter 
Threshold before filtering is suspended

• Digital Filter Threshold sets a threshold value, in display divisions; When the specified number of consecutive A/D 
readings (Digital Filter Sensitivity) fall outside of this threshold, filtering is suspended; Set Digital Filter Threshold to 
NONE to turn off the filter override
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7.1.3 Digital Rolling Average Filter Procedure

Figure 7-1. Configuration Menu
1. Navigate to Audit ► Setup ▼ Config ▼ Capacity ► ... ►FltrChn.

2. Press . Currently configured parameter displays.

3. Press  and  until AvgOnly (Average Only) displays.

4. Press . The DigFl1 (Digital Filter 1) displays.

5. Press . The currently configured parameter displays.

6. Press  repeatedly until 1 displays.

7. Press . The next digital filter displays.
8. Repeat Step 5 and Step 7 for DigFl2 and DigFl3.
9. Press  repeatedly until DfThrh (Digital Filter Sensitivity) appears.

10. Press . The currently configured parameter displays.

11. Press  repeatedly until None displays.

12. Press . AdSens displays.

13. Press  to exit the menu and return to Weigh mode.
14. Remove all weight from scale, then watch the indicator to determine the magnitude of vibration effects on the scale.
15. Record weight below which all but a few readings fall. This value is used to calculate the Digital Filter Threshold 

parameter in Step 17.
Example – if a heavy-capacity scale (10,000 x 5 lb) produces vibration-related readings of up to 50 lb, with occasional 
spikes up to 75 lb, record 50 as the threshold weight value.

16. Repeat Step 4 through Step 8 to set the filter stage parameters (Digital Filter Stage 1-3) at lowest effect level that 
eliminates the vibration effects on the scale (leave Digital Filter Threshold set to NONE).

NOTE: If needed, the digital filter cutout sensitivity (DFSENS) and the digital filter cutout threshold (DFTHRH) can be used 
to reset the digital rolling average filter so the response to a rate change is faster.

17. Calculate the Digital Filter Threshold parameter value by converting the weight value recorded in Step 15 to display 
divisions (Threshold_Weight_Value / Display_Divisions).
In the example in Step 15, with a threshold value of 50, and a display-division value of 5, set the Digital Filter 
Threshold parameter to 10 display divisions.

18. Set the Digital Filter Sensitivity parameter high enough to ignore transient peaks. Longer transients (typically caused 
by lower vibration frequencies) cause more consecutive out-of-band readings; set the Digital Filter Sensitivity 
(DFSENS) parameter higher to counter low frequency transients.
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Overloa
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DigFl3SmpRat Fltrchn

Capcity

DigFl2DigFl1

ZTrkBn InitZroZRange MotBndSense

Setup SetpntAudit

Config FormatComm

Sense

MENU

https://www.ricelake.com


Digital Filtering

© Rice Lake Weighing Systems ● All Rights Reserved 97

7.2 Adaptive Filter (Adaptive Only)
The adaptive filter has two settings, Adaptive Filter Sensitivity and Adaptive Filter Threshold. It maintains a running average of 
the A/D readings when the weight change remains less than the defined threshold value. The filter automatically applies less 
value to each successive A/D reading the longer the weight change is less than the threshold value. The amount of value given 
to the most recent A/D reading is determined by the sensitivity setting.

7.2.1 Adaptive Filter Sensitivity
Adaptive Filter Sensitivity can be set to Heavy, Medium or Light. A Heavy setting results in an output which is more stable to 
weight changes than the Light setting. A Heavy setting also results in small changes in weight data (a few grads) on the scale 
base to not be seen as quickly as with the Light setting.
If the difference in typical subsequent weight values on the scale are only a few display divisions, use a Light setting. On a truck 
scale where the changes in subsequent weight values are 100s of display divisions, a Heavy setting is more appropriate.

7.2.2 Adaptive Filter Threshold
Set the Adaptive Filtering Threshold for the amount of observed instability in the system. This parameter can be set in the range 
of 0–2000 and is entered as a weight value. When a new sampled weight value is acquired, the adaptive filter compares the 
new value to the previous (filtered) output value. 
If the difference between the new value and the previous output value is greater than the Adaptive Filtering Threshold 
parameter the adaptive filter is reset to the new weight value. 
If the difference between the new value and the previous output value is less than the Adaptive Filtering Threshold parameter, 
the two values are averaged together using a weighted average. The weighted average is based on the amount of time the 
system has been stable, and selected Adaptive Filter Sensitivity sensitivity.
With the Adaptive Filtering Threshold set at zero, determine the amount of instability present. Enter this amount of weight 
instability to set the threshold of the adaptive filter. The adaptive filter is set to OFF, the Adaptive Filtering Threshold parameter 
is set to zero.

7.3 Damping Filter (Damping Only)
The damping filter is a simple filter which adjusts the amount of time it takes for a change in weight to be processed through the 
scale. The Damping Value parameter is a time interval specified in tenths of a second (10 = 1 second). This Damping Value is 
used to determine the amount of time it takes for the scale to reach its final weight output. When Damping Value is set to ten, a 
transition from 0 lb to 500 lb on the scale takes one second. The closer the weight gets to its final amount, the slower the weight 
changes on the display.

Figure 7-2. 500 lb Displayed Weight Progression
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8.0 Revolution
The Revolution utility provides a suite of functions used to support configuration, calibration, customization and backup of the 
LaserLight3 software. Calibration values and scale configuration can both be saved and restored to the LaserLight3 using 
Revolution.

NOTE: For system requirements and software download visit the Revolution product page on: 
https://www.ricelake.com/products/revolution-scale-software/.

8.1 Connecting to LaserLight3
Connect the PC serial port to a LaserLight3 comm port, then click Connect in the toolbar. Revolution attempts to establish 
communications to the LaserLight3. If communication settings need to be adjusted, select Options… from the Tools menu in 
Revolution.
Downloading to the LaserLight3
The Send Configuration to Device function in the Revolution Communications menu allows a Revolution configuration file 
(with or without scale calibration data) or ticket formats to be sent/downloaded to a connected LaserLight3 in Setup mode.
The Send Section to Device function in the Communications menu allows the download of only the currently displayed object, 
such as a scale configuration.
Because less data is transferred using the Send Section to Device, it is typically faster than a full configuration download, but 
there is an increased possibility the download fails due to dependencies on other objects. If the download fails, try performing a 
complete download using the Send Configuration to Device function.
Uploading Configuration to Revolution
The Get Configuration from Device function in the Revolution Communications menu allows the existing configuration of a 
connected LaserLight3 to be saved to a file on the PC. Once saved, the configuration file provides a backup which can be 
quickly restored to the LaserLight3 if needed. Alternatively, the file can be edited within Revolution and sent back to the 
LaserLight3.

8.2 Saving and Transferring Data
  NOTE: Revolution has a module to save and transfer data. It is the preferred method over using ProComm or similar.

8.2.1 Saving LaserLight3 Data to a PC
Configuration data can be saved to a computer connected to the selected port. The PC must be running a communications 
program such as PROCOMMPLUS®. 
When configuring the LaserLight3, ensure the values set for the baud and bits parameters on the serial menu match the baud 
rate, bits and parity settings configured for the serial port on the PC.
To save all configuration data, first put the communications program into data capture mode, then place the LaserLight3 in 
Setup mode and send the DUMPALL command to the LaserLight3. The LaserLight3 responds by sending all configuration 
parameters to the PC as ASCII-formatted text. 

8.2.2 Downloading Configuration Data from PC to LaserLight3
Configuration data saved on a PC or disc can be downloaded from the PC to an LaserLight3. This procedure is useful when a 
number of LaserLight3s with similar configurations are set up or when an LaserLight3 is replaced.
To download configuration data, connect the PC to the selected port as described in Section 8.2.1. Place LaserLight3 in Setup 
mode and use the PC communications software to send the saved configuration data to the LaserLight3. When transfer is 
complete, calibrate the LaserLight3 as described in Section 6.0 on page 92.

https://www.ricelake.com
https://www.ricelake.com/products/revolution-scale-software/
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8.3 Updating Firmware
Revolution is used to update the firmware of the LaserLight3. 

  NOTE: Updating the firmware defaults the configuration settings.

To initiate a firmware update:
1. Check current LaserLight3 firmware version (Section 3.5.5 on page 36).
2. Navigate to https://www.ricelake.com/firmware and determine if newer firmware exists.

• If no new firmware version exists, end procedure
• If newer firmware version exists, continue procedure

3. Download latest LaserLight3 firmware.
4. Connect computer running Revolution to the CPU board’s Micro USB port (J7) with a micro USB cable (up to 10 feet 

long).
5. In Revolution, open the LaserLight3 module. The LaserLight3 Information page displays.
6. Select Update Firmware and follow steps on-screen.

Table 8-1.  CPU Board SW1 Switch and Micro USB Port

Micro USB 
Port (J7)

https://www.ricelake.com/firmware
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9.0 EDP Commands
The LaserLight3 indicator can be controlled by a personal computer connected to one of the indicator communication ports. 
Control is provided by a set of commands which can simulate front panel key press functions, return and change setup 
parameters, and perform reporting functions. The commands provide the capability to print configuration data or to save data to 
an attached personal computer. This section describes the EDP command set and procedures for saving and transferring data 
using the communication ports. The EDP command set is divided into several groups.
When the indicator processes a command, it either responds with a value (for reporting commands, or when querying 
parameter settings), or with the message OK. The OK response verifies the command was received and has been executed. If 
the command is unrecognized, the indicator responds with ?? invalid command. If the command cannot be executed in the 
current mode, the indicator responds with ?? invalid mode. If the command is recognized, but the value is out of range or an 
invalid type, the indicator responds with ?? followed by the type and the range.

9.1 Key Press Commands
Key press serial commands simulate pressing keys on the front panel of the indicator. These commands can be used in both 
setup and Weigh mode. Several of the commands serve as pseudo keys, providing functions which are not represented by a 
key on the front panel.
For example, to enter a 15 lb tare weight using serial commands:

1. Type K1 and press Enter (or Return).
2. Type K5 and press Enter.
3. Type KTARE and press Enter. 

Command Function
KZERO In Weigh mode, this command acts like pressing the Zero key
KGROSSNET In Weigh mode, this command acts like pressing the Gross/Net key
KGROSS Displays Gross mode (pseudo key)
KNET Displays Net mode (pseudo key)
KTARE In Weigh mode, this command acts like pressing the Tare key
KUNITS In Weigh mode, this command acts like pressing the Units key
KPRIM Displays primary units (pseudo key)
KSEC Displays secondary units (pseudo key)
KPRINT In Weigh mode, this command acts like pressing the Print key
KPRINTACCUM Prints the accumulator value
KDISPACCUM Displays the accumulator value
KDISPTARE Displays the tare value
KCLR In Weigh mode, this command acts like pressing the Clear key
KCLRCN Clears consecutive number
KCLRTAR Clears the tare from the system (pseudo key)
KLEFT In Setup mode, this command moves Left in the menu
KRIGHT In Setup mode, this command moves Right in the menu
KUP In Setup mode, this command moves Up in the menu
KDOWN In Setup mode, this command moves Down in the menu
KEXIT In Setup mode, this command exits to Weigh mode
KSAVE In Setup mode, this command saves the current configuration
KSAVEEXIT In Setup mode, this command saves the current configuration and exits to Weigh mode
KTIME Displays the Set System Time screen
KDATE Displays the Set System Date screen
KTIMEDATE Displays the Set System Time screen
KCLRACCUM Clears the accumulator
KENTER This command acts like pressing the Enter key
KMENU This command acts like pressing the Menu key
KDOT This command acts like pressing the decimal point (.)

Table 9-1.  Key Press Commands

https://www.ricelake.com
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9.2 Key Press String Transmission Commands
Sends up to a 20 alphanumeric character string to host indicator through the REMOTEIN port as if the correlating face button is 
pressed (Gross/Net, Print, Tare, Units and Zero). 

9.3 Reporting Commands
Reporting commands send specific information to the communications port. The commands listed in Table 9-3 can be used in 
either Setup mode, Weigh mode or Remote Display mode. 

Kn This command acts like pressing numbers 0 (zero) through 9
KLOCK=x In Weigh mode, this command locks specified front panel key; x = KPRINT, KUNITS, KTARE, KGROSSNET, KZERO, 

(example: to lock the Zero key, enter KLOCK=KZERO)
KUNLOCK=x In Weigh mode, this command unlocks specified front panel key; x = KPRINT, KUNITS, KTARE, KGROSSNET, KZERO, 

(example: to unlock the Print key, enter KUNLOCK=KPRINT)
TEST.KEYPAD Allows testing of the keys on the keypad. To Test keys:

• Input TEST.KEYPAD=ON to enter test mode
• Push keys on keypad
• Input TEST.KEYPAD=OFF to exit test mode

NOTE: The LaserLight3 must be setup mode to use this function.

Command Function
REMOTEKEY.GROSSNET 0 to 20 alphanumeric characters, REMOTEKEY.GROSSNET=KGROSSNET (Default value) 
REMOTEKEY.PRINT 0 to 20 alphanumeric characters, REMOTEKEY.PRINT=KPRINT (Default value) 
REMOTEKEY.TARE 0 to 20 alphanumeric characters, REMOTEKEY.TARE=KTARE (Default value) 
REMOTEKEY.UNITS 0 to 20 alphanumeric characters, REMOTEKEY.UNITS=KUNITS (Default value) 
REMOTEKEY.ZERO 0 to 20 alphanumeric characters, REMOTEKEY.ZERO=KZERO (Default value) 

Table 9-2.  Key Press String Transmission Commands

Command Function
DUMPALL Returns a list of all parameter values
DUMPAUDIT Returns the Audit Trail information
KDUMPAUDIT Returns the Audit Trail information on the same port which the EDP command was sent
AUDIT.LRVERSION Returns the legally relevant firmware version
AUDIT.CONFIG Returns the number of times configuration has changed
AUDIT.CALIBRATE Returns the number of calibrations
AUDITJUMPER Returns the position of the audit jumper: OK (if the audit jumper is ON) or ?? (if the audit jumper is OFF)
SPDUMP Returns a list of the setpoint parameter values
VERSION Returns the installed firmware version
BUILD Returns the firmware version and build number
HARDWARE Returns the option card installed
HWSUPPORT Returns the CPU board part number
RTCBATTERYSTATUS Returns the status of the real time clock battery: GOOD or BAD
TEST.TEMPSENSOR Enter command to view CPU board temperature in Celsius
REMOTE.FORMAT Returns a string representing the learned format when in Remote Display mode.

For example, RLWS for Rice Lake Weighing Systems format.

Table 9-3.  Reporting Commands

Command Function

Table 9-1.  Key Press Commands (Continued)
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9.4 Reset Configuration Command
The following command can be used to reset the configuration parameters of the LaserLight3. 

  NOTE: All scale calibration settings are lost when the RESETCONFIGURATION command is run.

9.5 Scale Parameter Setting Commands
Parameter setting commands allow the current value for a configuration parameter to be displayed or changed.
Current configuration parameter settings can be displayed in Setup mode or Weigh mode using the following syntax:

 command<ENTER>
Most parameter values can be changed in Setup mode only; setpoint parameters listed in Table 9-15 on page 111 can be 
changed when in normal Weigh mode.

  NOTE: The user must stop the current batch for new values to take effect.

Use the following command syntax when changing parameter values: command=value<ENTER>, where value is either a 
number or a parameter value. Use no spaces before or after the equal (=) sign. If an incorrect command is typed or an invalid 
value is specified, the indicator returns ?? followed by the error message. 

Example: to set the motion band parameter on Scale #1 to 5 divisions, type the following:
SC.MOTBAND#1=5<ENTER>

To return a list of the available values for parameters with specific values, enter the command and equal sign, followed by a 
question mark (command=?<ENTER>). The indicator must be in Setup mode to use this function.
After changes are made to configuration parameters using EDP commands, use the KSAVE or KSAVEEXIT commands to 
commit the changes to memory.

Command Function
RESETCONFIGURATION Restores all configuration parameters to default values (Setup mode only)

Table 9-4.  Reset Configuration Command

Command Description Values
SC.CAPACITY#n Scale capacity 0.0000001–9999999.0, 10000.0 (default)
SC.ZTRKBND#n Zero track band (in display divisions) 0.0–100.0, 0.0 (default)
SC.ZRANGE#n Zero range (%) 0.0–100.0, 1.9 (default)
SC.MOTBAND#n Motion band (in display divisions) 0–100, 1 (default)
SC.SSTIME#n Standstill time (in 0.1 second intervals; 10 = 1 second) 0–600, 10 (default)
SC.SENSE#n Sets the type of load cell cable connected 4-WIRE (default), 6-WIRE
SC.OVERLOAD#n Overload FS+2% (default), FS+1D, FS+9D, FS
SC.WMTTHRH#n Weighment threshold 0.0–9999999.0, 1000.0 (default)
SC.NUMWEIGH#n Number of weighments 0–2147483647, 0 (default)
SC.MAX_WEIGHT#n Maximum weighment -9999999–9999999
SC.MAX_DATE#n Date of maximum weighment Up to 25 alphanumeric characters 
SC.DIGFLTR1#n
SC.DIGFLTR2#n
SC.DIGFLTR3#n

Number of A/D samples averaged for the individual 
stages (1-3) of the three stage digital filter

1, 2, 4 (default), 8, 16, 32, 64, 128, 256

SC.DFSENS#n Digital filter cutout sensitivity 2OUT (default), 4OUT, 8OUT, 16OUT, 32OUT, 64OUT, 128OUT
SC.DFTHRH#n Digital filter cutout threshold NONE (default), 2D, 5D, 10D, 20D, 50D, 100D, 200D, 250D
SC.RATLTRAP#n Rattletrap filtering OFF (default), ON
SC.SMPRAT#n Scale A/D sample rate 6.25HZ, 7.5HZ, 12.5HZ, 15HZ, 25HZ, 30HZ (default), 50HZ, 

60HZ, 100HZ, 120HZ
SC.PWRUPMD#n Power up mode GO (default), DELAY
For commands ending with #n, n is the scale number (1)

Table 9-5.  Scale Parameter Setting Commands
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9.6 Scale Parameter Setting Commands
Parameter setting commands allow the current value for a configuration parameter to be displayed or changed.
Current configuration parameter settings can be displayed in Setup mode or Weigh mode using the following syntax:

 command<ENTER>
Most parameter values can be changed in Setup mode only; setpoint parameters listed in Table 9-15 on page 111 can be 
changed when in normal Weigh mode.

  NOTE: The user must stop the current batch for new values to take effect.

Use the following command syntax when changing parameter values: command=value<ENTER>, where value is either a 
number or a parameter value. Use no spaces before or after the equal (=) sign. If an incorrect command is typed or an invalid 
value is specified, the indicator returns ?? followed by the error message. 

SC.TAREFN#n Tare function BOTH (default), KEYED, NOTARE, PBTARE
SC.PRI.FMT#n Primary units format (decimal point and 

display divisions)
8888100, 8888200, 8888500, 8888810, 8888820, 8888850, 
8888881 (default), 8888882, 8888885, 888888.1, 888888.2, 
888888.5, 88888.81, 88888.82, 88888.85, 8888.881, 
8888.882, 8888.885, 888.8881, 888.8882, 888.8885, 
88.88881, 88.88882, 88.88885

SC.PRI.UNITS#n Primary units LB (default), KG, OZ, TN, T, G, NONE
SC.SEC.FMT#n Secondary units format (decimal point and 

display divisions)
8888100, 8888200, 8888500, 8888810, 8888820, 8888850, 
8888881, 8888882, 8888885, 888888.1, 888888.2,
888888.5 (default), 88888.81, 88888.82, 88888.85, 
8888.881, 8888.882, 8888.885, 888.8881, 888.8882, 
888.8885, 88.88881, 88.88882, 88.88885

SC.SEC.UNITS#n Secondary units LB, KG (default), OZ, TN, T, G, NONE
SC.SEC.ENABLED#n Enable the Secondary Units ON (default), OFF
SC.FILTERCHAIN#n Defines what filter to use AVGONLY (default), ADPONLY, DMPONLY, RAW
SC.DAMPINGVALUE#n Sets the damping time constant 0–2560 (in 0.1 second intervals), 10 (default)
SC.ADTHRESHOLD#n Adaptive filter weight threshold value 0–2000 (in display divisions), 10 (default)
SC.ADSENSITIVITY#n Adaptive filter sensitivity LIGHT (default), MEDIUM, HEAVY
SC.ACCUM#n Accumulator enable OFF (default), ON
SC.WZERO#n Perform zero calibration —
SC.TEMPZERO#n Perform temporary zero calibration —
SC.LASTZERO#n Perform last zero calibration —
SC.WVAL#n Test weight value 0.000001–9999999.999999, 10000.0 (default)
SC.WSPAN#n Perform span calibration —
SC.WLIN.F1#n–
SC.WLIN.F4#n

Actual raw count value for linear points 1–4 0–16777215, 0 (default)

SC.WLIN.V1#n–
SC.WLIN.V4#n

Test weight value for linear points 1–4 (A setting of 0 
indicates the linear point is not used)

0.000001–9999999.999999, 0.0 (default)

SC.WLIN.C1#n–
SC.WLIN.C4#n

Perform linear calibration on points 1–4 —

SC.LC.CD#n Deadload coefficient raw count value 0–16777215, 8388210 (default)
SC.LC.CW#n Span coefficient raw count value 0–16777215, 9476903 (default)
SC.LC.CZ#n Temporary zero raw count value 0–16777215, 8388367 (default)
SC.REZERO#n Perform the Rezero calibration function —
SC.INITIALZERO#n Initial Zero range in % of full scale 0.0–100.0, 0.0 (default)
SC.RTZGRAD#n Number of graduations from the zero base at which the 

accumulator re-arms itself
0.0–100.0, 0.4 (default)

Command Description Values

For commands ending with #n, n is the scale number (1)

Table 9-5.  Scale Parameter Setting Commands (Continued)
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Example: to set the motion band parameter on Scale #1 to 5 divisions, type the following:
SC.MOTBAND#1=5<ENTER>

To return a list of the available values for parameters with specific values, enter the command and equal sign, followed by a 
question mark (command=?<ENTER>). The indicator must be in Setup mode to use this function.
After changes are made to configuration parameters using EDP commands, use the KSAVE or KSAVEEXIT commands to 
commit the changes to memory.

Command Description Values
SC.CAPACITY#n Scale capacity 0.0000001–9999999.0, 10000.0 (default)
SC.ZTRKBND#n Zero track band (in display divisions) 0.0–100.0, 0.0 (default)
SC.ZRANGE#n Zero range (%) 0.0–100.0, 1.9 (default)
SC.MOTBAND#n Motion band (in display divisions) 0–100, 1 (default)
SC.SSTIME#n Standstill time (in 0.1 second intervals; 10 = 1 second) 0–600, 10 (default)
SC.SENSE#n Sets the type of load cell cable connected 4-WIRE (default), 6-WIRE
SC.OVERLOAD#n Overload FS+2% (default), FS+1D, FS+9D, FS
SC.WMTTHRH#n Weighment threshold 0.0–9999999.0, 1000.0 (default)
SC.NUMWEIGH#n Number of weighments 0–2147483647, 0 (default)
SC.MAX_WEIGHT#n Maximum weighment -9999999–9999999
SC.MAX_DATE#n Date of maximum weighment Up to 25 alphanumeric characters 
SC.DIGFLTR1#n
SC.DIGFLTR2#n
SC.DIGFLTR3#n

Number of A/D samples averaged for the individual 
stages (1-3) of the three stage digital filter

1, 2, 4 (default), 8, 16, 32, 64, 128, 256

SC.DFSENS#n Digital filter cutout sensitivity 2OUT (default), 4OUT, 8OUT, 16OUT, 32OUT, 64OUT, 128OUT
SC.DFTHRH#n Digital filter cutout threshold NONE (default), 2D, 5D, 10D, 20D, 50D, 100D, 200D, 250D
SC.RATLTRAP#n Rattletrap filtering OFF (default), ON
SC.SMPRAT#n Scale A/D sample rate 6.25HZ, 7.5HZ, 12.5HZ, 15HZ, 25HZ, 30HZ (default), 50HZ, 

60HZ, 100HZ, 120HZ
SC.PWRUPMD#n Power up mode GO (default), DELAY
SC.TAREFN#n Tare function BOTH (default), KEYED, NOTARE, PBTARE
SC.PRI.FMT#n Primary units format (decimal point and 

display divisions)
8888100, 8888200, 8888500, 8888810, 8888820, 8888850, 
8888881 (default), 8888882, 8888885, 888888.1, 888888.2, 
888888.5, 88888.81, 88888.82, 88888.85, 8888.881, 
8888.882, 8888.885, 888.8881, 888.8882, 888.8885, 
88.88881, 88.88882, 88.88885

SC.PRI.UNITS#n Primary units LB (default), KG, OZ, TN, T, G, NONE
SC.SEC.FMT#n Secondary units format (decimal point and 

display divisions)
8888100, 8888200, 8888500, 8888810, 8888820, 8888850, 
8888881, 8888882, 8888885, 888888.1, 888888.2,
888888.5 (default), 88888.81, 88888.82, 88888.85, 
8888.881, 8888.882, 8888.885, 888.8881, 888.8882, 
888.8885, 88.88881, 88.88882, 88.88885

SC.SEC.UNITS#n Secondary units LB, KG (default), OZ, TN, T, G, NONE
SC.SEC.ENABLED#n Enable the Secondary Units ON (default), OFF
SC.FILTERCHAIN#n Defines what filter to use AVGONLY (default), ADPONLY, DMPONLY, RAW
SC.DAMPINGVALUE#n Sets the damping time constant 0–2560 (in 0.1 second intervals), 10 (default)
SC.ADTHRESHOLD#n Adaptive filter weight threshold value 0–2000 (in display divisions), 10 (default)
SC.ADSENSITIVITY#n Adaptive filter sensitivity LIGHT (default), MEDIUM, HEAVY
SC.ACCUM#n Accumulator enable OFF (default), ON
SC.WZERO#n Perform zero calibration —
SC.TEMPZERO#n Perform temporary zero calibration —
SC.LASTZERO#n Perform last zero calibration —
For commands ending with #n, n is the scale number (1)

Table 9-6.  Scale Parameter Setting Commands
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SC.WVAL#n Test weight value 0.000001–9999999.999999, 10000.0 (default)
SC.WSPAN#n Perform span calibration —
SC.WLIN.F1#n–
SC.WLIN.F4#n

Actual raw count value for linear points 1–4 0–16777215, 0 (default)

SC.WLIN.V1#n–
SC.WLIN.V4#n

Test weight value for linear points 1–4 (A setting of 0 
indicates the linear point is not used)

0.000001–9999999.999999, 0.0 (default)

SC.WLIN.C1#n–
SC.WLIN.C4#n

Perform linear calibration on points 1–4 —

SC.LC.CD#n Deadload coefficient raw count value 0–16777215, 8388210 (default)
SC.LC.CW#n Span coefficient raw count value 0–16777215, 9476903 (default)
SC.LC.CZ#n Temporary zero raw count value 0–16777215, 8388367 (default)
SC.REZERO#n Perform the Rezero calibration function —
SC.INITIALZERO#n Initial Zero range in % of full scale 0.0–100.0, 0.0 (default)
SC.RTZGRAD#n Number of graduations from the zero base at which the 

accumulator re-arms itself
0.0–100.0, 0.4 (default)

Command Description Values

For commands ending with #n, n is the scale number (1)

Table 9-6.  Scale Parameter Setting Commands (Continued)
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9.7 LaserLight3 Commands
The following commands can be used to configure LaserLight3 parameters.

9.7.1 Learn or Manual Mode commands

Command Description Values
MANUALMODE.VALIDATE Used to validate Manual Mode configuration when con-

figured through EDP commands.
No parameters, action only.

MANUALMODE Used to enable Manual Mode. On, Off (default)
MANUAL.ANCHOR The beginning or end character in a stream, used to 

determine boundaries of incoming frame.
0 – 32 (decimal); <STX> (default), <CR>, <LF>, or <ETX>  
NOTE: For more abbreviations, see Section 13.5 on page 137.

MANUAL.GROSSCHAR The first character representing Gross Mode 0-Z characters up to 1 character, G (default) 
LEARN.HOLDWT Holds last weight on the display when there is an inter-

ruption in communications
On, Off (default)

MANUAL.MODEEND The index of the last character representing Mode 0 – 100; 0 (default)
MANUAL.MODESTART The index of the first character representing Mode 0 – 100; 0 (default)
MANUAL.NETCHAR The first character representing Net Mode 0-Z characters up to 1 character, N (default) 
MANUAL.POLSTART The index of the first character representing Polarity 0 – 100; 0 (default)
MANUAL.POLEND The index of the last character representing Polarity 0 – 100; 0 (default)
MANUAL.STATUSEND The index of the last character representing Status 0 – 100; 0 (default)
MANUAL.STATUSSTART The index of the first character representing Status 0 – 100; 0 (default)
MANUAL.UNITEND The index of the last character representing Unit 0 – 100; 0 (default)
MANUAL.UNITSTART The index of the first character representing Unit 0 – 100; 0 (default)
MANUAL.WEIGHTEND The index of the last character representing Weight 0 – 100; 0 (default)
MANUAL.WEIGHTSTART The index of the first character representing Weight 0 – 100; 0 (default)
MODEDEF.GROSS Expected Gross character in the incoming stream. A – Z up to 8 characters; G (default)
MODEDEF.NET Expected Net character in the incoming stream. A – Z up to 8 characters; N (default)
POLARITYDEF.POSITIVE Expected character(s) representing positive Polarity A – Z up to 8 characters; <space> (default)
POLARITYDEF.NEGATIVE Expected character(s) representing negative Polarity A – Z up to 8 characters; - (default)
STATUSDEF.INVALID Expected character(s) representing Invalid status A – Z up to 8 characters; I (default)
STATUSDEF.MOTION Expected character(s) representing Motion status A – Z up to 8 characters; M (default)
STATUSDEF.OVERLOAD Expected character(s) representing Overload status A – Z up to 8 characters; O (default)
STATUSDEF.UNDERLOAD Expected character(s) representing Underload status A – Z up to 8 characters; U (default)
STATUSDEF.COZ Expected character(s) representing Center of Zero sta-

tus
A – Z up to 8 characters; Z (default)

STATUSDEF.OK Expected character(s) representing OK status A – Z up to 8 characters; <Space> (default)
UNITDEF.G Expected Gram unit character(s) in the incoming stream. A – Z up to 8 characters; G (default)
UNITDEF.KG Expected Kilogram unit character(s) in the incoming 

stream.
A – Z up to 8 characters; K (default)

UNITDEF.LB Expected Pound unit character(s) in the incoming 
stream.

A – Z up to 8 characters; L (default)

UNITDEF.OZ Expected Ounce unit character(s) in the incoming 
stream.

A – Z up to 8 characters; O (default)

UNITDEF.T Expected Metric Ton unit character(s) in the incoming 
stream.

A – Z up to 8 characters; T (default)

UNITDEF.TN Expected Ton unit character(s) in the incoming stream. A – Z up to 8 characters; t (default)
Table 9-7.  LaserLight3 EDP Commands
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9.7.2 Additional LaserLight3 commands

9.8 Serial Port Setting Commands
The following commands can be used to configure serial port parameters.

9.8.1 Serial Ports
• Ports 1 and 2 are the two RS-232 ports (J3)
• Port 3 is the RS-485/422 port (J4)
• Port 4 is 20ma (J11)

Command Description Values
ADDRESS Command address of LaserLight3 0-31; 0 (default)
BRIGHT.DAY Display brightness during the day 1–6; 4 (default)
BRIGHT.NIGHT Display brightness during the night 1–6; 4 (default)
BRIGHT.DAYLVL Ambient brightness threshold at which the display 

changes from night to day and vice versa
0–10; 4 (default)

BRIGHT.INTENSITY Display brightness from 1–6 (16.67–100%) of full bright-
ness or as DayLVL 

1, 2, 3, 4, 5, 6, DAYLVL; 6 (default)

DISPLAY.COLOR Color of text on the display. Red, Yellow, Green, Blue, Magenta, Cyan, White; Red (default)
DISPLAY.TYPE Determine how the display will be situated Legacy; Standard (default)
MIRROR Select On to display LED readout in reverse; The menu 

is viewed normally
ON, Off (default), Toggle

MSGTIME The amount of time (in seconds) a message stays on the 
remote display

0 - 65535 ; 5 (default)

SETANN.UNIT Manually set Unit annunciator OFF (default), Primary, Secondary
SETANN.MODE Manually set Mode annunciator OFF (default), Gross, Net
STARTUPDTEST Turn Startup Display Test on or off ON, OFF (default)
TIMEDATE Display the Time and Date when at a zero weight ON, OFF (default)

Table 9-8.  Additional LaserLight3 Commands

Command Description Values
EDP.TRIGGER#p Port serial input trigger function CMD (default), STRIND, STRLFT, REMOTEIN, REMOTEOUT
EDP.BAUD#p Port baud rate 1200, 2400, 4800, 9600 (default), 19200, 28800, 38400, 57600, 115200, AUTO
EDP.BITS#p Port data bits/parity 8NONE (default), 8EVEN, 8ODD, 7EVEN, 7ODD
EDP.TERMIN#p Port line termination character CR/LF (default), CR
EDP.STOPBITS#p Port stop bits 1 (default), 2
EDP.ECHO#p Port echo ON (default), OFF
EDP.RESPONSE#p Port response ON (default), OFF
EDP.EOLDLY#p Port end-of-line delay 0–255 (0.1-second intervals), 0 (default)
EDP.ADDRESS#p Port RS-485 address (port 3) 0–31, 0 (default)
EDP.DUPLEX#p Port duplex setting for RS-485 ports

(port 3)
FULL (default), HALF

For commands ending with #p, p is the port number (1-4)
Table 9-9.  Serial Port Commands
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9.9 Ethernet and USB Setting Commands
The following commands can be used to configure Ethernet and USB parameters.

9.10 Wi-Fi Setting Commands
The following commands can be used to configure Wi-Fi parameters.

Command Description Values
WIRED.MACID Ethernet hardware MAC ID (read only) xx:xx:xx:xx:xx:xx
WIRED.DHCP Enable Ethernet DHCP ON (default), OFF
WIRED.ENABLED Enable wired Ethernet adapter ON, OFF (default)
WIRED.IPADDR Ethernet IP address Valid IP xxx.xxx.xxx.xxx*, 0.0.0.0 (default)
WIRED.SUBNET Ethernet subnet mask Valid IP xxx.xxx.xxx.xxx*, 255.255.255.0 (default)
WIRED.GATEWAY Ethernet gateway Valid IP xxx.xxx.xxx.xxx*, 0.0.0.0 (default)
TCPC1.ECHO TCP Client 1 echo ON (default), OFF
TCPC1.EOLDLY TCP Client 1 end-of-line delay 0–255 (in 0.1 sec intervals), 0 (default)
TCPC1.IPADDR TCP Client 1 remote server IP Valid IP xxx.xxx.xxx.xxx*, 0.0.0.0 (default)
TCPC1.LINETERM TCP Client 1 line termination CR/LF (default), CR
TCPC1.PORT TCP Client 1 remote server port 1025–65535, 10001 (default)
TCPC1.RESPONSE TCP Client 1 response ON (default), OFF
TCPC1.TRIGGER TCP Client 1 input trigger type CMD (default), STRIND, STRLFT, REMOTEIN, REMOTEOUT
TCPC1.DISCTIME TCP Client 1 disconnect time (in seconds) 0–60 (0 = do not disconnect), 0 (default)
TCPS.PORT TCP Server port number 1025–65535, 10001 (default)
TCPS.HOSTNAME TCP Server host name Up to 30 alphanumeric characters, 0 (default)
TCPS.TRIGGER TCP Server input trigger type CMD (default), STRIND, STRLFT, REMOTEIN, REMOTEOUT
TCPS.ECHO TCP Server echo ON (default), OFF
TCPS.LINETERM TCP Server line termination CR/LF (default), CR
TCPS.RESPONSE TCP Server response ON (default), OFF
USB.TRIGGER USB input trigger type CMD (default), STRIND, STRLFT, REMOTEIN, REMOTEOUT
USB.LINETERM USB line terminator CR/LF (default), CR
USB.ECHO USB echo ON (default), OFF
USB.RESPONSE USB response ON (default), OFF
USB.EOLDLY USB end of line delay 0–255, 0 (default)
* A valid IP consists of four numbers, in the range of 0 to 255, separated by a decimal point (127.0.0.1 and 192.165.0.230 are valid IP addresses)

Table 9-10.  Ethernet TCP/IP and USB Commands

Command Description Values
WIFI.ENABLED Enables the wireless module and sets Wi-Fi OFF (default), ON 
WIFI.TRIGGER Wi-Fi input trigger type CMD (default), STRIND, STRLFT, REMOTEIN, 

REMOTEOUT
WIFI.TERMIN Wi-Fi line terminator CR/LF (default), CR
WIFI.ECHO Wi-Fi echo ON (default), OFF
WIFI.RESPONSE Wi-Fi response ON (default), OFF
WIFI.EOLDLY Wi-Fi end of line delay 0–255 (in 0.1 second intervals), 0 (default)
WIFI.MACID Returns MAC address of the Wi-Fi radio (read only) xx:xx:xx:xx:xx:xx

Table 9-11.  Wi-Fi Commands
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9.11 Program Commands
The following commands can be used to configure feature parameters.

Command Description Values
DATEFMT Date format MMDDYY (default), DDMMYY, YYMMDD, YYDDMM
DATESEP Date separator SLASH (default), DASH, SEMI, DOT
TIMEFMT Time format 12HOUR (default), 24HOUR
TIMESEP Time separator COLON (default), COMMA, DOT
CONSNUM Consecutive numbering 0–9999999, 0 (default)
CONSTUP Consecutive number start-up value 0–9999999, 0 (default)
UID ID of the LaserLight3 Up to 8 alphanumeric characters, 1 (default)
KYBDLK Keyboard lock, disables keyboard except for the menu key OFF (default), ON
ZERONLY Disables keyboard except for the zero and menu keys OFF (default), ON
CONTACT.COMPANY Contact company name Up to 30 alphanumeric characters
CONTACT.ADDR1-3 Contact company address Up to 20 alphanumeric characters (for each line)
CONTACT.NAME1-3 Contact names Up to 30 alphanumeric characters (for each line)
CONTACT.PHONE1-3 Contact phone numbers Up to 20 alphanumeric characters (for each line)
CONTACT.EMAIL Contact email address Up to 40 alphanumeric characters
CONTACT.LASTCAL Last calibration date Date MMDDYYYY as an 8-digit number
CONTACT.NEXTCAL Next calibration date Date MMDDYYYY as an 8-digit number
KHOLDTIME Key hold time (in tenths of a second); 20 equals 2 seconds 10–50, 20 (default)
KHOLDINTERVAL Key hold time interval; the amount of time between increments 

during a key hold (in twentieths of a second); 2 equals a tenth of 
a second (10 increments per second during a key hold)

1–100, 2 (default)

LOCALE Enable gravity compensation OFF (default), ON, FACTOR
LAT.LOC Origin latitude (to nearest degree) for gravity compensation 0–90, 45 (default)
ELEV.LOC Origin elevation (in meters) for gravity compensation -9999–9999, 345 (default)
DEST.LAT.LOC Destination latitude (in degrees) for gravity compensation 0–90, 45 (default)
DEST.ELEV.LOC Destination elevation (in meters) for gravity compensation -9999–9999, 345 (default)
GRAV.LOC Origin gravity factor (in m/s2) for gravity compensation 9.00000–9.99999, 9.80665 (default)
DEST.GRAV.LOC Destination gravity factor (in m/s2) for gravity compensation 9.00000–9.99999, 9.80665 (default)
PERSISTENTTARE Determines if a tare remains through a power cycle OFF (default), ON

Table 9-12.  Program Commands
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9.12 Stream Setting Commands
The following commands can be used to configure stream format parameters.

9.13 Regulatory Commands
The following commands can be used to configure regulatory parameters.

Command Description Values
STRM.FORMAT#n Stream format RLWS (default), CARDNAL, WTRONIX, TOLEDO, CUSTOM
STRM.CUSTOM#n Custom stream definition Up to 1,000 alphanumeric characters
STRM.GROSS#n Mode token when streaming the Gross weight Up to 8 alphanumeric characters, G (default)
STRM.NET#n Mode token when streaming the Net weight Up to 8 alphanumeric characters, N (default)
STRM.PRI#n Units token when streaming Primary units Up to 8 alphanumeric characters, L (default)
STRM.SEC#n Units token when streaming Secondary units Up to 8 alphanumeric characters, K (default)
STRM.INVALID#n Status token when streaming an Invalid weight Up to 2 alphanumeric characters, I (default)
STRM.MOTION#n Status token when the weight is in motion Up to 2 alphanumeric characters, M (default)
STRM.POS#n Polarity token when the weight is positive SPACE (default), NONE, +
STRM.NEG#n Polarity token when the weight is negative SPACE, NONE, – (default)
STRM.OK#n Status token when the weight is OK (not invalid, out 

of range, at zero or in-motion)
Up to 2 alphanumeric characters (default is a space)

STRM.TARE#n Mode token when streaming the tare weight Up to 8 alphanumeric characters, T (default)
STRM.RANGE#n Status token when the weight is Out of Range Up to 2 alphanumeric characters, O (default)
STRM.ZERO#n Status token when the weight is at Center of Zero Up to 2 alphanumeric characters, Z (default)
For commands ending with #n, n is the stream format number (1)

Table 9-13.  Stream Formatting Commands

Command Description Values
REGULAT Regulatory mode NTEP (default), CANADA, INDUST, NONE, OIML
AUDAGNCY Audit Agency (Industrial Mode) NTEP (default), CANADA, NONE, OIML
REG.SNPSHOT Display or Scale weight source DISPLAY (default), SCALE
REG.ZTARE Remove tare on ZERO NO (default), YES
REG.KTARE Always allow keyed tare NO, YES (default)
REG.MTARE Multiple tare action REPLACE (default), REMOVE, NOTHING
REG.NTARE Allow negative tare NO (default), YES
REG.CTARE Allow Clear key to clear tare/accumulator NO, YES (default)
REG.NEGTOTAL Allow total scale to display negative value NO (default), YES
REG.PRTMOT Allow print while in motion NO (default), YES
REG.PRINTPT Add PT to keyed tare print NO, YES (default)
REG.OVRBASE Zero base for overload calculation CALIB (default), SCALE
REG.AZTNET Perform AZT on Net value NO (default), YES
REG.MANUALCLEARTARE Allows manual clearing of the tare value NO, YES (default)
REG.TAREINMOTION Allows Tare in Motion NO (default), YES
REG.ZEROINMOTION Allows scale to be zeroed while in motion NO (default), YES
REG.UNDERLOAD Underload weight value in display divisions 1–9999999, 20 (default)
REG.HLDWGH Allow Weighment during Display Hold NO (default), YES
REG.MOTWGH Allow Weighment in Motion NO (default), YES
REG.HTARE Allow Tare during Display Hold NO (default), YES
REG.PRTHLD Allow Print during Display Hold NO (default), YES
REG.RKTARE Round Keyed Tare NO (default), YES
REG.RTARE Round Pushbutton Tare NO (default), YES
NTEP defaults shown for regulatory command values

Table 9-14.  Regulatory Commands
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9.14 Setpoint Commands
The following commands can be used to configure setpoint parameters.

9.15 Batching Control Commands
The commands listed in Table 9-16 provide batching control through a communications port.

Command Description Values
BATCHNG Batching mode OFF (default), AUTO, MANUAL
SP.KIND#n Setpoint kind OFF (default), GROSS, NET, -GROSS, -NET, ACCUM, POSREL, NEGREL, 

PCTREL, PAUSE, DELAY, WAITSS, COUNTER, AUTOJOG, COZ, INMOTON, 
INRANGE, BATCHPR, TIMER, CONCUR, TOD, ALWAYS, NEVER

SP.VALUE#n Setpoint value 0.0–9999999.0, 0.0 (default)
SP.TRIP#n Trip HIGHER (default), LOWER, INBAND, OUTBAND
SP.BANDVAL#n Band value 0.0–9999999.0, 0.0 (default)
SP.HYSTER#n Hysteresis 0.0–9999999.0, 0.0 (default)
SP.PREACT#n Preact type OFF (default), ON, LEARN
SP.PREVAL#n Preact value 0.0–9999999.0, 0.0 (default)
SP.PREADJ#n Preact adjustment percentage 0.0–100.0, 50.0 (default)
SP.PRESTAB#n Preact learn stability (in tenths of a second) 0–65535, 0 (default)
SP.PCOUNT#n Preact learn interval 1–65535, 1 (default)
SP.BATCH#n Batch step enable OFF (default), ON
SP.CLRACCM#n Clear accumulator enable OFF (default), ON
SP.CLRTARE#n Clear tare enable OFF (default), ON
SP.PSHACCM#n Push accumulate OFF (default), ON, ONQUIET
SP.PSHPRINT#n Push print OFF (default), ON, WAITSS
SP.PSHTARE#n Push tare OFF (default), ON
SP.ALARM#n Alarm enable OFF (default), ON
SP.ALIAS#n Setpoint name Up to 8 alphanumeric characters, SETPT (default)
SP.ACCESS#n Setpoint access OFF, ON (default), HIDE
SP.DSLOT#n Digital output slot NONE (default), 0
SP.DIGOUT#n Digital output 1–4, 1 (default)
SP.SENSE#n Digital output sense NORMAL (default), INVERT
SP.BRANCH#n Branch destination (0 = do not branch) 0–8, 0 (default)
SP.RELNUM#n Relative setpoint number 1–8, 1 (default)
SP.START#n Starting setpoint 1–8, 1 (default)
SP.END#n Ending setpoint 1–8, 1 (default)
SP.TIME#n Trip time hhmm, 0000 (default)
SP.DURATION#n Trip duration hhmmss, 000000 (default)
SP.ENABLE#n Setpoint enable OFF, ON (default)
For setpoint commands ending with #n, n is the setpoint number (1-8)

Table 9-15.  Setpoints Commands

Command Description Values
BATSTART Batch Start If the BATRUN digital input is active or not assigned, the BATSTART command can be used to start the batch 

program
BATSTOP Batch Stop Stops an active batch and turns off all associated digital outputs; Requires a Batch Start to resume processing
BATPAUSE Batch Pause Pauses an active batch and turns off all digital outputs except those associated with Concurrent and Timer set-

points; processing is suspended until the indicator receives a Batch Start signal; pressing the Batch Start digi-
tal input, BATSTART serial command resumes the batch and re-energizes all digital outputs turned off by the 
Batch Pause

BATRESET Batch Reset Stops the program and resets the batch program to the first batch step; use the BATRESET command after 
making changes to the batch configuration

BATSTATUS Batch Status Returns XYYY where X is S (if the batch is stopped), P (if the batch is paused), 
R (if the batch is running); and YYY is the setpoint number the batch is currently on (1-8)

Table 9-16.  Batching Control Commands
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9.16 Print Format Commands
The following commands can be used to configure print format parameters.

9.17 Digital I/O Command
The following commands can be used to configure digital I/O parameters.

Command Description Values
GFMT
GFMT.PORT
GFMT.PORT2

Gross demand print format string Each format can be sent out one or two ports; for the .PORT and .PORT2 commands, 
specify the port name as one of the following: RS232-1 (PORT default), RS232-2, 20MA, 
RS485, TCP1, TCPS, USB, WIFI, NONE (PORT2 default)

Example: To send the Gross format out both the RS-232 Port 2 and the TCPC Port at the 
same time, send: 

GFMT.PORT=RS232-2
GFMT.PORT2=USB

See Section 10.0 on page 114 for information about demand print format strings

NFMT
NFMT.PORT
NFMT.PORT2

Net demand print format string

ACCFMT
ACC.PORT
ACC.PORT2

Accumulator print format string

SPFMT
SPFMT.PORT
SPFMT.PORT2

Setpoint print format string

HDRFMT1
HDRFMT2

Ticket header format strings

AUD.PORT
AUD.PORT2

Audit destination print ports

Table 9-17.  Print Format Commands

Command Description Values
DIO.b#s Sets DIO type OFF (default), OUTPUT, PRIM, PRINT, SEC, TARE, UNITS, ZERO, BATRUN, 

BATSTART, BATPAUSE, BATRESET, BATSTOP, CLEAR, CLRACC, CLRCN, 
CLRTAR, DSPACC, DSPTAR, GROSS, KBDLOC, NET, NT/GRS, INPUT

DIN#0 Returns a bit-weighted integer number 
(0-15) based on the state of the DIO pins; 
the command looks at the raw state of 
pins (input or output); if all are inactive, it 
returns 0; if all are active, it returns 15

-

DOFF.b#0 Disables digital output for bit entered -
DON.b#0 Enables digital output bit entered -
Valid bit values (b) are 1-4; For commands ending with #s, s is the slot assigned to the digital I/O (0); Slot 0 is onboard; For commands ending with b#0, 
bits must be configured as a digital output for command to function properly.

Table 9-18.  Digital I/O Commands
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9.18 Weigh Mode Commands
These commands function in Weigh mode. Non-weight-related commands work in Setup mode. 

Command Description Values
P Returns what the indicator is currently displaying -- 
ZZ Returns what the indicator is currently displaying as 

along with the currently displayed annunciators
See Section 13.6 on page 140

CONSNUM Returns current consecutive number value 0–9999999, 0 (default)
UID Sets or returns the unit ID Up to 8 alphanumeric characters, 1 (default)
SD Sets or returns the current system date MMDDYY, DDMMYY, YYMMDD, or YYDDMM. Enter six-digit date using the 

year-month-day order specified for the DATEFMT parameter, using only the last two 
digits of the year; The current system date is returned by only sending SD

ST Sets or returns the current system time HHMM (enter using 24-hour format)
The current system time is returned by only sending ST

STS Sets or returns the current system time with 
seconds

HHMMSS (enter using 24-hour format)
The current system time is returned by only sending STS

RS Resets system Soft reset; Used to reset the indicator without resetting the configuration to the fac-
tory defaults

SX Starts all serial data streams --
EX Stops all serial data streams --
SX#p Starts serial data stream for port p OK or ??

An EX command sent while in Setup mode does not take effect until the indicator is 
returned to Weigh mode

EX#p Stops serial data stream for port p

SF#n Returns a single stream frame from scale n using 
the currently configured stream format.

-- 

XA#n Returns the accumulator value in displayed units nnnnnnnnn UU
XAP#n Returns the accumulator value in primary units
XAS#n Returns the accumulator value in secondary units
XG#n Returns the gross weight in displayed units nnnnnnnnn UU
XGP#n Returns the gross weight in primary units
XGS#n Returns the gross weight in secondary units
XN#n Returns the net weight in displayed units nnnnnnnnn UU
XNP#n Returns the net weight in primary units
XNS#n Returns the net weight in secondary units
XT#n Returns the tare weight in displayed units nnnnnnnnn UU
XTP#n Returns the tare weight in primary units
XTS#n Returns the tare weight in secondary units
For commands ending with #n, n is the scale number (1); For commands ending with #p, p is the port number (1-8):

• 1 = RS232-1
• 2 = RS232-2
• 3 = 20mA
• 4 = RS422/485
• 5 = USB
• 6 = TCP Server
• 7 = TCP Client
• 8 = WIFI

Table 9-19.  Weigh Mode Commands
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10.0 Print Formatting
The LaserLight3 provides multiple print formats, Gross, Net, Accumulator, Setpoint, Header which determine the format of the 
printed output when the Print key is pressed. If a tare has been entered or acquired, Net is used; otherwise, Gross is used.
Each print format can be customized to include up to 1,000 characters of information, such as company name and address, on 
printed tickets. Use the print format menu through front panel of the indicator to customize the print formats.
List of print formats and the associated EDP commands:

• Gross Format (GFMT)
• Net Format (NFMT)
• Header Format (HDRFMT1-2)
• Audit Trail Port (AUD.DEST1-2)

10.1 Print Formatting Tokens
Table 10-1 lists tokens which can be used to configure the print formats. Tokens included in the format strings must be enclosed 
between < and > delimiters. Characters outside of the delimiters are printed as text on the ticket. Text characters can include 
ASCII characters, which can be printed by the output device.

Token Description Supported Ticket Formats
General Weight Data Tokens
<Gx> Gross weight, current scale GFMT, NFMT, ACCFMT, SPFMT
<Gx#n> Gross weight, scale n
<Nx> Net weight, current scale
<Nx#n> Net weight, scale n
<Tx> Tare weight, current scale
<Tx#n> Tare weight, scale n
<S> Current scale number
NOTE: For tokens with #n, n is the scale number (1). For tokens with an x, x is the character width of the weight field with padded spaces on 
the left. If x is not specified, 10 is the assumed default for the weight field. x can be set using one or two digits and sets the minimum number 
of characters in the weight field, but expands to show all characters for a value that has more characters than the minimum value set with x.

Example: To format a ticket to provide gross weight for Scale 1 with a minimum of 6 print characters, use the following token: <G6#1>
NOTE: Gross, net and tare weights can be printed in any configured weight unit by adding modifiers to the gross, net, and tare weight tokens: 
/P (primary units), /D (displayed units) or /S (secondary units). If not specified, the currently displayed unit (/D) is assumed.

Example: To format a ticket to provide net weight in secondary units, use the following token: <N/S>
Formatted weight strings default to contain a 10-digit weight field (including sign and decimal point), followed by a space and a 2-digit unit 
identifier. Total field length with unit identifier is 13 characters. For tokens with an x, total field length with unit identifier is x + 3.
Accumulator Tokens
<A> Accumulated weight, current scale; Prints to 15 digits GFMT, NFMT, ACCFMT
<A#n> Accumulated weight, scale n
<AA> Average accumulation, current scale
<AA#n> Average accumulation, scale n
<AC> Number of accumulations, current scale
<AC#n> Number of accumulations, scale n
<AT> Time of last accumulation, current scale
<AT#n> Time of last accumulation, scale n
<AD> Date of last accumulation, current scale
<AD#n> Date of last accumulation, scale n
NOTE: For tokens with #n, n is the scale number (1).
Setpoint Tokens

Table 10-1.  Print Format Tokens
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<SCV> Setpoint captured value SPFMT
<SN> Setpoint number
<SNA> Setpoint name
<SPM> Setpoint mode (gross or net label)
<SPV> Setpoint preact value
<STV> Setpoint target value
Auditing Tokens
<CD> Last calibration date All
<NOC> Number of calibrations
<NOW> Number of weighments since last calibration
NOTE: Last calibration date (<CD>) and number of calibrations (<NOC>) are updated anytime a calibration is performed on any of the scales. 
Number of weighments (<NOW>) is incremented whenever the scale weight exceeds 10% of scale capacity. Scale must return to gross or net 
zero before the value can be incremented again.
Formatting and General-Purpose Tokens
<nnn> ASCII character (nnn = decimal value of ASCII character); used for inserting control 

characters (STX, for example) in the print stream
All

<TI> Time
<DA> Date
<TD> Time and date
<UID> Unit ID number (up to 8 alphanumeric characters)
<CN> Consecutive number (up to 7 digits)
<H1> Insert header format 1 (HDRFMT1)
<H2> Insert header format 2 (HDRFMT2)
<CR> Carriage return character
<LF> Line feed character
<NLnn> New line (nn = number of termination (<CR/LF> or <CR>) characters)*
<SPnn> Space (nn = number of spaces)*
<SU> Toggle weight data format (formatted/unformatted)
NOTE: If nn is not specified, 1 is assumed. Value must be in the range 1–99.
Header Format Tokens
<COMP> Company name (up to 30 characters) All
<COAR1>
<COAR2>
<COAR3>

Company address, lines 1–3 (up to 30 characters)

<CONM1>
<CONM2>
<CONM3>

Company contact names (up to 20 characters)

<COPH1>
<COPH2>
<COPH3>

Company contact phone numbers (up to 20 characters)

<COML> Company contact e-mail address (up to 30 characters)

Token Description Supported Ticket Formats

Table 10-1.  Print Format Tokens (Continued)
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NOTE: The 1,000 character limit of each print format string includes the output field length of the print formatting tokens, 
not the token length. For example, if the indicator is configured to display a decimal point, the <G> token generates an 
output field of 13 characters: the 10 character weight value (including decimal point), one space, and a two-digit units 
identifier. For tokens with an x (e.g. <Gx> or <Gx#n>), total field length with unit identifier is x + 3.
PT (preset tare) is added to the tare weight if tare was keyed in.

10.2 Customizing Print Formats
The Gross (GFMT), Net (NFMT), Accumulator (ACCFMT), Setpoint (SPFMT), Header (HDRFMT1-2), formats can be customized 
using the print format menu via the front panel. See Section 4.3.5 on page 55 for the print format menu structure. To access the 
print format menu the indicator must be in Setup mode (Section 2.8.2 on page 25).
The print format menu via the front panel can be used to customize the print formats and to edit the print format strings with the 
full keyboard that appears on the display when entering a format string. 

10.3 Non-Human Readable Characters
ASCII characters 0 through 31 are non-human readable characters. To include a special character in a print format, the decimal 
equivalent needs to be used (Section 13.5 on page 137). For example, the special character Esc would be <27> or 60, 50, 55, 
62 (less the commas).
Examples of a print release command for a TMU295 in the GROSS format:

Format Default Format String When Used
GFMT GROSS<G><NL2><TD><NL> Weigh mode – no tare in system
NFMT GROSS<G><NL>TARE<SP><T><NL>NET<SP2><N>

<NL2><TD><NL>
Weigh mode – tare in system

ACCFMT ACCUM <A><NL><DA> <TI><NL> Accumulator demand print format string
SPFMT <SCV><SP><SPM><NL> Setpoint print operation with Push Print = ON
HDRFMTn COMPANY NAME<NL>STREET ADDRESS<NL>CITY  ST   ZIP<NL2> Header format strings (n=1-2)

Table 10-2.  Default Print Formats

Print Format:
GROSS<G><NL2><TD><NL><27>q
In Revolution:

Print Format:
GROSS<G><NL2><TD><NL><27><113>
In Revolution:
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11.0 Setpoints
The LaserLight3 indicator provides eight configurable setpoints for control of both indicator and external equipment functions. 
Setpoints can be configured to perform actions or functions based on specified parameter conditions. Parameters associated 
with various setpoint kinds can, for example, be configured to perform functions (print, tare, accumulate), to change the state of 
a digital output controlling indicator or external equipment functions, or to make conditional decisions.

  NOTE: Weight-based setpoints are tripped by values specified in primary units only.

11.1 Continuous and Batch Setpoints
LaserLight3 setpoints can be either continuous or batch.
Continuous setpoints are free-running; the indicator constantly monitors the condition of free-running setpoints at each A/D 
update. The specified setpoint action or function is performed when the designated setpoint parameter conditions are met. A 
digital output or function assigned to a free-running setpoint continuously changes state, becoming active or inactive, as 
defined by the setpoint parameters. 
Batch setpoints (Batch = On) which have digital outputs associated to them remain active until the setpoint condition is met. 
The setpoint is then latched for the remainder of the batch sequence.
To use batch setpoints, set the Batching parameter in the Setpoint menu. This parameter defines whether a batch sequence is 
automatic or manual. Auto sequences repeat continuously after receiving a single batch start signal, while Manual sequences 
only run through once for each batch start signal. The batch start signal can be initiated by a digital input (set to Batch Start), or 
an EDP command (BATSTART).
For a setpoint to be used as part of a batch sequence, its batch sequence (Batch) parameter must be set to On. If a setpoint is 
defined and enabled, but its batch sequence parameter is set to Off, the setpoint operates as a continuous setpoint even during 
batch sequences.

NOTE: In applications which contain both batch setpoint routines and continuous setpoints, it is good practice to keep 
continuous setpoints separate from the batch sequence. 
Do not assign them the same digital output.
Set the Access parameter On when creating and testing batch routines. Once the batching routine is complete and ready 
for production, Access can be set to Off to prevent changes to the configured setpoint value, or to Hide to prevent 
changing or viewing the value.

 
Parameter Description Batch Continuous

Off Setpoint turned off/ignored
Gross Performs functions based on the gross weight; the target weight entered is considered a positive 

gross weight
X X

Net Performs functions based on the net weight; the target weight entered is considered a positive 
net weight value

X X

Negative Gross Performs functions based on the gross weight; the target weight entered is considered a 
negative gross weight

X X

Negative Net Performs functions based on the net weight; the target weight entered is considered a negative 
net weight value

X X

Accumulate Compares the value of the setpoint to the source scale accumulator; the accumulator setpoint is 
satisfied when the value of the source scale accumulator meets the value and conditions of the 
accumulator setpoint

X X

Positive Relative Performs functions based on a specified value above a referenced setpoint, using the same 
weight mode as the referenced setpoint

X X

Negative Relative Performs functions based on a specified value below a referenced setpoint, using the same 
weight mode as the referenced setpoint

X X

Table 11-1.  Setpoint Kinds
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Percent Relative Performs functions based on a specified percentage of the target value of a referenced setpoint, 
using the same weight mode as the referenced setpoint; the actual target value of the Percent 
Relative setpoint is calculated as a percentage of the target value of the referenced setpoint

X X

Pause Pauses the batch sequence indefinitely; a Batch Start signal must be initiated to continue the 
batch process

X

Delay Delays the batch sequence for a specified time; the length of the delay (in tenths of a second) is 
specified on the Value parameter

X

Wait Standstill Suspends the batch sequence until the scale is at standstill X
Counter Specifies the number of consecutive batch sequences to perform; place counter setpoints at the 

beginning of a batch routine
X

Auto-Jog Automatically checks the previous weight-based setpoint to verify the setpoint weight value is 
satisfied in a standstill condition

• If the previous setpoint is not satisfied when at standstill, the Auto-Jog setpoint activates 
the digital output of the previous weight-based setpoint for a period of time, specified on 
the Value parameter (in tenths of a second)

• The Auto-Jog process repeats until the previous weight-based setpoint is satisfied when 
the scale is at standstill

NOTE: The Auto-Jog digital output is typically used to signify an Auto-Jog operation is 
being performed. 
NOTE: Auto-Jog uses the digital output of the previous weight-based setpoint, and 
should not be assigned to the same digital output as the related weight-based setpoint.

X

Center of Zero Monitors for a gross center of zero condition
• The digital output associated with this setpoint kind is activated when the referenced scale 

is at center of zero
• No value is required for this setpoint

X

In Motion Monitors for an in-motion condition
• The digital output associated with this setpoint is activated when scale is not at standstill
• No value is required for this setpoint

X

In Range Monitors for an in-range condition
• The digital output associated with this setpoint is activated when the scale is within 

capacity range 
• No value is required for this setpoint

X

Batch in Process Batch processing signal:
• The digital output associated with this setpoint is activated whenever a batch sequence is 

in progress 
• No value is required for this setpoint

X

Timer Tracks the progress of a batch sequence based on a timer
• The timer value, in tenths of a second, determines the length of time allowed between start 

and end setpoints 
• Start and End parameters are used to specify the start and end setpoints 
• If the End setpoint is not reached before the timer expires, the digital output associated 

with this setpoint is activated 

X

Concurrent Allows a digital output to remain active over a specified portion of the batch sequence
• Type 1 (Value = 0): The digital output associated with this setpoint becomes active when 

the Start setpoint becomes the current batch step and remains active until the End setpoint 
becomes the current batch step

• Type 2 (Value > 0): If a non-zero value is specified for the Value parameter, the value 
represents the timer, in tenths of a second, for this setpoint; The digital output associated 
with this setpoint becomes active when the Start setpoint becomes the current batch step 
and remains active until the timer expires

X

Time of Day Performs functions when the internal clock time of the indicator matches the specified 
setpoint time

X X

Always This setpoint is always satisfied; It is typically used to provide an endpoint for true/false 
branching batch routines

X

Never This setpoint is never satisfied; Used to branch to a designated setpoint in true/false branching 
batch routines in which the batch does not continue through the normal sequence of batch 
setpoints

X

Parameter Description Batch Continuous

Table 11-1.  Setpoint Kinds (Continued)
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11.2 Batch Operations
Batches are controlled by digital inputs or EDP commands.
Batch Run (or BATRUN EDP command)
If a Batch Run digital input is configured, it must be active (low) for a batch to be started, and for it to continue to run. If a batch 
is running and the input becomes inactive (high), it will stop the batch at the current batch setpoint and turn off all associated 
digital outputs.
Batch Start (or BATSTART EDP command)
If the Batch Run digital input is active (low), or is not assigned, Batch Start will start a batch, resume a paused batch or resume 
a stopped batch. If the Batch Run digital input is inactive (high), Batch Start will reset the current batch.
Batch Pause (or BATPAUSE EDP command)
The Batch Pause digital input will pause an active batch, turning off all associated digital outputs EXCEPT those associated 
with Concurrent and Timer setpoints, while the input is active (low). As soon as the Batch Pause digital input is made inactive 
(high), the batch will resume. BATPAUSE EDP command works the same, except the batch will not resume until a Batch Start 
signal is received.
Batch Stop (or BATSTOP EDP command)
Stops an active batch at the current setpoint and turns off all associated digital outputs.
Batch Reset (or BATRESET EDP command)
Stops and resets an active batch to the beginning of the process.

WARNING: To prevent personal injury and equipment damage, software-based interruptions must always be supplemented 
by emergency stop switches and other safety devices necessary for the application.

11.2.1 Batching Switch
The batching switch option (PN 19369) comes as a complete unit in an FRP enclosure, with legend plate, emergency stop, and 
a run/start/abort three-way switch.

Figure 11-1. Batching Switch
Both switches are wired into the indicator’s digital I/O terminal as shown in Figure 11-2 on page 120. Each switch uses a 
separate digital input. Digital I/O Bit 1 must be set to Batch Start and Bit 2 must be set to Batch Run.
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Once cables and switches have been connected to the indicator, use the setup jumper (J25) to place the indicator in Setup 
mode. Use the Digital I/O menu (Section 4.3.8 on page 61) to configure digital input and output functions.

Figure 11-2. Batching Switch and Wiring Diagram Example
When configuration is complete, exit Setup mode. Initialize the batch by turning the three-way switch to ABORT, then unlock 
the STOP button (the STOP button must be in the OUT position to allow the batch process to run). The batching switch is now 
ready to use.

WARNING: If no digital input is assigned to Batch Run, batching proceeds as if Batch Run were always on (the batch starts 
when the three-way switch is turned to Run, but the Stop button does not function).

To begin a batch process, turn the three-way switch to START momentarily. If the STOP button is pushed during the batch 
process, the process halts and the button locks in the IN position.
The START switch is ignored while the STOP button is locked in the IN position. The STOP button must be turned 
counterclockwise to unlock it, then released into the OUT position to enable the three-way switch.
To restart an interrupted batch from the step where it left off:

1. Unlock STOP button (OUT position).
2. Turn three-way switch to START.

To restart an interrupted batch from the first batch step:
1. Turn three-way switch to ABORT.
2. Unlock STOP button (OUT position).
3. Turn three-way switch to START.

To abort an interrupted batch:
1. Push the STOP button.
2. Turn three-way switch to ABORT.
3. Unlock STOP button (OUT position). A new batch can now be started.

NOTE: Use this procedure (or Batch Reset) to initialize the new batch routine following any change to the setpoint 
configuration.
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11.3 Batching Examples
11.3.1 Example 1
The following example uses six setpoints to dispense material from a hopper in 100-lb batches and to automatically refill the 
hopper when its weight drops below 300 lb.

Bits 1 and 2 in the Digital I/O menu (Section 4.3.8 on page 61) are assigned to batch start and batch run functions: Batch Run 
must be on (low) before the Batch Start input starts the batch.

Slot 0, Bit 1 = Batch Start
Slot 0, Bit 2 = Batch Run
Batching = Manual

Setpoint 1 ensures the hopper has enough material to start the batch. If the hopper weight is 300 lb or higher, setpoint 1 is 
tripped.

Setpoint 1 Trip = Higher
Kind = Gross Alarm = On
Value = 300 Batch = On

Setpoint 2 waits for standstill, then performs a tare to put the indicator into net mode.
Setpoint 2
Kind = Wait Standstill
Push Tare = On

Setpoint 3 is used as a reference (relative setpoint) for setpoint 4.
Setpoint 3 Trip = Higher
Kind = Net Batch = Off
Value = 0

Setpoint 4 is used to dispense material from the hopper. When the hopper weight falls to 100 lb less than its weight at the 
relative setpoint (setpoint 3), digital output 1 is set off. 

Setpoint 4 Digital Output = 1
Kind = Negative Relative Batch = On
Value = 100 Relative Setpoint Number = 3
Trip = Lower

Setpoint 5 is used to evaluate the gross amount of material in the hopper after dispensing, and to maintain a minimum material 
level in the hopper. When the hopper weight falls below 300 lb, digital output 2 becomes active and the hopper is refilled to 
1,000 lb.

Setpoint 5 Hysteresis = 700
Kind = Gross Digital Output = 2
Value = 300 Batch = On
Trip = Higher

Setpoint 6 is used to ensure the operation performed in setpoint 4 is completed within 10 seconds. The Start and End 
parameters identify the setpoints monitored by the Timer. If the Timer expires before Setpoint 5 starts, Digital Output 4 is turned 
on as an alarm to signal a process fault.

Setpoint 6 Start = 4
Kind = Timer End = 5
Value = 100 Digital Output = 4



LaserLight3 Large-Display Weight Indicator

122 Visit our website www.RiceLake.com

11.3.2 Example 2
The following example uses six setpoints to control a two-speed fill operation where both fast and slow feeds are on 
simultaneously.

Bits 1 and 2 in the Digital I/O menu (Section 4.3.8 on page 61) are assigned to Batch Start and Batch Run functions. Batch Run 
must be on (low) before the Batch Start input starts the batch.

Slot 0, Bit 1 = Batch Start
Slot 0, Bit 2 = Batch Run
Batching = Manual

Setpoint 1 ensures the scale is empty (0±2 lb).
Setpoint 1 Trip = Inband
Kind = Gross Band Value = 2
Value = 0 Batch = On

Setpoint 2 checks for the weight of a container (>5 lb) placed on the scale.
Setpoint 2 Trip = Higher
Kind = Gross Batch = On
Value = 5

Setpoint 3 waits for standstill, then tares the container weight, placing the indicator in net mode.
Setpoint 3
Kind = Wait Standstill
Push Tare = On

Setpoint 4 starts the fast fill operation. When the net weight reaches 175 lb, the setpoint trips and digital output 1 is set off.
Setpoint 4 Trip = Higher
Kind = Net Digital Output = 1
Value = 175 Batch = On

Setpoint 5 controls the slow fill operation. When the net weight reaches 200 lb, the slow fill is stopped, the indicator waits for 
standstill and performs a push print operation using the Setpoint Format ticket format.

Setpoint 5 Push Print = Wait Standstill
Kind = Net Digital Output = 2
Value = 200 Batch = On
Trip = Higher

Setpoint 6 is a continuous setpoint, used to allow the slow feed output to be on at the same time as the fast fill. The slow fill 
output (Digital Output 2) is turned on when Setpoint 4 (fast fill) starts and remains on until Setpoint 5 begins.

Setpoint 6 Start = 4
Kind = Concurrent End = 5
Value = 0 Digital Output = 2
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12.0 Maintenance
The maintenance information in this manual is designed to cover aspects of maintaining and troubleshooting the LaserLight3 
indicator. Contact the local Rice Lake Weighing Systems dealer if a problem requires technical assistance.

  NOTE: Have serial number available when calling for assistance. 

12.1 Maintenance Checkpoints
The LaserLight3 must be checked frequently to determine when a calibration is required. It is recommended a zero calibration 
be checked every other day and a calibration checked every week for several months after installation. Observe the results and 
change the period between calibration checks, depending upon the accuracy desired. 

NOTE: Establish a routine inspection procedure. Report changes in the LaserLight3 function to the individual or 
department responsible for the LaserLight3 performance. 

12.2 Field Wiring
If a problem with the wiring is suspected, check the electrical portion of the LaserLight3.

• Check for proper connections between the components of the system
• Check wiring meets all specifications in the installation drawings
• Check all wiring and connections for continuity, shorts and grounds using an ohmmeter with the LaserLight3 off
• Check for loose connections, poor solder joints, shorted or broken wires and unspecified grounds in wiring; these issues 

cause erratic readings and shifts in weight readings
• Check all cable shields to ensure grounding is made at only the locations specified in the installation drawings

12.3 Troubleshooting Tips
Table 12-1 lists general troubleshooting tips for hardware and firmware error conditions.

Symptom Possible Cause Remedy
LaserLight3 does not power up Bad power supply Check power supply; Check presence of AC power – breaker tripped or unit 

unplugged; Power supply outputs low or no voltage – replace if bad
Battery-backed corrupt error message at 
startup

Bad CR2032 coin cell bat-
tery (on CPU board)

Perform configuration reset then check for low battery warning on display; 
If battery is 2.7V or less, replace battery (see Section 12.5 on page 126), perform 
another configuration reset, then reload files/configuration

   or
 vvv vvvv

Over or under range 
LaserLight3 condition

For out-of -range conditions, check all LaserLight3 inputs for positive weight 
values. Troubleshoot load cell, then junction.
Verify Sense parameter is configured correctly for the quantity of load cell wires 
(4- Wire is default). For more information, see Section 4.3.1 on page 46.

Cannot enter Setup mode Bad or missing shunt Test shunt for continuity or replace shunt on jumper (J25)
Serial port not responding to a command Configuration error Ensure port INPUT parameter is set to CMD for command input
A/D LaserLight3 out of range LaserLight3 operation

Load cell connection
Bad load cell or summing 
board in junction box

Check scale for binding, obstructions and mechanical failures 
Check load cell and cable connection
Check LaserLight3 operation with load cell simulator
Check status of sense setting

Does not display data from source Source connection Check source for cable connection and verify continuity of wiring

Table 12-1.  Basic Troubleshooting

vvvvvvv
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12.4 Removing Front Door
The LaserLight3 front door can be detached when service is required. Perform the following to remove the front door.

NOTE: The following procedure involves disconnecting wiring, for more information about wiring see Section 2.6 on 
page 17.
WARNING: The LaserLight3 has no on/off switch. Before opening the unit, ensure the power cord is disconnected from the 
power outlet.
Use a grounding wrist strap to protect components from electrostatic discharge (ESD) when working inside the enclosure 
or on the front door.

1. Unplug the power cord from the power outlet.
2. Open enclosure as described in Section 2.4 on page 15.
3. Disconnect power wiring from CPU board on J14.
4. Remove green ground wire from front door closest mounted ferrites.
5. Disconnect wiring to external components from CPU board. For example, communication cables (J3, J11, J4 or J8), 

load cell cables (J1) and DIG I/O (J5).
6. (Optional) If installed, disconnect Wi-Fi antenna cable from Wi-Fi module.
7. While supporting front door from underneath, pull quick release pins by rings away from hinges.

  NOTE: If pins are difficult to remove, lift door slightly to relieve weight of front door from hinge.

Figure 12-1. LaserLight3 Quick Release Pins

Ground

Quick Release Pin

Quick Release Pin
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8. Position door approximately 30 degrees from vertical, then lift vertically to remove from enclosure.

  NOTE: Positioning the door approximately 30 degrees from vertical, allows the door hinge to pass over the enclosure seal.

Figure 12-2. LaserLight3 Quick Release Pins

9. Place front door in ESD safe work area and perform required maintenance.
10. Reverse procedure to reinstall front door.
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12.5 Battery Replacement
The battery life varies depending on use. It is recommended to replace the battery every three years, or sooner, if left powered 
off for extended periods of time to prevent data loss in the event of a power failure. Use the Revolution configuration utility 
(Section 8.0 on page 98) or EDP commands (Section 9.0 on page 100) to store a copy of the LaserLight3 configuration on a PC 
before attempting battery replacement. The LaserLight3 configuration can be restored from the PC if data is lost. 

NOTE: When LaserLight3 is opened, the CPU board is presented with the text oriented upside down. This section reflects 
the orientation of the CPU board when viewed in an open LaserLight3 enclosure.

WARNING: Risk of explosion if battery is replaced with an incorrect type. Dispose of used batteries according to federal, 
state and local regulations.

IMPORTANT: Use anti-static protection for grounding and to protect components from electrostatic discharge (ESD) when 
working inside the LaserLight3 enclosure. Procedures requiring work inside the LaserLight3 must be performed by 
qualified service personnel only.

Figure 12-3. CPU Board Battery Location

Perform the following to replace the 3V lithium CR2032 battery (PN 71408):
1. Disconnect power to the indicator.
2. Open enclosure as described in Section 2.4 on page 15.
3. Place the tip of a non-conductive flat head screw driver between negative contact and battery.
4. Twist screw driver to release battery from holder.
5. Press new replacement battery straight into the battery holder with the positive side up. 

Figure 12-4. Battery Installed

6. Reset the time and date settings of the indicator (see Section 3.5.1 on page 34 and Section 3.5.2 on page 35).

Battery

Battery
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12.6 CPU Board Replacement
  NOTE: CPU Board replacement should only be performed by a service technician.

IMPORTANT: Use anti-static protection for grounding and to protect components from electrostatic discharge (ESD) when 
working inside the LaserLight3 enclosure. Procedures requiring work inside the LaserLight3 must be performed by 
qualified service personnel only.

1. Disconnect power to LaserLight3.
2. Open enclosure as described in Section 2.4 on page 15.
3. Label connections for re-installation to new CPU board.
4. Disconnect all cabling from CPU board.
5. Remove ferrite support mounting screws, washers and standoffs.
6. Set display ferrite support stand/display power cable to side.

NOTE: The following image displays a basic example of the CPU board installed in the LaserLight3. Depending on 
configuration, additional components and cabling may present.

Figure 12-5. Disconnecting Components from CPU Board

7. Remove all CPU board mounting screws and washers.
8. Remove CPU board.

Figure 12-6. Removing CPU Board

Disconnect 
Cabling

Remove Ferrite Support 
Mounting Hardware

Disconnect 
Cabling

Remove CPU Board 
Mounting Screws
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9. Ensure display power cable is connected to display power input (adjacent to large ribbon cable with ferrites), and then 
set to the side.

Figure 12-7. Display Power Cable Connection

10. Position new replacement CPU board on standoffs in enclosure and secure with previously removed hardware.

Figure 12-8. Attaching New CPU Board

11. Reattach ferrite support stand to CPU board and standoffs with previously removed hardware.
12. Reconnect cabling to CPU board. See Section 2.8 on page 24 for details about board connectors.

Figure 12-9. Connecting Components and Cables on CPU Board

IMPORTANT: Verify LaserLight3 connections are properly installed and perform complete function test before returning the 
LaserLight3 to service.

Cable Connection

Secure CPU Board 
Mounting Screws

Connect Cabling
Attach Ferrite Support 
Mounting HardwareConnect Cabling
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12.7 LED Display Replacement
Two LED display panels comprise the LaserLight3 display. Depending on the scenario, either one or both LED display panels 
may be replaced.

  NOTE: CPU Board replacement should only be performed by a service technician.

IMPORTANT: Use anti-static protection for grounding and to protect components from electrostatic discharge (ESD) when 
working with LaserLight3 components. 

1. Disconnect power to LaserLight3.
2. Open LaserLight3 as described in Section 2.4 on page 15.
3. Remove front door as described in Section 12.4 on page 124.
4. Remove eight heat shield Phillips screws and washers on ends of heat shield.

Figure 12-10. Heat shield and CPU Board Removal

5. Lift the heat shield slightly and then unplug 4-pin cable connected to LED display (approximately under CPU board 
HUB 75 connector). 

Figure 12-11. Disconnecting Cable Under Heat Shield

Disconnect Cable
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6. Lift heat shield and PCB away from door frame and set aside.

Figure 12-12. Removing Heat Shield from Door Frame

7. Remove ribbon cable attached to the two LED displays.

  NOTE: The ribbon cable has a locking feature that must be carefully unlocked to allow removal.

Figure 12-13. Remove Ribbon Cable from LED Displays

Connector Locks
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8. Remove four Philips mounting screws and washers (previously underneath heat shield) for only the LED display that 
will be replaced.

Figure 12-14. Remove Mounting Hardware from LED Displays

9. Note orientation of connectors on LED display.
10. Press the two locating pins down, then slide out LED display from door frame.

Figure 12-15. Slide Out LED Display from Door Frame
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11. Slide new LED display into door frame while maintaining same connector orientation as previous LED display.

  NOTE: The display provides orientation arrows. Ensure they point toward the captive screws.

12. Ensure two locating pins engage in door frame.
13. Attach LED display with four Philips mounting screws and washers (removed in Step 8).
14. If needed, repeat Step 8 through Step 13 to replace remaining LED display.
15. Reattach and lock ribbon cable to the two LED displays (removed in Step 7).
16. Connect 4-pin cable to LED display that is covered by the heat shield (removed in Step 6).
17. Reattach heat shield with CPU board to door frame with eight Philips screws and washers (removed in Step 4).
18. Reconnect CPU board cabling.
19. Reattach front door as described in Section 12.4 on page 124.
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12.8 Test Functions
12.8.1 Digital Output Test
The Digital Output Test displays if a digital output is operational.
Figure 12-17 displays a menu path to the Digout parameter.

Figure 12-16. Digout parameter Menu Path

1. Navigate to Audit ► Test ▼ Digout.

2. Press . Bit 1 displays.

3. Press  or  repeatedly until the desired Bit is selected.

4. Press . The bit activates for three seconds, displays OK and then becomes inactive.
NOTE: Digital output bits must be configured as an output to be tested. “Bit not configured” displays if the test is activated 
for a digital output bit that is not assigned. See Section 2.7.6 on page 21 for pin assignments and Section 4.3.7 on page 57 
for digital I/O configuration description.

5. Press  to exit the menu.

12.8.2 Digital Input Test
Perform the following to test Digital Inputs:
The Digital Input Test Displays a summed decimal representation of all active Digital I/O (J5 on the CPU board) input signals. 
Figure 12-17 displays a menu path to the Digin parameter.

Figure 12-17. Digin parameter Menu Path

1. Navigate to Audit ► Test ▼ Digout ►... ►Digin.

2. Press . The summed values read from the digital input bits displays.

  NOTE: The summed data range is 0 - 15. Each input bit provides a specific value:

3. Press  to exit the menu.

Connector Pin Signal Input Bit
J5 1 +5 VDC, 250 mA max -

2 GND -
3 DIO1 1
4 DIO2 2
5 DIO3 4
6 DIO4 8

Table 12-2.  Digin Bit Range

DigoutLightLvl

Audit Setpnt TareSetup Accum Mac ID Test

MENU

Digout DiginLightLvl

Audit Setpnt TareSetup Accum Mac ID Test

MENU
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12.8.3 Loop-back Test
This test provides a loop-back self test for use in diagnosing CPU board serial communications errors. The loop-back self test 
checks the function of the LaserLight3 by connecting a jumper wire to specific serial port pins and sending and receiving data to 
itself. If the data is sent and received as expected, the test is successful and Pass displays. If the data is not sent or received, 
the test is unsuccessful and displays Fail. There are three tests depend on serial port, see Table 12-3 for tests and required 
jumper wire connections.

Figure 12-18 displays a menu path to the LoopBack parameter.

Figure 12-18. LoopBack parameter Menu Path

1. Unplug the power cord from the power outlet.
2. Open enclosure as described in Section 2.4 on page 15.
3. Install a jumper wire according to serial pin assignment (Table 12-3).
4. Close enclosure as described in Section 2.4 on page 15.
5. Plug in the power cord to the power outlet.
6. Navigate to Audit ► Test ▼ Digout►... ►LoopBack.

7. Press . RS-232 1 displays.

8. Press  or  repeatedly until the desired test is selected.

9. Press . The Test begins.
10. One of the following occurs:

• If communication is unsuccessful, Fail displays.
• If communication is successful, OK displays.

Communication Test RS-232 1 RS-232 2 RS-485
Wire Connections RS-232 1 TX 1  (P3) → RX 1 (P2) RS-232 2 TX 2 (P6) → RX 2 (P5) RS-485 TX Z (P4) → RX B (P2) 

RS-485 TX Y (P5) → RX A (P3) 
Wire Diagram

Table 12-3.  Loop-Back Test Jumper Wire Connections

Digout DiginLightLvl LoopBack

Audit Setpnt TareSetup Accum

Mac ID Test
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13.0 Appendix

13.1 Error Messages
The LaserLight3 provides a number of front panel error messages to assist in problem diagnosis. Table 13-1 lists these 
messages and their meanings.

13.2 Audit Trail Support
Audit trail support provides tracking information for configuration and calibration events. To prevent potential misuse, all 
configuration and calibration changes are counted as change events.
Audit trail information can be printed from Revolution or by sending the DUMPAUDIT serial command. Revolution can be used 
to display audit trail information. The audit trail display includes the legally relevant (LR) version number (firmware version for 
the code which provides audit trail information), a calibration count and a configuration count. 
See Section 3.6.11 on page 41 for steps to view the Audit Trail counters.

13.3 Unit Conversion Factors
The LaserLight3 has the capability to mathematically convert a weight into many different types of units and instantly display 
those results with a press of the Units key. Secondary Units can be configured in the Format menu (Section 4.3.2 on page 48).

NOTE: Multipliers are preconfigured within the indicator.
Ensure the unit format is set appropriately for the scale capacity in the Secondary Unit Format.

Error Message Description
 ------- Overflow error – Weight value too large to be displayed

Gross > overload limit – Gross value exceeds overload limit; Check configuration or signal input level; Overload can 
be caused by input signal > 45 mV or common mode voltage > 950 mV

 v v v v v v v Gross < underload limit – Gross value exceeds underload limit
Battery low Displays every 30-seconds when CR2032 battery is 2.7V or less
Waiting for 30 seconds of standstill Displays when power up delay is active
Not allowed in motion Displays when attempting to perform a function while weight is in motion, if in motion is not allowed for that function
Tare in motion not allowed Displays when attempting to perform a tare while weight is in motion, if in-motion tares are not allowed
Tare not allowed Displays when attempting to perform a tare, if a tare is not allowed
Negative tare not allowed Displays when attempting to perform a negative tare, if a negative tare is not allowed
Keyed tare not allowed Displays when attempting to perform a keyed tare, if a keyed tare is not allowed
Tare exceeding capacity not allowed Displays when attempting to perform a tare larger than capacity, if it is not allowed
Multiple tares not allowed Displays when attempting to perform a tare if a tare is already in the system, if tare is not configured to 

replace or remove
Must be in first interval to tare Interval is currently within the second or third interval; Perform tare while in the first interval only
Keyed tare value must be in first 
interval

Keyed tare value is within the second or third interval; Keyed tare value must be within the first interval only

Initial zero failed Displays when an attempt to perform an initial zero fails, only possible at startup
Please wait Displays when calibrating
Alarm Displays when a configured setpoint’s ALARM action occurs
NODATA Displays when set to a remote display and indicates that a data stream is not currently received by the LaserLight3. 

Ensure Indicator is transmitting a data stream to LaserLight3, LaserLight3 is set to RmtIn (Remote In), and wiring is 
correct/undamaged.

Table 13-1.  LaserLight3 Error Messages

vvvvvvv
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13.4 Parameter Abbreviation List
Table 13-2 lists parameter abbreviations and definitions from the menu (Section 4.0).

Abbreviation Definition Abbreviation Definition Abbreviation Definition
Accum Accumulator HttpSvr Http Server PrtAcum Print Accumulator
AccumFmt Accumulator Format Hysteres Hysteresis PshAcc Push Accumulator
Addr 1-3 Address 1-3 IndSet Industrial Settings PshPrint Push Print
Addres Address InitZro Initial Zero Range PshTare Push Tare
AdSense Adaptive Filter Sensitivity Ip Addr IP Address PwrUpM Power Up Mode
AdThrh Adaptive Filter Threshold KTare Allow Keyed Tare Range Out of Range
AnchrSq Anchor Sequence LastCal Last Calibration Regula Regulatory Mode
AudAgcy Audit Agency LatOrig Origin Latitude RelNum Relative Setpoint Number
Azt Net Auto-Zero Tracking on Net Zero LightLvL Light Level Respnse Response
BandVal Band Value LnTerm Line Termination RKTare Round Keyed Tare
Calibr Calibration LRV Legally Relevant Version RTare Round Button Tare
ClrAcum Clear Accumulator LstZero Last Zero RtlTrap RattleTrap
ClrTare Clear Tare MaxWgh Maximum Weight Sec Secondary
Comm Communication MCLTare Manual Clear Tare SetAnn Set Annunciator
Config Configuration MnlMode Manual Mode Setpnt Set point
ConsNu Consecutive Number MnlMVal Manual Mode Validation SFormt Stream Format
CTare Allow Clear Tare Key ModeBeg Mode Start SmpRat Sample Rate
DfltCFG Default Configuration ModeDef Mode Definitions SnapSht Snapshot
DfSens Digital Filter Sensitivity ModeEnd Mode End SpnCnt Span Counts
DfThrh Digital Filter Threshold MotBnd Motion Band SSTime Standstill Time
DigFl 1-3 Digital Filter Stage 1-3 MotoWgh Weighment in Motion StatBeg Status Start
Digin Digital Input MsgTim Message Time StatDef Status Definitions
Digio Digital Inputs and Outputs MTare Multiple Tare Action StatEnd Status End
DigOut Digital Output Neg Negative StptCfg Setpoint Configuration
DispAcm Display Accumulator NegTotl Negative Total StptFmt Setpoint Format
DispTar Display Tare NetFmt Net Format TareFn Tare Function
DispTst Startup Display Test NextCal Next Calibration TareMot Tare in Motion
DmpVal Damping Value NTare Allow Negative Tare Theoret Theoretical Calibration
DSlot Digital Output Slot NumWegh Number of Weighments Tm/Dt Time/Date
Dsplay Display OvrBase Zero Base for Overload TmpZero Temp Zero
DumpAud Dump Audit PCount Preact Count UID Unit ID
Duraton Duration PFormt Print Format UldWgh Underload Weight
EleOrig Origin Elevation PolBeg Priority Start UnitBeg Unit Start
Eoldly End of Line Delay PolDefs Polarity Definitions UnitDef Unit Definitions
EthClnt Ethernet Client PolEnd Priority End UnitEnd Unit End
EthSrvr Ethernet Sever Dest 1 Destination Port 1 WgtBeg Weight Start
FltrChn Filter Chain Type Dest 2 Destination Port 2 WgtEnd Weight End
Format Scale Format Pos Positive WLin Linear Calibration
Gfmt Gross Format PreAdj Preact Adjust WmtThrh Weighment Threshold
GrvDest Destination Gravity PreStab Preact Stability WSpan Span Calibration
GrvOrig Origin Gravity PreVal Preact Value WVal Test Weight
HdrFmt Header Format Pri Primary WZero Zero Calibration
HoldWgh Weighment Display Hold PrntHld Print Display Hold ZeroCnt Zero Counts
HoldWt Hold Weight PrntMot Allow Print in Motion ZeroMot Zero in Motion
Htare Display Hold Tare PrntPt Add PT to Keyed Tare Print ZRange Zero Range 

Table 13-2.  Parameter Abbreviation Definitions
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13.5 Non-Printable Characters
Table 13-3 lists non-printable characters that may appear in an incoming data stream during Manual Mode configuration 
(Section 5.3.2 on page 77).

Character Hex Decimal Abbreviation Description Character Hex Decimal Abbreviation Description
☻ 01 1 SOH Start of Heading - 2D 45
☺ 02 2 STX Start of Text . 2E 46
♥ 03 3 ETX End of Text / 2F 47
♦ 04 4 EOT End of Transmission 0 30 48
♣ 05 5 ENQ Enquiry 1 31 49
♠ 06 6 ACK Acknowledge 2 32 50
▪ 07 7 BEL Bell 3 33 51
◘ 08 8 BS Backspace 4 34 52

09 9 HT Horizontal Tab 5 35 53
0A 10 LF Line Feed 6 36 54

♂ 0B 11 VT Vertical tab 7 37 55
♀ 0C 12 FF Form feed 8 38 56
♪ 0D 13 CR Carriage Return 9 39 57
♫ 0E 14 SO Shift Out : 3A 58
☼ 0F 15 SI Shift In ; 3B 59
► 10 16 DLE Data Link Escape < 3C 60
◄ 11 17 DC1 Device Control 1 = 3D 61
↕ 12 18 DC2 Device Control 2 > 3E 62
‼ 13 19 DC3 Device Control 3 ? 3F 63
¶ 14 20 DC4 Device Control 4 @ 40 64
§ 15 21 NAK Negative Acknowledge A 41 65
_ 16 22 SYN Synchronous Idle B 42 66
↕ 17 23 ETB End of Transmission Block C 43 67
↑ 18 24 CAN Cancel D 44 68
↓ 19 25 EM End of Medium E 45 69
→ 1A 26 SUB Substitute F 46 70
← 1B 27 ESC Escape G 47 71
└ 1C 28 FS File Separator H 48 72
╫ 1D 29 GS Group Separator I 49 73
▲ 1E 30 RS Record Separator J 4A 74
▼ 1F 31 US Unit Separator K 4B 75

20 32 SP Space L 4C 76
! 21 33 M 4D 77
“ 22 34 N 4E 78
# 23 35 O 4F 79
$ 24 36 P 50 80
% 25 37 Q 51 81
& 26 38 R 52 82
‘ 27 39 S 53 83
( 28 40 T 54 84
) 29 41 U 55 85
* 2A 42 V 56 86
+ 2B 43 W 57 87
, 2C 44 X 58 88

Table 13-3.  ASCII Symbols
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Y 59 89 è 8A 138
Z 5A 90 ï 8B 139
[ 5B 91 î 8C 140
\ 5C 92 ì 8D 141
] 5D 93 Ä 8E 142
^ 5E 94 Å 8F 143
_ 5F 95 É 90 144
‘ 60 96 æ 91 145
a 61 97 Æ 92 146
b 62 98 ô 93 147
c 63 99 ö 94 148
d 64 100 ò 95 149
e 65 101 û 96 150
f 66 102 ù 97 151
g 67 103 ÿ 98 152
h 68 104 Ö 99 153
i 69 105 Ü 9A 154
j 6A 106 ¢ 9B 155
k 6B 107 £ 9C 156
l 6C 108 ¥ 9D 157

m 6D 109 ₧ 9E 158
n 6E 110 ƒ 9F 159
o 6F 111 á A0 160
p 70 112 í A1 161
q 71 113 ó A2 162
r 72 114 ú A3 163
s 73 115 ñ A4 164
t 74 116 Ñ A5 165
u 75 117 ª A6 166
v 76 118 ° A7 167
w 77 119 ¿ A8 168
x 78 120 ⌐ A9 169
y 79 121 ¬ AA 170
z 7A 122 ½ AB 171
{ 7B 123 ¼ AC 172
¦ 7C 124 ¡ AD 173
} 7D 125 « AE 174
” 7E 126 » AD 175
⌂ 7F 127 DEL Delete ░ B0 176
Ç 80 128 ▒ B1 177
ü 81 129 ▓ B2 178
é 82 130 │ B3 179
â 83 131 ┤ B4 180
ä 84 132 ╡ B5 181
à 85 133 ╢ B6 182
å 86 134 ╖ B7 183
ç 87 135 ╕ B8 184
ê 88 136 ╣ B9 185
ë 89 137 ║ BA 186

Character Hex Decimal Abbreviation Description Character Hex Decimal Abbreviation Description

Table 13-3.  ASCII Symbols (Continued)
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╗ BB 187 ▐ DE 222
╝ BC 188 ▀ DF 223
╜ BD 189 α E0 224
╛ BE 190 ß E1 225
┐ BF 191 Γ E2 226
└ C0 192 π E3 227
┴ C1 193 ε E4 228
┬ C2 194 σ E5 229
├ C3 195 µ E6 230
─ C4 196 τ E7 231
┼ C5 197 Φ E8 232
╞ C6 198 Θ E9 233
╟ C7 199 Ω EA 234
╚ C8 200 δ EB 235
╔ C9 201 ∞ EC 236
╩ CA 202 φ ED 237
╦ CB 203 ε EE 238
╠ CC 204 ∩ EF 239
═ CD 205 ≡ F0 240
╬ CE 206 ± F1 241
╧ CF 207 ≥ F2 242
╨ D0 208 ≤ F3 243
╤ D1 209 ⌠ F4 244
╥ D2 210 ⌡ F5 245
╙ D3 211 ÷ F6 246
╘ D4 212 ≈ F7 247
╒ D5 213 ° F8 248
╓ D6 214 ∙ F9 249
╫ D7 215 · FA 250
╪ D8 216 √ FB 251
┘ D9 217 ⁿ FC 252
┌ DA 218 ² FD 253
█ DB 219 ■ FE 254
▄ DC 220 FF 255
▌ DD 221

Character Hex Decimal Abbreviation Description Character Hex Decimal Abbreviation Description

Table 13-3.  ASCII Symbols (Continued)
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13.6 ZZ EDP Command
The ZZ EDP command can be used to remotely query the value currently displayed on the display, along with the units, and a 
number representing the current state of the annunciators. The number represents the LED annunciators currently lit (Table 13-4).
Example: If the ZZ command returns 2500 LB 145; the weight on display is 2500 pounds, and the gross, standstill, and lb 

annunciators are lit.The number 145 represents the sum of the values for the gross mode annunciator (16), the 
standstill annunciator (128), and the lb annunciator (1).

13.7 Auto-Learn Supported Data Formats

  NOTE: Functions with devices that do not require a checksum in the data string.

Decimal Value Annunciator
1 lb/primary units
2 kg/secondary units
4 Tare entered
8 Keyed tare entered

16 Gross
32 Net
64 Center of zero

128 Standstill

Table 13-4.  Status Codes Returned on the ZZ Command

Vender or Product Data Format
Accuweigh <STX><P><W6.><U><M><S><CR><LF>
Analogic <STX><SP><W6.><CR><LF>
A&D <S><,><M><,><P><W7.><U><CR><LF>
Avery Weigh-Tronix <T><M><P><W06.><SP><UU><CR><LF>
Cardinal <CR><P><W06..><S><SP><UU><SP><M><SP><SP><ETX>

 <CR><P><W6.><S><SP><U><SP><M><SP2><ETX>
<CR><P><W7.><S><SP><U><SP><M><SP2><ETX>
 <CR><P><W6.><S><SP><U><SP><S2><SP2><ETX>

Dini Argeo <SS>,<MM>,<P><W7.>,<UU><CR><LF>
Fairbanks <STX><SS><W-7.><ETX>

<STX><M><P><W6.><ETX>
GSE Scale Systems <STX><W8><SP><UNIT><SP><MODE><CR><LF>
Hardy <CR><LF><SP>GROSS<SP><-W7.><SP><UU><SP><CR><LF>

<SP>NET<SP><SP><SP><-W7.><SP><UU><SP><CR><LF>
<SP>TARE<SP><SP><-W7.><SP><UU><SP><CR><LF><CR><LF>
NOTE: The full 65-character format must be used, but only the gross weight is displayed. For 
Hardy only, a stream of at least 5 full frames per second is required for Auto-Learn to work.

Ishida <P><W7.><U><S1><S2><CR><LF>
Measurement Systems International <W-7.><SP><UU><SP><MM><CR><LF>
Rice Lake / Condec <STX><P><W7.><U><M><S><CR><LF>
SCT 20 <W6><CR><LF>
SCT 2200 Standard <ID><S1><,><M><,><W8.><,><U><CR><LF>
SCT 2200 Extended <ID><SC><,><S1><,><NW10><,><TT><,><TW10><,><P10><,><UU><,><CR><LF>
Toledo <STX><A><B><C><W06><T06><CR>
Weightronix <TR><M><P><W6.><SP><U><CR><LF>

<TR><M><SP><P><W6.><SP><U><CR><LF>

Table 13-5.  Auto-Learn Supported Data String
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13.8 Continuous Data (Stream) Output Formats
When the trigger setting for a port is set to STRIND or STRLFT, data is continuously streamed from the appropriate port in one 
of the four fixed format options or a custom format option.

13.8.1 Fixed Format Options:
• Rice Lake Weighing Systems (Section 13.8.2)
• Cardinal (Section 13.8.3)
• Avery Weigh-Tronix (Section 13.8.4 on page 142)
• Mettler Toledo (Section 13.8.5 on page 142)

13.8.2 Rice Lake Weighing Systems Stream Format

Figure 13-1. Rice Lake Weighing Systems Stream Data Format

13.8.3 Cardinal Stream Format

Figure 13-2. Cardinal Stream Data Format

<STX>         <POL>        <wwwwwww>            <UNIT>        <G/N>     <S>       <TERM>

ASCII 002

Polarity:
<space> = Positive
<–> = Negative

Weight: 7 digits, right-justified, dummy
zeroes, decimal point with no leading
zeroes except for leading zero immediately
preceding the decimal point. Leading
zeroes transmitted as spaces.

L = pounds
K = kilograms
T = tons
G = grams
O = ounces

G = Gross
N = Net

Status:
<space> = valid
I = Invalid
M = Motion
O = Over/under range
Z = COZ

<CR> <LF>
or <CR>

Carriage
Return

Polarity:
<+> for positive
"–" for negative

Six digits, right justified, floating decimal
(follows weight if not embedded),
leading zeroes are present.

g for Gross
n for Net

lb = pound
kg = kilogram
g = gram
tn = ton (short)
t = ton (metric)
oz = ounce
<space> = none

Space
Character

<CR>  <POL>   <wwwwww>   <S>  <SP>   <UNIT>  <SP>  <G/N>  <SP>  <SP>  <ETX>

Space character
(2)

Space
Character

Status:
<space> = valid or invalid
m = motion
o = over/under range

ASCII 003
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13.8.4 Avery Weigh-Tronix Stream Format

 

Figure 13-3. Avery Weigh-Tronix Stream Data Format

13.8.5 Mettler Toledo Stream Format

Figure 13-4. Mettler Toledo Stream Data Format

Space

Polarity:
<+> for positive
"–" for negative

Six digits, right justified, floating decimal, 
leading zeros are present

g for Gross
n for Net

<CR><LF>
 or 
<CR>lb = pound

kg = kilogram
g = gram
tn = ton (short)
t = ton (metric)
oz = ounce
<space> = none

Space

<SP>          <G/N>       <POL>             <wwwwww>            <SP>         <UNIT>        <TERM>

<STX>       <SWA>      <SWB>      <SWC>        <wwwwww>       <tttttt>       <CR> 

Status Word A

<CR> entered at end
of string

Status Word B

Status Word C

MUL1 MUL0Parity

DP2 DP1 DP0 Fixed Zero/Dec. Pt. Location
0 0 0 x 100 (2 fixed zeroes)
0 0 1 x 10 (1 fixed zero)
0 1 0 x 1 (No decimal point)
0 1 1 x 0.1 (1 decimal place)
1 0 0 x 0.01 (2 decimal places)
1 0 1 x 0.001 (3 decimal places)
1 1 0 x 0.0001 (4 decimal places)
1 1 1 x 0.00001     (5 decimal places)

  Disp. Div.
MUL1 MUL0 M ultiplier

0 1 x 1
1 0 x 2
1 1 x 5

Even parity bit.
Requires EDP Port setup.

Status Word A: 

Status Word C: ASCII 20h (space) 

Even parity bit:
Requires EDP  Port setup. 

Status Word B: 

0 = Gross Display Mode
1 = Net Display Mode

0 = Positive indicated weight value
1 = Negative indicated weight value

0 = In range
1 = Out of range

0 = Stable
1 = Motion

0 = lb
1 = kg

Even parity bit:
Requires EDP Port
setup. 

Six digit Gross or Net weight, right justified, 
dummy and leading zeros

Six digit Tare weight, right justified, 
dummy and leading zeros

7 6 5 4 3 2 1 0
DP2 DP1 DP010

Parity
7 6 5 4 3 2 1 0

10 0 0 0 0 0

Parity
7 6 5 4 3 2 1 0

10

ASCII 002
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13.8.6 Custom Stream Format Tokens
The custom stream format can be configured using the stream format menu via the front panel. See Section 4.3.6 on page 56 
for the stream format menu structure. The indicator must be in setup mode (Section 2.8.2 on page 25) to access the stream 
format menu.

13.8.6.1 Using the Front Panel
Use the stream format menu to customize the custom stream format by changing the ASCII characters in the format string.

Setup ▼Config ►... ►SFormt ▼SFormt ►Custom  Custom ▼to format string entry

NOTE: The LaserLight3 can send or receive ASCII characters; the character printed depends on the particular ASCII 
character set implemented for the receiving device. Some characters cannot be displayed on the LaserLight3 front panel, 
see the ASCII character chart in Section 13.5 on page 137 for available characters and see Section 10.3 on page 116 for a 
description of Non-Human Readable Characters.

For example, enter the following string of format tokens to recreate the standard RLWS stream format as a custom stream 
format: <2><P><W7.><U><M><S><CR><LF>

<2> Sends ASCII character 2, or STX.
<P> Sends the Polarity character.
<W7.> Sends 7 weight digits, no leading zeros, with a floating decimal point as needed.
<U> Sends the Units.
<M> Sends the Mode.
<S> Sends the Status.
<CR> Sends a Carriage Return.
<LF> Sends a Line Feed.

13.8.6.2 Custom Stream Format Tokens

Format Token Defined By Description
<P[G | N | T]> STRM.POS#n

STRM.NEG#n
Polarity – specifies positive or negative polarity for the current or specified (Gross/Net/Tare) weight on the 
source scale. Possible values are SPACE, NONE, + (for STR.POS#n) or – (for STR.NEG#n)

<U[P | S]> STRM.PRI#n
STRM.SEC#n

Units – specifies primary or secondary units for the current or specified weight on the source scale

<M[G | N | T]> STRM.GROSS#n
STRM.NET#n
STRM.TARE#n

Mode – specifies gross, net or tare weight for the current or specified weight on the source scale

<S> STRM.MOTION#n
STRM.RANGE#n
STRM.OK#n
STRM.INVALID#n
STRM.ZERO#n

Status for the source scale – default values and meanings for each status:
• STR.MOTION#n M In motion
• STR.RANGE#n O Out of range
• STR.OK#n <space> OK
• STR.INVALID#n I Invalid
• STR.ZERO#n Z COZ

<UID> UID Unit ID number – specifies the unit identification number as an alphanumeric value up to 8 characters long
<###> -- To send an ASCII character; ### is a number 0 to 255; for example: <2> sends the ASCII character 2, Start 

of Text (STX) and the token <13> sends a Carriage Return
XXXX -- To send literal characters; XXXX represents literal characters to include in the string by not including < >; 

for example: SCALE<W7.><U><CR><LF> will stream “SCALE   1234 L” with a weight of 1234 pounds
<B [–]n,…> See descriptions below Bit fields. Comma-separated sequence of bit field specifiers; must be exactly 8-bits; 

minus sign ([–]) inverts the bit
B0 -- Always 0
B1 -- Always 1
B2 Configuration =1 if even parity

Table 13-6.  Custom Stream Format Tokens
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B3 Dynamic =1 if MODE=NET
B4 Dynamic =1 if COZ
B5 Dynamic =1 if standstill
B6 Dynamic =1 if gross negative
B7 Dynamic =1 if out of range
B8 Dynamic =1 if secondary
B9 Dynamic =1 if tare in system
B10 Dynamic =1 if tare is keyed
B11 Dynamic =00 if MODE=GROSS

=01 if MODE=NET
=10 if MODE=TARE
=11 (not used)

B12 Dynamic =00 if UNITS=PRIMARY
=01 if UNITS=SECONDARY
=11 (not used)

B13 Configuration =00 (not used)
=01 if current DSPDIV=1
=10 if current DSPDIV=2
=11 if current DSPDIV=5

B14 Configuration =00 (not used)
=01 if primary DSPDIV=1
=10 if primary DSPDIV=2
=11 if primary DSPDIV=5

B15 Configuration =00 (not used)
=01 if secondary DSPDIV=1
=10 if secondary DSPDIV=2
=11 if secondary DSPDIV=5

B17 Configuration =000 if current DECPNT=8888800 =100 if current DECPNT=88888.88
=001 if current DECPNT=8888880 =101 if current DECPNT=8888.888
=010 if current DECPNT=8888888 =110 if current DECPNT=888.8888
=011 if current DECPNT=888888.8 =111 if current DECPNT=88.88888

B18 Configuration =000 if primary DECPNT=8888800 =100 if primary DECPNT=88888.88
=001 if primary DECPNT=8888880 =101 if primary DECPNT=8888.888
=010 if primary DECPNT=8888888 =110 if primary DECPNT=888.8888
=011 if primary DECPNT=888888.8 =111 if primary DECPNT=88.88888

B19 Configuration =000 if secondary DECPNT=8888800 =100 if secondary DECPNT=88888.88
=001 if secondary DECPNT=8888880 =101 if secondary DECPNT=8888.888
=010 if secondary DECPNT=8888888 =110 if secondary DECPNT=888.8888
=011 if secondary DECPNT=888888.8 =111 if secondary DECPNT=88.88888

<wspec [–] [0] digit 
[.[.][digit ]]>

Scale weight Weight for the source scale. wspec is defined as follows:
wspec indicates whether the weight is the current displayed weight (W, w), gross (G, g), net (N, n) or tare 
(T, t) weight; upper-case letters specify right-justified weights, lower-case are left-justified
Optional /P, /S or /T suffixes can be added before the ending delimiter (>) to specify weight display in 
primary (/P) or secondary (/S) units
[–] Enter a minus sign (–) to include sign for negative values
[0] Enter a zero (0) to display leading zeros
digit[.[.][digit]] The first digit indicates the field width in characters; the decimal point only indicates a 

floating decimal; a decimal point with a following digit indicates fixed decimal with n digits to the right 
of the decimal; two consecutive decimals send the decimal point even if it falls at the end of the 
transmitted weight field

<CR> -- Carriage return
<LF> -- Line feed

Format Token Defined By Description

Table 13-6.  Custom Stream Format Tokens (Continued)
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13.9 Cardinal Display Type Format
When LaserLight3 is configured correctly and receives an appropriate signal from a Cardinal indicator, the LaserLight3 
replicates either Message Board or a Score Board stop and go formats with data from the Cardinal indicator.

NOTE: In order to view Cardinal Message Board or a Score Board stop and go formats, The LaserLight3 must be configured 
with:

• Remote display configuration
• Display Type set as Cardinl (Section 5.1 on page 72) 
• Communication protocol with the Cardinal indicator (Section 5.2 on page 73 or Section 5.3 on page 76).

13.9.1 Cardinal Message Board Stream Format

Figure 13-5. Cardinal Message Board Stream Data Format

13.9.2 Cardinal Score Board Stream Format

Figure 13-6. Cardinal Score Board Stream Data Format

Carriage
ReturnAddress of indicator

Nine digits, right justified, floating
decimal (follows weight if not
 embedded), leading zeroes are
 present.

<%N>  <DDDDDDDDD>  <CR>

Carriage
ReturnAddress of indicator

Six digits, right justified, floating
decimal (follows weight if not
 embedded), leading zeroes are
 present.

G = Gross
N = Net

lb = pound
kg = kilogram
T = ton (Imperial)
t = ton (metric)
<space> = none

G, g, C = Green Circle
R, r, c = Red Circle
S = Down green arrow
s = Down red arrow
N = Up green arrow
n = Up red Arrow
<space> = Traffic light 
                  area blank

<%N>  <DDDDDD>   <UU>  <M>   <T> <CR>
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14.0 Specifications

Power
AC voltages 100-240 VAC; 50-60 Hz 
120 Watt (120 VAC)

Output Interface
Ethernet TCP/IP, Independently configurable echo port

Input Data Format 
7 or 8 data bits; even, odd or no parity; 1 or 2 stop bits
Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400, 57600 and 115200 
self-learning or configurable
Update
Continuous or out-of-motion modes
Message interrupt mode 
Digital I/O
Four I/O Read or Set
5V Logic 

Communication Ports
Ethernet TCP/IP, RS-232, RS-485, 20 mA,

Optional 
ConnexLink™ wireless radio
WLAN interface 801.11 a/b 

Character Format
Selectable foreground/background color
7-color: red, blue, green, yellow, magenta, cyan, white

Maximum Viewing Distance 
4-inch character: 100 ft (30 m)
5-inch character: 150 ft (46 m)

Viewing Angle
160 degrees 
Display
Bright, outdoor color LED Lamps
128 x 32-pixel, 4 mm pitch 
Decimal or comma indication
Weight display with Units and Mode

Keys/Buttons
Integrated keypad with configurable scale commands
Zero, Gross/Net, Tare, Units, Print, Menu

Time
Software enable, 12- or 24-hour format

Date
Software enable, US or ISO format

Dimensions
(L x H x W): 25.0 in x 10.0 in x 6.0 in 

Temperature Range
Operating: -40°F to 120°F (-40°C to 49°C)

Rating/Material
IP66
Mild steel, powder-coated

Weight
Without wall mount: 14.19 lb (7.81 kg)
With wall mount: 20.48 lb (10.66 kg)
With sunshade: 29.79 lb (14.88 kg)

Warranty
Two-year limited warranty

Certifications and Approvals

NTEP
CoC Number 22-096
Accuracy Class: III / IIIL; nmax: 10000

NTEP
Approval AM-6210C
Accuracy Class: III / IIIHD; nmax: 10000

Measurement
Canada
Approved
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